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Copyright
This manual is copyrighted by Canon Computer Systems, Inc. (CCSI)
with all rights reserved. Under the copyright laws, this manual may not
be reproduced in any form, in whole or part, without prior written
consent of CCSI.

©1998 Canon Computer Systems, Inc.

Disclaimer
Canon Computer Systems, Inc. has reviewed this manual thoroughly in
order to make it an easy to use guide for your Canon MultiPASS C5500
system. All statements, technical information, and recommendations in
this manual and in any guides or related documents are believed reliable,
but the accuracy and completeness thereof are not guaranteed or
warranted, and they are not intended to be, nor should they be
understood to be, representations or warranties concerning the products
described.

Your MultiPASS C5500 and the software media included with your
system have been sold to you subject to the limited warranties set forth
in the warranty and license agreement enclosed with the respective
products. All software is licensed AS IS, as described in the license
agreement enclosed with the software media. Further, CCSI reserves the
right to make changes in the specifications of the products described in
this manual at any time without notice and without obligation to notify
any person of such changes.

Trademarks
Canon and BJ are registered trademarks and BCI, Bubble Jet, MultiPASS,
and UHQ are trademarks and SelectExchange is a service mark of
Canon Inc.

All other product and brand names are registered trademarks,
trademarks or service marks of their respective owners.

ENERGY STAR® COMPLIANT

As an ENERGY STAR® Partner, Canon U.S.A., Inc. has determined that 
this product meets the ENERGY STAR® guidelines for energy efficiency.
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USERS IN U.S.A.

PRE-INSTALLATION REQUIREMENTS FOR CANON
FACSIMILE EQUIPMENT
A. Location

Supply a suitable table, cabinet, or desk. See Appendix A for the unit’s
dimensions and weight.

B. Order Information
1. Only a single line, touch-tone or rotary telephone set is to be used.

2. Order an RJ11-C modular jack (USOC code), which should be
installed by the phone company. If the RJ11-C jack is not present,
installation cannot occur.

3. Order a normal business line from your telephone company’s business
representative. The line should be a regular voice grade line or
equivalent. Use one line per unit.

DDD (DIRECT DISTANCE DIAL) LINE
or
IDDD (INTERNATIONAL DIRECT DISTANCE DIAL) LINE IF YOU
COMMUNICATE OVERSEAS

N Canon recommends an individual line following industry standards [e.g., the
2500 (touch-tone) or 500 (rotary/pulse dial) telephones]. A dedicated extension
off a PBX unit without “Call Waiting” can be used with your MultiPASS C5500.
Key telephone systems are not recommended because they send non-standard
signals to individual telephones for ringing and special codes, which may cause
a fax error.

C. Power Requirements
This equipment should be connected to a standard 120 volt AC, three-wire
grounded outlet only. Do not connect this unit to an outlet or power line
shared with other appliances that cause “electrical noise.” Air conditioners,
electric typewriters, copiers, and machines of this sort generate noise which
often interferes with communications equipment and the sending and
receiving of documents.

CONNECTION OF THE EQUIPMENT
This equipment complies with Part 68 of the FCC rules. On the rear panel of
this equipment is a label that contains, among other information, the FCC
Registration Number and Ringer Equivalence Number (REN) for this
equipment. If requested, this information must be given to the telephone
company. This equipment may not be used on coin service provided by the
telephone company. Connection to party lines is subject to state tariffs.
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IN CASE OF EQUIPMENT MALFUNCTION
Should any malfunction occur which cannot be corrected by the procedures
described in this User’s Manual, disconnect the equipment from the telephone
line or unplug the power cord. The telephone line should not be reconnected or
the power cord plugged in until the problem is completely resolved. Users
should contact Canon Authorized Service Facilities for servicing of equipment.
Information regarding Authorized Service Facility locations can be obtained by
calling the Canon Computer Systems Customer Care Center. (See page 1-4 for
details.)

RIGHTS OF THE TELEPHONE COMPANY
Should the equipment cause harm to the telephone network, the telephone
company may temporarily disconnect service. The telephone company also
retains the right to make changes in facilities and services which may affect the
operation of this equipment. When such changes are necessary, the telephone
company is required to give adequate prior notice to the user.

WARNING
Do not make any changes or modifications to the equipment unless otherwise
specified in the manual. If such changes or modifications should be made, you
could be required to stop operation of the equipment.

N This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed, and used in accordance with the instructions, may
cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one of the
following measures:
● Reorient or relocate the receiving antenna.
● Increase the separation between the equipment and receiver.
● Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected.
● Consult the dealer or an experienced radio/TV technician for help.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any
person to use a computer or other electronic device to send any message via a
telephone fax machine unless such message clearly contains in a margin at the
top or bottom of each transmitted page or on the first page of the transmission,
the date and time it is sent and an identification of the business or other entity,
or other individual sending the message and the telephone number of the
sending machine or such business, other entity, or individual.

To automatically enter this information into your MultiPASS C5500, follow the
instructions in your Quick Start Guide.
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USERS IN CANADA

PRE-INSTALLATION REQUIREMENTS FOR CANON
FACSIMILE EQUIPMENT
A. Location

Supply a suitable table, cabinet, or desk. See Appendix A for the unit’s
dimensions and weight.

B. Order Information
1. Provide only a single-line to touch-tone or rotary telephone set

terminated with a standard 4-pin modular phone plug. (Touch-tone is
recommended if available in your area.) 

2. Order an RJ11-C modular jack (USOC code), which should be
installed by the phone company. If the RJ11-C jack is not present,
installation cannot occur.

3. Order a normal business line from your telephone company’s business
representative. The line should be a regular voice grade line or
equivalent. Use one line per unit.

DDD (DIRECT DISTANCE DIAL) LINE
or
IDDD (INTERNATIONAL DIRECT DISTANCE DIAL) LINE IF YOU
COMMUNICATE OVERSEAS

N Canon recommends an individual line following industry standards [e.g., the
2500 (touch-tone) or 500 (rotary/pulse dial) telephones]. A dedicated extension
off a PBX unit without “Camp On” signals is also permissible with your
MultiPASS C5500. Key telephone systems are not recommended because they
send non-standard signals to individual telephones for ringing and special
codes, which may cause a fax error.

C. Power Requirements
The power outlet should be a three-prong grounded receptacle (Single or
Duplex). It should be independent from copiers, heaters, air conditioners,
or any electric equipment that is thermostatically controlled. The rated
value is 120 volts and 15 amperes. The RJ11-C modular jack should be
relatively close to the power outlet to facilitate installation.

NOTICE
The Industry Canada label identifies certified equipment. This certification
means that the equipment meets telecommunications network protective,
operational and safety requirements as prescribed in the appropriate Terminal
Equipment Technical Requirements document(s). The Department does not
guarantee the equipment will operate to the user’s satisfaction.
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Before installing this equipment, users should ensure that it is permissible to be
connected to the facilities of the local telecommunications company. The
equipment must also be installed using an acceptable method of connection.
The customer should be aware that compliance with the above conditions may
not prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative
designated by the supplier. Any repairs or alterations made by the user to this
equipment, or equipment malfunctions, may give the telecommunications
company cause to request the user to disconnect the equipment.

Users should ensure for their own protection that the electrical ground
connections of the power utility, telephone lines and internal metallic water
pipe system, if present, are connected together. This precaution may be
particularly important in rural areas.

CAUTION
Users should not attempt to make such connections themselves, but should
contact the appropriate electric inspection authority, or electrician, as
appropriate.

The Ringer Equivalence Number (REN) assigned to each terminal device
provides an indication of the maximum number of terminals allowed to be
connected to a telephone interface. The termination on an interface may consist
of any combination of devices subject only to the requirement that the sum of
the Ringer Equivalence Numbers of all the devices does not exceed 5.

CANON CANADA INC.
1-800-263-1121

24 HOURS A DAY, SEVEN DAYS A WEEK
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Using Your Documentation
The following documentation is supplied with the MultiPASS C5500 to
help you use your new Canon multi-talented color printer.

Quick Start Guide
This booklet describes how you unpack, set up, and start using your
MultiPASS C5500. It includes how to install the software that comes
with the MultiPASS C5500, including the MultiPASS Desktop Manager
for Windows®, ScanGear for MultiPASS, and the MultiPASS Printer
Driver. This software enables you to use all the features of the MultiPASS
C5500—color printing, color scanning, color copying, and PC faxing.

User’s Manual
This manual offers detailed information on how to operate your
MultiPASS C5500. It includes how to use the MultiPASS C5500 as a
monochrome or color printer, stand-alone plain paper fax, PC fax, color
scanner, and color copier. It also includes maintenance, troubleshooting,
and specifications.

Conventions
This User’s Manual uses the following conventions to alert you to
information that will help you operate the MultiPASS C5500 correctly
and safely.

N Notes provide advice or suggestions regarding the use of the 
MultiPASS C5500.

C Cautions alert you to operations that could cause damage to your
hardware or software, or cause injury to yourself.
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Distinctive typefaces identify the buttons you press, the lights on the
operator panel, and any commands you enter at your computer.

❍ The buttons you press appear in this typeface: START/COPY.

❍ The names of lights you see appear in this typeface: ALARM.

❍ What you see in the LCD display appears in this typeface:
REGISTRATION.

❍ When you type something on your computer, it appears in this
typeface: DIR/P .
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1Introduction

Thank you for purchasing the Canon MultiPASS C5500—the multi-
talented color printer for your home office and the whole family. We 
are sure that your MultiPASS C5500 will provide all you need in one
machine: Color Bubble Jet printer, color scanner, color copier, plain
paper fax, and PC fax.

This chapter introduces you to the MultiPASS C5500. It includes:

❍ Supplies and accessories

❍ Getting help from Canon

❍ Important safety instructions

❍ Examining the main components of the unit

❍ Using the operator panel

❍ Loading paper in the sheet feeder

❍ Preparing documents for faxing, copying, or scanning

❍ Identifying your documents

❍ Copying documents
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Supplies and Accessories
Your MultiPASS C5500 supports excellent and unique print media
options that will allow you to produce dazzling, professional, and fun
presentations. All of these print media are specially designed and
manufactured to work with your Canon MultiPASS C5500 so you can
produce the finest output possible.

Canon has an extensive dealer network equipped to offer you supplies as
you need them. To find a dealer near you, call the Canon Referral
Service at 1-800-848-4123.

If supplies are not available from your local dealer, you can order
directly from Canon by calling 1-800-385-2155.

BJ Cartridges and BJ Tanks
Your MultiPASS C5500 comes with:

❍ One BC-21e Color BJ® Cartridge

❍ One SB-21 Ink Cartridge Storage Box

❍ One extra BCI-21 Black BJ Tank

You can also purchase the following BJ cartridges for use with the
MultiPASS C5500:

❍ BC-20 Black BJ Cartridge 

❍ BC-22e Photo BJ Cartridge 

❍ BC-29F Neon BJ Cartridge 

You can purchase the following BJ tanks for use in the BC-21e Color 
BJ Cartridge:

❍ BCI-21 Black BJ Tank (one extra BJ tank comes with the printer)

❍ BCI-21 Color BJ Tank
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N BJ cartridges contain the Bubble Jet print head and ink, while BJ tanks
contain ink only. Some BJ cartridges, like the BC-21e Color BJ
Cartridge, contain replaceable BJ tanks; when you run out of ink, you
can replace the empty tank. Some BJ cartridges, like the BC-20 Black 
BJ Cartridge, contain both the print head and ink; when you run out of
ink, you replace the entire BJ cartridge. See Chapter 9, Maintaining the
MultiPASS C5500, for details on replacing BJ cartridges and BJ tanks.

N Canon has more engineers dedicated to creating quality ink for
providing the best results for output on Bubble Jet products than any
other organization. Canon does not prohibit the use of third-party inks
and the use of third-party inks does not invalidate the product’s limited
warranty. However, Canon cannot guarantee the quality or performance
of your MultiPASS C5500 when you are using inks from other suppliers.

Canon’s limited warranty does not cover damage caused to Canon’s
Bubble Jet products that is attributable to the use of third party parts or
supplies, including inks. The limited warranty remains in effect for its
life once that particular damage has been properly repaired.

For optimum printing results, Canon recommends that you use only
Canon ink cartridges.

Canon Specialty Papers
Canon manufactures numerous specialty papers, including:

❍ Glossy Photo Paper GP-201
❍ Banner Paper
❍ Brilliant White Paper
❍ High Resolution Paper HR-101
❍ T-Shirt Transfers TR-101
❍ Greeting Cards GC-101
❍ Bubble Jet Paper LC-301 (water resistant)
❍ Fabric Sheet FS-101
❍ Transparencies CF-102
❍ Back Print Film BF-102
❍ High Gloss Film HG-101

See Chapter 2, Printing With the MultiPASS C5500, for details on
Canon’s Specialty Papers.
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You can also purchase the optional Canon BC-22e Photo Kit, which
includes everything you need to produce photo-realistic images:

❍ BC-22e Photo BJ Cartridge 

❍ SB-21 Ink Cartridge Storage Box

❍ Canon High Resolution Paper HR-101 (60 sheets)

Getting Help From Canon
Canon Computer Systems, Inc. offers a full range of customer technical
support* options including:

❍ 24-hour, 7-day-a-week, toll-free automated support for troubleshooting
issues on most current products (1-800-423-2366)

❍ Speak to a technician free of service charge (currently Monday–
Friday, 8:00 A.M.–10:00 P.M. EST, excluding holidays) for products 
still under warranty** (1-757-413-2848)

❍ Speak to a technician for a service charge (currently $24.99 per 
call) during holidays and days/hours not listed above regarding
urgent product questions or for products no longer under warranty
(1-800-423-2366)

Or for a charge of $2.50 per minute, to a maximum of $25.00 per
call (1-900-246-1200)

❍ E-mail support via the Canon Computer Systems, Inc. Web site
(www.ccsi.canon.com)

❍ 24-hour, toll-free Fax Retrieval System (1-800-526-4345)

❍ To download the latest drivers using your modem, 24-hour Bulletin
Board Service (1-757-420-2000)

*Support program specifics subject to change without notice.
**Refer to individual product information for warranty details.

Canon Canada
Within Canada, 24 hours a day, 7 days a week (1-800-263-1121)

In other countries, please contact your Canon dealer.
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Servicing the MultiPASS C5500
The Canon MultiPASS C5500 is designed with the latest technology 
to provide trouble-free operation. The warranty card that comes with
your MultiPASS describes Canon’s limited warranty. Be sure to read the
warranty information to find out about the different service options
available to you.

N Save your sales receipt for proof of purchase. In the event that your
printer needs service, you will need your proof of purchase to obtain
warranty service.

Be sure to fill out the Registration card and send it in. This will help
Canon give you better support service.

If you seem to have a problem, try to solve it by referring to the
troubleshooting information in Chapter 10. If you cannot solve the
problem, contact the Canon Computer Systems Customer Care Center
(see previous page for details).

If you feel your MultiPASS needs servicing, contact Canon on the World
Wide Web to locate the Canon Authorized Service Facility (ASF) nearest
you. If you do not have access to the Web, you can call Canon (see
previous page for details).

Important Safety Instructions
Read these safety instructions and refer to them later if you have any
questions.

C Except as explained in this manual, do not attempt to service the
MultiPASS C5500 yourself. Opening and removing interior covers may
expose you to dangerous voltage points or other risks. Refer all servicing
to a Canon Authorized Service Facility (ASF). Call the Customer Care
Center for details.

❍ Follow all warnings and instructions marked on the MultiPASS and
inside the printer cover.

❍ Place the MultiPASS on a sturdy level surface. Do not place it on an
unstable cart, stand, or table. If the unit falls, it could be seriously
damaged.
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❍ Do not use the MultiPASS near water. If you spill liquid on 
or into the unit, unplug it immediately and call the Customer Care
Center.

❍ Slots and openings in the cabinet and the back or bottom are
provided for ventilation. To ensure reliable operation of the
MultiPASS and to protect it from overheating, do not block or cover
these openings. Do not block the openings by placing the unit on a
bed, sofa, rug, or other similar surface. Do not place the unit near a
radiator, nor in a closet or built-in cabinet unless proper ventilation
is provided.

❍ Operate the MultiPASS only from the type of power source
indicated on the unit’s label. If you are not sure of the type of power
available, consult your dealer or local power company.

❍ Do not allow anything to rest on the power cord, and do not locate
the MultiPASS where the cord will be walked on. Make sure the
power cord is not knotted or kinked.

❍ Do not push metal objects of any kind into the slots or openings on
the cabinet. This could result in a risk of fire or electric shock.

❍ Do not allow small objects (such as pins, paper clips, or staples) to
fall into the MultiPASS. If something does fall into it that you
cannot remove, unplug the unit immediately and call the Customer
Care Center.

❍ Unplug this product from the wall outlet and call the Customer Care
Center if any of the following conditions exist:

• The power cord or plug is damaged or frayed.

• Liquid is spilled into the unit, or if the unit is exposed to rain 
or water.

• Smoke, unusual noises, or odors come from the unit.

• The unit has been dropped or the cabinet has been damaged.

• The unit does not operate normally when you have followed the
operating instructions. Adjust only those controls that are
covered by the operating instructions in the Quick Start Guide
and this User’s Manual. Improper adjustment of other controls
may result in damage and may require extensive work by a
qualified technician to restore the product to normal operation.
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Main Components of the MultiPASS C5500
Before using the MultiPASS C5500, it’s a good idea to familiarize
yourself with the components and understand their functions.

Front View
SENDING DOCUMENT SUPPORT
HOLDS DOCUMENTS AS THEY FEED
INTO ADF

PAPER GUIDES
ADJUST TO WIDTH
OF DOCUMENT TO
BE SCANNED

AUTOMATIC DOCUMENT
FEEDER (ADF) AND
PRINTER COVER
HOLDS DOCUMENTS 
TO BE SCANNED (UP
TO 30 SHEETS)

OPERATOR PANEL
USE TO CONTROL
THE MultiPASS C5500

SHEET FEEDER
HOLDS 100 SHEETS
OF PLAIN PAPER

OUTPUT TRAY
HOLDS PRINTED DOCUMENTS AS
THEY EXIT THE MultiPASS C5500

PAPER OUTPUT GUIDES
HOLD HIGH RESOLUTION
PAPER WHEN USING THE 
BC-22e PHOTO BJ CARTRIDGE

OUTPUT TRAY EXTENSION
HOLDS PRINTED DOCUMENTS AS
THEY EXIT THE MultiPASS C5500

DOCUMENT SUPPORT
HOLDS SCANNED
DOCUMENTS AS 
THEY EXIT THE
MultiPASS C5500

PAPER REST
SUPPORTS PAPER
STACKED IN THE
SHEET FEEDER



Back View

Inside the Printer Area
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LINE JACK TELEPHONE/
ANSWERING
MACHINE/
MODEM
JACK

PARALLEL CABLE
CONNECTOR

MANUAL FEED
SLOT

POWER CORD
CONNECTOR

PAPER THICKNESS LEVER

CARTRIDGE HOLDER

PRINTER COVER
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Using the Operator Panel
This section presents a brief description of the operator panel on the
MultiPASS C5500.

Document feed lever
Set this lever to the left ( ) for automatic feed or to the right ( ) for
manual document feed.

COLOR COPY button
Use this button to change the resolution when making color copies 
using the operator panel. This button has no function during fax
transmissions. For color scanning, change the resolution from your
software.

LCD display
Displays messages and prompts during operation. Displays selections,
text, numbers, and names when registering information.

9

11

3

4

5

6

7
8

1

2

3

ONE-TOUCH SPEED DIAL/
FUNCTION BUTTONS

B&W FAX/COPY

LCD
DISPLAY

ALARM

STOP

START/COPY
CODED DIAL

10 REDIAL/PAUSE

DOCUMENT FEED
LEVER

NUMBER BUTTONS

COLOR COPY

1

2
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B&W FAX/COPY button
Use this button when sending faxes or making copies in black and white
only. For black and white scanning, set the resolution from the
MultiPASS Desktop Manager.

One-touch Speed Dial/Function buttons
Use for one-touch speed dialing, entering user information, printing
documents stored in memory, and cleaning the print head. (See the next
page for details.)

STOP button
Press to cancel sending, receiving, or any other operation.

ALARM light
Flashes when an error occurs, when the MultiPASS is out of paper or
ink, or when received faxes are stored in memory.

START/COPY button
Press to begin sending, receiving, copying, or other operations, or to
select functions when registering information.

CODED DIAL button
Press this button (followed by a two-digit code) to dial a number that
you have registered for coded speed dialing.

REDIAL/PAUSE button
Press to redial the last number that was dialed using the number
buttons, or to enter pauses between digits when dialing fax numbers.

Number buttons
Use these buttons to enter numbers and names when registering
information, and to dial fax/telephone numbers that are not registered
for automatic dialing.

5

6

7

8

9

10

11

4
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Special Function Buttons

FUNCTION button
Use to register user settings, to run the print head cleaning process, or to
print faxes stored in the MultiPASS’s memory.

CARTRIDGE button
Press to move the BJ cartridge holder to the center of the unit when
installing or replacing the cartridge. (Press again after installing the
cartridge to move the holder back to its home position on the right.)

RESUME button
Press when you want to form-feed paper when printing.

PRINTER RESET button
Press to reset the MultiPASS to Standby mode if the LCD displays
PRINTER MODE.

Arrow buttons
Use to scroll through menu selections, or to move the cursor when
registering data.
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Loading Paper in the Sheet Feeder
The paper you load in the sheet feeder is used for printing documents 
or for incoming faxes. For printing documents, you can use any of
the Canon Specialty Papers described in Chapter 2, Printing With the
MultiPASS C5500. For receiving faxes, use plain paper (such as copier
paper).

When the message LOAD PAPER appears in the LCD display, you need to
add paper to the sheet feeder. The sheet feeder holds approximately 100
sheets of plain paper.

❍ For best results, fan the paper before loading it.

❍ Always fan a stack of paper along the edge that will feed
into the MultiPASS first.

❍ Pull the paper rest up until it stops.

❍ Move the paper guide to the left to match the size of
your paper.

Make sure the
paper rest 

is extended.

Fan the paper.
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❍ Align the edge of the paper with the right edge of the
sheet feeder.

❍ Secure the stack with the paper guide.

Preparing Documents for Faxing, 
Copying, or Scanning

You can use the MultiPASS to fax, copy, or scan documents that are
printed on standard letter, legal, or A4 size paper. Follow these guidelines
to prepare your documents.

❍ Do not attempt to feed the following types of documents into the
MultiPASS:

• wrinkled or creased paper

• curled or rolled paper

• torn paper

• carbon-paper or carbon-backed paper

• coated paper

• onion skin or thin paper

Slide the stack of
paper into the

sheet feeder 
until it stops.
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TAB
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❍ Remove all staples, paper clips, and the like before feeding the
document.

❍ Make sure any glue, ink, or correction fluid on the paper is
completely dry before feeding the document.

❍ Make a photocopy of any document that will not feed into the
MultiPASS. You can then feed the copy.

❍ Do not feed documents with pages that are different sizes or of
different thicknesses.

Loading the Document 
You can load up to 30 letter or A4 size sheets and up to 10 legal size
sheets at a time into the Automatic Document Feeder (ADF).

❍ For a multiple-page document, fan the sheets and tap the
document on a flat surface to even the stack.

Stack your
documents.
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❍ Insert the document face down (letterhead first) into the
ADF until you hear a beep.

❍ Adjust the document guides to the width of the
document.

The MultiPASS automatically feeds the pages one by one from the
bottom.

If you have problems feeding multiple-page documents, insert the pages
one at a time into the ADF. This stacks the pages on a slant so they feed
correctly into the ADF. (Do not attempt to stack more than 30 sheets in
the ADF.)

Feed the
document.
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Adding Pages to the Document
If you want to add pages while the MultiPASS is sending a document,
wait until the last page is feeding into the unit and then insert the new
sheets. Insert the first new page so it overlaps the last page by about one
inch (2.5 cm).

Always wait until the last page is being fed into the MultiPASS before
you add new pages.

Setting the Document Feed Lever
You use the document feed lever on the ADF to select multiple
documents ( ) or single sheets ( ).

Always set the document feed lever to single sheets and manually feed
the following types of documents:

❍ Thick paper
❍ Thin paper
❍ Small documents (postcards, business cards)
❍ Documents with uneven surfaces
❍ Photographs
❍ Special types of paper

DOCUMENT FEED LEVER
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Identifying Your Documents
When sending a document, the following information is printed out 
by the receiving fax: your fax number, your name, and the current date
and time. This information is called your TTI (Transmit Terminal
Identification) and appears at the top of the faxed document in small
type.

N In the United States, you are required by FCC regulations to include this
information every time you send a fax.

By identifying the documents you send, the receiving party will
recognize your fax messages at a glance. The illustration below shows a
sample document with the identifying information.

The top line includes the name of the receiving party if you send the
document using one-touch speed dialing, coded speed dialing, or group
dialing and you registered the party’s name. It also includes the page
number.

N You entered your fax header information during the MultiPASS
installation procedure. If you followed the installation procedure, this
information will be printed on the top of your outgoing faxes. If you did
not install the MultiPASS Desktop Manager, see Appendix B, Using the
MultiPASS C5500 as a Stand-alone Fax, for details on how to enter
this information.

In
tr

od
uc

tio
n

THE PAGE NUMBER
THE NAME OF THE
PARTY WHO IS
RECEIVING THE
DOCUMENT

YOUR NAME OR
COMPANY NAME

YOUR FAX/
TELEPHONE
NUMBER

THE DATE AND
TIME YOU SENT
THE DOCUMENT
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Copying Documents
One of the convenient features of the MultiPASS is its ability to make
high-quality copies. Copying in black and white, you can make up to 
99 copies of one document at a time.

N It’s a good idea to use the optional BC-20 Black BJ Cartridge when you
make black and white copies.

You can use the BC-21e Color BJ Cartridge or the optional BC-22e
Photo Color BJ Cartridge to make color copies.

❍ Place the document face down in the ADF. The LCD
displays these messages:

❍ The display shows the size of the copy (the default is
100%) and the number of copies (the default is 1).

COPY    100%     01
Press 

START/COPY.

DOCUMENT READY

FAX FINE

MEMORY USED    0%

Feed the
document.
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❍ To change the resolution for color copying, press the
COLOR COPY button.

❍ To change the copying resolution for black and white
copying, press the B&W FAX/COPY button.

N When copying in color:
• Use COLOR FINE resolution for 360 × 360 dpi; this results in a much

better quality reproduction, but takes longer than other settings.
• Use COLOR DRAFT resolution for 180 × 360 dpi.
• Use COLOR SNAPSHOT when scanning photos that are less wide than

a letter-size page.

When copying in black and white:
• Use B&W TEXT resolution for copying most text documents.
• Use B&W PHOTO resolution when copying documents that contain

photographs. This scans areas of the document that contain photos
with 256 levels of gray, and results in a much better reproduction of
the photograph.

When copying in color:
• You can specify plain paper or High Resolution paper using the LCD

menu system. Press FUNCTION; press < or > until you see USER 
SETTINGS; press START/COPY; press < or > until you see COLOR
COPY MEDIA; press START/COPY; press < or > to display PLAIN 
PAPER or HIGH RES PAPER; press START/COPY to make your 
selection; press STOP to exit the FUNCTION menu.

B&W PHOTO

B&W TEXT

COLOR SNAPSHOT

COLOR DRAFT

COLOR FINE

Change the
resolution if

necessary.
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Miscellaneous
If the Power Goes Out

If power to the MultiPASS is cut off, any documents stored in its fax
memory will be lost. Because of this, be sure to print documents stored
in memory or resend them as soon as possible. (The MultiPASS
automatically prints a Memory Clear Report when power is restored.
See page 10-26.) 

While the power is out, the MultiPASS will receive telephone calls if a
telephone is attached. However, you cannot send or receive faxes. (If you
are using a cordless phone, you will not be able to make or receive calls.)

Avoid unplugging the MultiPASS unless absolutely necessary. This is the
same as a power outage.

Using Switch Boxes
Canon does not recommend using a switch box with the MultiPASS. To
use more than one printer, it’s a good idea to add a second parallel port
to your computer.
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❍ To reduce the size of the copies, use the < or > buttons to
select the reduction percentage you want (70%, 80%,
90%, or 100%):

❍ To make multiple copies (in black and white), use the
number buttons to enter the number of copies (up to 99).

❍ To stop copying at any time, press STOP. You may need to
lift the operator panel to remove the document (see page
10-3 for details).

❍ If an error occurs and the LCD displays START AGAIN,
reload the document and start copying again.

N If the LCD displays MEMORY FULL while making multiple copies 
of a document, do not use the multiple copy feature for copying the
document. Make single copies of the document instead (as many times
as required).

You may be able to make multiple copies if you first print out any faxes
that are stored in memory (see page 5-5).

COPY 
Press 

START/COPY.

COPY    100%     02

Enter the 
number 

of copies.

COPY      80%     01

Select 
Reduction mode 

if necessary.
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This chapter describes how to use the MultiPASS C5500 to print your
documents. Once you have installed the MultiPASS Desktop Manager,
you can use the MultiPASS C5500 for all your printing needs.

This chapter describes:

❍ Paper handling

❍ Installing a printer driver

❍ Printing a document

❍ Printer setup within Windows

❍ Printing speed versus color

❍ Setting the paper thickness lever

❍ Printer settings for various print media

❍ Loading paper

❍ Printing on envelopes

❍ Printing on Canon Specialty Papers

2Printing With the 
MultiPASS C5500
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Paper Handling
One of the most important things you can do to assure the best possible
printing performance of your MultiPASS is to select the correct paper.
Your MultiPASS produces letter quality print on most plain bond
papers, including cotton bond and photocopying papers; it does not
require special ink jet papers. However, the print quality varies with
different paper types. Be sure to test a type of paper before you purchase
a large quantity.

Selecting Paper
Plain Paper
The MultiPASS supports paper sizes of letter, legal, and A4 in portrait
orientation. You can use regular copier paper, cotton bond papers, and
typical letterhead. Always use paper without curls, folds, staples, or
damaged edges. Copier paper has a preferred side for printing. Look at
the label on the package to see which side to print on.

Glossy Photo Paper
Canon Glossy Photo Paper GP-201 is a high gloss, thicker paper that
produces the look and feel of a photograph. Use this paper with the 
BC-22e Photo BJ Cartridge to produce photo-realistic prints from your
printer. (Select Glossy Paper in the printer driver when you have this
paper loaded.)

Banner Paper
This paper is specifically designed for printing one continuous sheet in a
banner format. The connected sheets are divided by a perforation. You
can print from two to six sheets at one time. Canon’s Banner Paper is
specially designed for use with Bubble Jet printers and to produce bright
and vivid color images. (In your printer driver, select Plain Paper for
Media and Letter Banner for Size when you load this paper.)

Brilliant White Paper
Canon’s unique paper formulation gives you a bright white printing
surface that produces incredibly brilliant colors and dark, crisp black
text. This paper works great for proposals, color presentations, color
charts/graphs, flyers, and newsletters. You can print on both sides of
the sheet. (In your printer driver, select Plain Paper for Media when 
you load this paper.)
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High Resolution Paper
The Canon High Resolution Paper HR-101 is designed to produce
photo-realistic quality output with sharp and vivid graphics. For best
results, use the optional BC-22e Photo BJ Cartridge to produce images
comparable to your favorite photographs.

T-Shirt Transfers
Use Canon’s popular T-Shirt Transfers TR-101 to create and personalize
T-shirts, sweatshirts, aprons, tablecloths, napkins, tote bags, and
anything else your imagination allows! Use on any cotton or cotton/poly
blend fabric. Your image is printed in mirror image (when you use 
T-Shirt Transfer mode through the MultiPASS printer driver for
Windows) so when you iron it onto the T-shirt, the image is viewed
correctly.

Greeting Cards
Get the most out of your Canon Creative or other card-making software
with Canon Greeting Cards GC-101. These cards give your unique,
personalized cards the look and feel of professional cards. You can create
cards, invitations, announcements, and more.

Bubble Jet Paper (water resistant)
The Canon Bubble Jet Paper LC-301 has been developed for high quality
printing with minimal or no smearing or running when in contact with
water or damp surfaces, making it a good choice for damp or rainy
environments. The paper is specially coated and printable on both sides.
(Select Plain Paper in the printer driver when you load this paper.)

Fabric Sheets
Use Fabric Sheet FS-101 for Canon Bubble Jet products to print pillow
covers, scarves, flags, and other textile items. Use these sheets for
appliqués and other craft and sewing projects. Fabric sheets are 
9.5 × 14 inches.

Back Print Film
Canon Back Print Film BF-102 has been specially developed for Canon
Color Bubble Jet printers and MultiPASS products. The film is designed
to deliver brilliant, high-intensity color images suitable for business
presentations, design work, or professional reports. Back print film is
printed on the back (nonglossy) side of the film in mirror image and
then viewed from the front (glossy) side using a backlighting device. For
more details, ask a Canon Authorized Dealer for information or refer to
the manual supplied with the film.
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High Gloss Film
The Canon High Gloss Film HG-101 features a bright white finish that
lends striking visual power to charts, graphs, and photographic images.
Use this film to make your presentation materials and graphics look
professional.

Transparencies
CF-102 Transparencies from Canon are recommended. These
transparencies produce excellent contrast, sharpness, and color.

Assorted Paper Starter Kit
If you would like to try some of the papers described above, look 
for Canon’s Starter Kit (SK-102). It contains an assortment of five 
paper types.

Paper Guidelines
When selecting or loading paper, please remember the following:

❍ Attempting to print on damp, curled, wrinkled, or torn paper can
cause paper jams and poor print quality.

❍ Use cut-sheet paper only. You cannot use multipart paper.

❍ When using graph paper, the lines may not match because the 
1/6-inch line spacing of the printer is slightly less than that of
graph paper.

❍ If the print density of your page is very high, light paper stock may
curl slightly due to the large amount of ink. If you need to print
dense graphics, try printing on heavier stock.

❍ Do not use thicker paper than meets the specifications for this
printer. Printing with a paper that is thick enough to come in
contact with the print head nozzles may damage the BJ cartridge.
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❍ Choose Print or Print Setup from the File menu.

❍ You will see a screen similar to this:

❍ Click on the Properties (or Setup) button if you want to
make any adjustments as appropriate for printing your
document. (See Printer Setup Within Windows on the
following page for details.)

❍ After making any necessary changes to the printing
parameters, select OK to start the print job.

Make sure  the
Canon MultiPASS
C5500 Printer is 
selected as your
default printer.
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Installing a Printer Driver
Before you can use any type of printer with your computer, you must
install a printer driver. The printer driver tells the computer what kind
of a printer you are using. The printer driver also controls the various
settings, such as print quality and paper type. You define these settings
within the printer driver, and the printer driver then communicates the
settings to both the computer and the printer.

You must install the MultiPASS Printer Driver for Windows and the
MultiPASS Desktop Manager before you can use the MultiPASS C5500
as a printer for your computer. If you followed the instructions in your
Quick Start Guide, you have already installed the necessary software. If
not, see your Quick Start Guide for details on how to install this
software.

Printing a Document
This procedure describes the general steps required for printing from
various Windows applications. The exact steps for printing a document
may vary depending on the application program (such as Microsoft
Word) you are using. Refer to your software application’s documentation
for the exact printing procedure.

❍ Start the program you are using to create the document,
and open the document you want to print.

Start your
application.
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Printer Setup Within Windows
You can use the MultiPASS with all your Windows 98 and Windows 95
applications. Be sure to set the MultiPASS as the default printer for all
your Windows operations.

Most of your printing operations are controlled by your software
application. The following sections describe how you set certain options
directly from the printer driver; you only need this information if your
application does not control printing.

Opening the Printer Properties Dialog Box 
in Windows 98/95

You can open the Properties dialog box in one of the following ways:

❍ From within any Windows application, you can select the Print or
Print Setup command.

❍ From the Printers folder, you can select the printer and then select
the Properties command from the File menu.

❍ From the Printers folder, you can select the printer, click the right
mouse button, and then select Properties from the drop down list.

Using the Printer Driver in Windows 98/95
The printing options are displayed on these Windows 98/95 tabs:
General, Details, Paper, Graphics, and Setting. See Using the Windows
Tabs on the next page for details.

N For detailed information on any of the printing options, you can use the
Windows 98/95 online Help in the following ways:

❍ Use the right mouse button to click an item on the screen; then 
click the What’s This? command.

❍ Click the question mark ? in the upper right corner and then click 
an item.

❍ Press F1.
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Using the Windows Tabs
The MultiPASS Printer Driver for Windows has several tabs from which
you can select your printing options and learn about your printer driver
as well as your MultiPASS C5500.

❍ General
This tab allows you to add comments regarding the printer driver
and print a test page or a separator page. (You see this tab when 
you open the Properties dialog box from the Printers folder, but you
do not see it when you open the Properties dialog box from within a
Windows application.)

❍ Details
This tab allows you to specify printer port settings, spool settings,
and time-out settings. (You see this tab when you open the
Properties dialog box from the Printers folder, but you do not see it
when you open the Properties dialog box from within a Windows
application.)

DEFINE THE
PRINTER’S PORT

SPECIFY THE
PRINTER DRIVER

SPECIFY TIMEOUT
SETTINGS

SPECIFY PORT
SETTINGS

SPECIFY SPOOL
SETTINGS

ADD COMMENTS
HERE

PRINT A
SEPARATOR
PAGE

PRINT A TEST PAGE
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❍ Paper
This tab allows you to specify page orientation, paper size, and type
of print media.

❍ Graphics
This tab allows you to specify print quality, color model, and print
model.

SPECIFY TYPE
OF PAPER

SPECIFY PAGE
ORIENTATION

SPECIFY SIZE
OF PAPER

SPECIFY
PAPER FEED
METHOD

ENABLE OR
DISABLE IMAGE
COLOR MATCHING 

ENABLE OR
DISABLE FINE
MODE 

ENABLE OR
DISABLE IMAGE
OPTIMIZER

SPECIFY PRINT
QUALITY

SELECT A COLOR
MODEL (THE
COLOR MODEL
YOU SELECT
DEPENDS ON THE
BJ CARTRIDGE
INSTALLED; BE
SURE TO CHANGE
THIS SETTING
WHEN YOU
CHANGE
CARTRIDGES.)

SELECT A
PRINT MODEL
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❍ Setting
This tab allows you to turn on or off the Setup Analyzer. It also
allows you to save up to four custom print settings.

Specifying Your Printing Options
Be sure to use your online help to find out about the settings available
for each printing option.

❍ To move between the Windows tabs, click on any of the tabs.

❍ To select the settings and exit, click the OK button.

❍ To cancel your setting selections on a tab, click the Cancel button.

❍ To save your settings without exiting, click the Apply button.

❍ To access helpful information about the MultiPASS and the printer
driver, click on the Help button.

❍ To find out about a setting, click the question mark ? in the upper
right corner. Move the larger question mark to the setting you are
interested in and click again.

ENABLE OR
DISABLE SETUP
ANALYZER

SAVE YOUR
CUSTOM PRINT
SETTINGS
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Recommended Graphics Settings
You can select the following printing options from the Graphics tab to
achieve the specified results.

Driver settings
To achieve Print Quality Color Model Results
Fastest B&W Draft Monochrome Uses less ink. Output 
output possible 180 × 180 dpi quality is draft.

Fast letter quality Standard Monochrome Slightly slower than 
output 360 × 360 dpi draft. Quality is standard.

Fast B&W photograph Standard and Monochrome Slower than B&W but
and graphic output Fine On better grayscale quality.

360 × 360 dpi

High quality High and Monochrome Produces highest
output Fine Off resolution output.

720 × 360 dpi

High quality High and Monochrome Slower than Standard but
photograph and Fine On optimizes B&W grayscale
graphic output 720 × 360 dpi quality.

Fast color output Draft Color Uses less ink. Output
180 × 180 dpi quality is draft.

Color output Standard Color Fast color printing but
360 × 360 dpi quality is not optimized.

High quality High and Color Uses Drop Modulation
color output Fine On Technology to optimize

720 × 360 dpi color print quality but the
print speed is slower.

Photo-realistic Standard Photo Color Produces photo-realistic
color printing 360 × 360 dpi color printing. (Requires

BC-22e Photo BJ Cartridge
and High Resolution 
Paper HR-101 or Glossy 
Photo Paper GP-201.)

True photo High Photo Color Uses Drop Modulation
quality printing 360 × 360 dpi Technology™ to produce

true photo quality.
(Requires BC-22e Photo
BJ Cartridge and High
Resolution Paper HR-101
or Glossy Photo Paper
GP-201.)
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Using the Setup Analyzer
The Setup Analyzer allows the printer driver to evaluate your choice of
printing settings. On the Setting tab, you click on the green ✔ to enable
the Setup Analyzer. Click on the red symbol to disable it.

When you exit the printer driver and accept your printing settings by
clicking the OK button, the Setup Analyzer (if enabled) checks to see if
any of your settings are contrary to the recommended settings. If there
are inconsistencies, a dialog box similar to this appears:

The inconsistencies appear with check boxes. You can use the dialog box
buttons to select or deselect the inconsistencies and to fix or ignore the
inconsistencies.
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Printing Speed Versus Color
The MultiPASS Printer Driver for Windows can interpret and translate
the full spectrum of colors, up to 16.7 million colors. When printing
color, there is a significant increase in the amount of information that
the driver has to interpret and translate. When printing black ink only,
the driver has only one color to interpret.

By decreasing the amount of colors that the printer driver has to
interpret, you can significantly decrease the time needed to translate the
information. This will speed up the overall printing process.

N You select the settings described below using the Windows tabs of the
MultiPASS Printer Driver. See Using the Windows Tabs starting on page
2-8 for details.

For Quick Color Printing
In the MultiPASS Printer Driver for Windows, choose the following
printing operations. These selections allow the printer driver to interpret
and translate 256 colors, which will increase your printing speed.
However, your print quality will not be optimized.

❍ Media Type—Plain Paper

❍ Print Quality—Standard; Fine is off

❍ Color Model—Color

❍ Print Model—Custom

❍ Color Selection—Fast Color

For High Quality Color Printing
For the MultiPASS, select the printing options shown below to allow the
printer driver to interpret and translate up to 16.7 million colors. Keep
in mind that your print speed will be slower than with other setting
combinations.

❍ Print Quality—High; Fine mode is on

❍ Color Model—Color

❍ Print Model—Automatic
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For Monochrome Printing
Use the optional BC-20 Black BJ Cartridge to optimize the printer’s
performance when you are printing black text and graphics only.

In the printer driver, choose the following printing options to tell your
MultiPASS to print using black ink only.

❍ Media Type—Plain Paper

❍ Print Quality—Standard

❍ Color Model—Monochrome

❍ Print Model—Automatic

Other Ways to Improve Print Speed in Windows
To improve printing speed, you can try the following:

Avoid diffusion halftones
In the Custom Settings dialog box, choose Diffusion for halftoning only
when printing final output or photographic images. Choosing Fine
allows documents to print as much as 20% faster because the computer
does not need to compute to “best possible position” for each dot.

Avoid screen matched color
In the Custom Settings dialog box, avoid Match as the Color Adjustment
setting. The screen matching feature takes longer to process in the
computer because it requires special information.

Avoid automatic settings
Although the automatic settings are easy to use, the computer must
interpret the printed page. This takes more time than if you select each
setting.

Free up your memory
Use only one software program at a time and unload any screen saving
utilities or programs stored in Windows background; this frees up more
memory for Windows processing.
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Use Monochrome when possible
If you will be printing text in black ink only, choose a Color Selection 
of Black and White rather than Grayscale. Print draft documents in
Monochrome rather than Color, or use Draft print quality when
printing color.

Limit the number of colors on each page
The computer will need to calculate and transmit fewer dots per inch
(dpi). Too many colors can make the image confusing and less effective
as well as cause the print speed to slow down.

Use primary colors when printing presentation graphics
Use black, cyan, yellow, magenta, blue, green, and red when possible.
The computer will need to calculate and transfer less dot information.

Use the Draft print quality
The printer will need to image fewer dots.

Use Plain Paper as the Media Type
The print head will make only one pass for each printed line.

Use smaller graphics and more white space in your documents
The computer will be able to prepare the print file faster.

Add RAM to your computer
The computer will be able to prepare the print file faster.

Use a computer with a faster processor
The computer will be able to prepare the print file faster.
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Setting the Paper Thickness Lever
To ensure trouble-free paper handling, you’ll want to set the paper
thickness lever before loading paper.

❍ Center for color BJ cartridges

❍ Left for black BJ cartridges

❍ Right for heavier-weight print media or envelopes

N Be sure to check this lever when you change BJ cartridges, and before
and after printing on heavier-weight print media or envelopes.

Open the
printer cover by

grasping the
paper guides 

and lifting up.

DO NOT TOUCH THE
GUIDE RAIL

DO NOT TOUCH THE
RIBBON CABLE

DO NOT TOUCH THE
ROUND SHAFT
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❍ Set the paper thickness lever to left, center, or right
according to the BJ cartridge and paper type. See 
page 2-16 for details.

❍ Press CARTRIDGE again to move the cartridge holder
back to its home position.

❍ Close the printer cover.

Complete the
operation.

Set the paper
thickness lever.

Press the
CARTRIDGE

button to move
the cartridge
holder to the

center of the unit.

CARTRIDGE
BUTTON
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Printer Settings for Various Print Media
Paper Paper
thickness lever output Paper feed

Media BC-21e     BC-20 guides Method Limit (Sheets)
Plain paper Center Left Down Auto Approx. 100 

(0.4" or 10 mm stack)

Glossy Photo Paper Center Up Auto or 1
GP-201 Manual

Banner Paper Right Up Auto 1 (2 to 6)

Brilliant White Paper Center Left Down Auto Approx. 100

High Resolution Center Up Auto Approx. 80
Paper HR-101 (0.4" or 10 mm stack)

T-Shirt Transfers Right Down Auto or 1
TR-101 Manual

Greeting Cards Right Down Manual 1
GC-101

Bubble Jet Paper Center Left Down Auto Approx. 100
LC-301 (0.4" or 10 mm stack)

Fabric sheet Right Down Auto or 1
FS-101 Manual

Transparencies Center Down Auto 50
CF-102 

Back Print Film Center Down Auto 10
BF-102

High Gloss Film Center Down Manual 1
HG-101

Other heavier-weight Right Down Manual 1
print media

Envelopes
Single Right Down Manual 1
Stack Right Down Auto 15
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Loading Paper
You can stack paper in the sheet feeder to load it automatically, or you
can manually feed one sheet at a time through the manual feed slot.

You can place approximately 100 sheets of plain paper (20 lb or 
75 g/m2) in the sheet feeder at a time.

You can stack approximately 50 sheets of transparency film or 10 sheets
of back print film in the sheet feeder. However, these special media may
not advance correctly under unusual environmental conditions (such as
extreme temperatures or humidity). If you have trouble with special
papers becoming skewed or feeding multiple sheets, do not stack them
in the sheet feeder. Load them one sheet at a time.

Automatically Feeding Paper

❍ Center for color BJ cartridges.

❍ Left for black BJ cartridges.

Set the paper
thickness lever.
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❍ Move the paper guide to the left to match your paper size.

❍ For best results, fan the paper before loading it.

❍ Always fan a stack of paper along the edge that will feed
into the printer first.

Fan the paper.

Pull the paper
support up

until it stops.
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❍ Align the edge of the paper with the right edge of the
sheet feeder.

❍ Secure the stack with the paper guide.

❍ Start your print operation.

Auto Feed Guidelines
When automatically feeding stacks of paper, follow these guidelines:

❍ Do not leave paper stacked in the printer for long periods of time;
longer sheets of paper may become bent or curled over time. This
may cause the paper to misfeed or jam.

❍ If your printed page contains lots of graphics, the ink on the page
may be damp due to the print density. Remove the page right away
and allow the ink to dry.

❍ The capacity of the paper output tray is 30 sheets of paper. To
reduce paper jams, remove paper from the output tray before the
count reaches 30.

❍ If paper curls after printing, remove it immediately; otherwise, paper
jams may occur.

Slide the stack 
of paper into 

the sheet feeder
until it stops.
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❍ The platen (a roller on the inside of the printer) may become inked
if you print data beyond the width of the page. If this happens, clean
the platen with a soft cloth. (For details on cleaning the platen, see
page 9-4.)

❍ Depending on the density of your printed pages, the ink may need
time to dry. Within two to three seconds, the ink becomes smudge
resistant. After drying for several minutes, the ink becomes water
resistant.

❍ Do not try to load paper into the sheet feeder beyond the paper
limit mark (    ) or the tab on the right side of the sheet feeder;
stacking too much paper may cause paper feeding or printing
problems.

❍ Make sure there are no gaps between the stack of paper and the
paper guide or the right edge of the sheet feeder.

NO GAP HERE NO GAP HERE

PAPER LIMIT
MARK

D
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Manually Feeding Paper
You use the manual feed function when printing on heavier-weight print
media (24 lb to 28 lb or 90 g/m2 to 105 g/m2).

N You cannot receive faxes when paper is loaded in the manual feed slot.

❍ If you are manually feeding heavier-weight print media,
set the paper thickness lever to the right.

❍ If you are using Windows, you must select Manual Feed
in the MultiPASS Printer Driver for the printer to accept
manually fed paper.

❍ You will see this screen:

❍ Remove any paper in the sheet feeder and click Continue.

Start your 
print operation.

Check the paper
thickness lever.

DO NOT TOUCH
THE GUIDE RAIL

DO NOT TOUCH
THE RIBBON
CABLE
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❍ You see this screen approximately 5 seconds after clicking
Continue.

❍ Make sure the print side is facing up.

❍ Align the sheet with the left edge of the manual feed slot,
and keep the leading edge of the paper perpendicular to
the left edge.

❍ Slide the paper into the manual feed slot in the back of
the printer until it stops.

❍ Hold the sheet for about two seconds until it feeds
automatically.

❍ The printer will automatically load the paper into
position.

❍ When ready, click Continue in the Add Paper dialog box.

After printing on thick paper or envelopes, set the paper thickness lever
(inside the printer) back to the left or center position before printing on
other paper types.

When you are
prompted, insert
the single sheet.
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Printing On Envelopes
You can stack up to 10 envelopes in the sheet feeder or you can manually
feed envelopes one at a time.

U.S. Commercial number 10 (COM10) envelopes and European DL
envelopes are recommended. You may be able to stack envelopes of
other sizes in the sheet feeder; however, Canon cannot guarantee
consistent performance on envelope sizes other than COM10 and DL.

The following envelopes are not recommended because they may cause
jams or smears, or may damage your printer.

❍ Envelopes with windows, holes, perforations, cutouts, and 
double flaps.

❍ Envelopes made with special coated paper or deeply 
embossed paper.

❍ Envelopes using peel-off sealing strips.

❍ Envelopes in which letters have been enclosed.

When you are ready to print on envelopes, follow these steps to stack
envelopes in the sheet feeder. (You can also manually feed envelopes one
at a time.)

❍ Close the printer cover.

Make sure the
paper thickness

lever is set to the
right (A).

DO NOT TOUCH
THE GUIDE RAIL

DO NOT TOUCH
THE RIBBON
CABLE
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❍ Arrange the stack of envelopes on a firm surface and 
press down firmly on the edges to make the folds crisp.

❍ Press all the way around the envelopes to remove any
curls and expel air from inside the envelopes.

❍ Remove any curling from the envelopes by holding the
edge of the envelopes diagonally and bending them
gently.

❍ Make sure the flaps of the envelopes are flat and not
curled.

Prepare the
envelopes.

PRESS DOWN FIRMLY ON
THE EDGES OF THE FLAP
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❍ Slide a stack of envelopes into the sheet feeder until it
stops.

❍ Align the edge of the paper guide with the left edge of the
stack of envelopes.

❍ Insert the envelopes with the print side up.

❍ Feed the top of the envelope (return address portion) 
into the sheet feeder first.

❍ Make sure the back flap is toward the sheet feeder.

Now you can start your print operation.

Insert the
envelopes.
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Using Canon’s Specialty Papers
This section provides guidelines for printing on Canon’s Specialty Papers
and describes special procedures required for High Resolution Paper,
Fabric Sheets, and Banner Paper.

Specialty Paper Guidelines

N Be sure to read any instructions that come with your Canon Specialty
Paper. These instructions provide important information regarding how
to achieve the highest print quality with these papers.

Follow these guidelines:

❍ When automatically feeding transparencies or back print film,
remove each sheet after it is delivered. Do not allow film sheets to
stack up.

❍ Let the printed sheets of film or paper dry completely before storing
them.

Paper type Drying time
Canon High Gloss Film HG-101 10 minutes
Canon Glossy Photo Paper GP-201 10 minutes
Canon Fabric Sheet FS-101 1 hour
Canon Transparencies CF-102 15 minutes
Canon Back Print Film BF-102 15 minutes

❍ When your output has dried completely, cover its printed side 
with a sheet of plain (not coated) paper before storing it; this is
recommended even if you place the sheets of film in a clear file or
plastic holder.
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❍ When loading transparencies or back print film, insert one sheet of
plain paper as the last sheet in the stack.

❍ Do not leave the film in the sheet feeder for long periods of time.
Dust and dirt may accumulate on the film resulting in spotty
printing.

❍ To avoid smudging caused by fingerprints, use a pair of thin cloth
gloves while loading and handling the film.

❍ To avoid fading, do not expose the printed film to prolonged
sunlight.

❍ Store unused papers and films flat. Do not remove papers from their
protective packaging until you are ready to use them.

❍ Store unused film at temperatures between 59°F to 86°F (15°C to
30°C). The relative humidity should be between 10% and 70%.

Uncurling Back Print Film

If Back Print Film becomes curled, follow these steps to uncurl it:

❍ Do not roll the film too tight.

❍ The film and paper rolled together should be about one
inch (2.5 cm) in diameter.

Roll the film 
and paper up in

the direction
opposite the curl. 

Cover the
nonglossy side 

of the film 
with a sheet 

of plain paper.
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❍ You may want to fasten the roll with a small piece of tape.

Canon’s High Resolution Paper HR-101

Using the Paper Output Guides

The output tray on your MultiPASS is equipped with paper output
guides. When using the optional BC-22e Photo BJ Cartridge or BC-29F
Neon BJ Cartridge to print on Canon’s High Resolution Paper HR-101,
lift the paper output guides on both sides of the output tray.

These guides help support the document as it exits the MultiPASS. The
guides keep the sheet from sagging as it exits and pulling through the
unit, which can lead to poor print quality.

❍ Lift both paper output guides until they are vertical. Always lift both
output guides.

Keep the film
rolled up for

about five
minutes.
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❍ When the output guides are raised, the output tray can hold a
maximum of 30 sheets.

❍ When you finish using the BC-22e Photo or BC-29F Neon 
BJ Cartridge with High Resolution Paper, lower the output 
guides to their original position.

❍ Always lower the paper guides when using the MultiPASS as a 
fax machine. The guides may cause paper to pile up and jam.

Using the Cleaning Sheet

Canon’s High Resolution Paper HR-101 is designed for high quality
printing. This paper is specially coated to produce delicate color output.

After using a package of High Resolution Paper (200 sheets), you need
to use the cleaning sheet enclosed with the paper to remove paper dust
from the printer’s rollers; this will help prevent paper feed problems.

❍ Make sure the paper thickness lever is to the center.Set up 
the printer.
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❍ Insert the sheet with the sticky side out (toward you) and
down (going into the sheet feeder).

❍ Adjust the paper guide to the edge of the cleaning sheet.

Insert the
cleaning sheet.

Remove the two
pieces of tape

from the sheet.
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❍ Press the < or > button until ROLLER CLEANING appears.

❍ Press START/COPY.

The cleaning sheet feeds through the
unit and ejects.

Fabric Sheet FS-101
Fabric Sheet FS-101 for Canon printers comes with a booklet that
describes special handling procedures. Be sure to look through this
booklet for special information regarding the Fabric Sheet. This section
describes specific steps for using Fabric Sheets with the Canon Bubble
Jet products.

Be sure to follow these guidelines:

❍ To avoid paper jams, smearing, and other problems, do not open the
printer’s cover during printing.

❍ Do not touch newly printed fabric sheets until the ink is completely
dry. This takes about one hour.

N Do not use the fixing agent that comes with the Fabric Sheet FS-101. This
agent is NOT needed when printing with the MultiPASS C5500.

ROLLER CLEANING

FUNCTIONTo feed the sheet,
press FUNCTION 

on the one- 
touch speed 
dial keypad.
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Printing On a Fabric Sheet

❍ Make sure the paper thickness lever is to the right
position.

❍ Make sure the paper support and paper output tray are
extended.

❍ Insert the sheet with the cloth side out (toward you) and
the open end up (away from the sheet feeder).

❍ Adjust the paper guide to the edge of the fabric sheet.

Insert the 
fabric sheet.

Set up 
the printer.

DO NOT TOUCH
THE GUIDE RAIL

DO NOT TOUCH
THE RIBBON
CABLE

OPEN END AT THE TOP
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❍ In the Paper tab, select A4 for the Paper Size and select
Fabric Sheet for the Print Media.

❍ In the Graphics tab, select High for the Print Quality. You
may also want to select Fine mode.

❍ Start the print operation from your Windows application.

❍ Let the printed fabric sheet set for about one hour to
allow the ink to completely dry.

❍ When dry, peel the film backing from the printed fabric
sheet.

❍ Wash the printed fabric sheet for about three minutes
under lukewarm running water to remove extra ink.

❍ Hang the fabric sheet up to dry it again.

❍ Iron the dried fabric sheet with a clothes iron.

❍ See the booklet that comes with Fabric Sheet FS-101 for
details on drying and washing.

Dry and 
then wash the

fabric sheet.

Set up 
the MultiPASS
Printer Driver 
for Windows.
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Printing On Banner Paper
Banner paper is a continuous sheet of paper with perforations at equal
distances along its length where it can be cut to the length required. For
best results, use Canon’s Banner Paper.

To set up a print job on banner paper, you must decide on the number
of sheets you need. You can print banners from 2 to 6 sheets in length.

N Always leave an extra sheet at the end of the banner—just in case the
type runs over.

The shaded portions of the drawing below illustrate the maximum
recommended printing area of banner paper.

N Printing on banner paper requires quite a bit of ink. If you think your 
BJ cartridge may run out of ink, use a new BJ cartridge.

For best print results on banner paper, use light design patterns.

To prevent ink from running over the edges of the sheet, print within
the margins shown in the previous illustration.
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❍ Place the MultiPASS near the edge of a table so that the
paper can flow over the edge as it exits the unit.

❍ Make sure the paper rest is extended.

❍ Press the CARTRIDGE button to move the cartridge
holder to the center of the unit.

❍ Open the printer cover by grasping the document guides
and lifting.

❍ Set the paper thickness lever.

• Set it to the center if you are using the BC-21e Color
BJ cartridge.

• Set it to the left if you are using the BC-20 Black 
BJ cartridge.

❍ Close the printer cover.

Set the paper
thickness lever.

Position the
MultiPASS.

P
rin
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DO NOT TOUCH THE RIBBON CABLE

DO NOT TOUCH THE GUIDE RAIL

DO NOT TOUCH THE ROUND SHAFT
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❍ Raise both output guides on the paper output tray.

❍ Your banner can be up to 6 sheets (66 in./1676 mm) long.Cut the banner
paper along 
one of the

perforations to
the length

required.

Adjust the 
paper output 

tray.
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Gently fold along
the perforations

between the first
and second sheets.

Place the paper
behind the

MultiPASS on a
flat surface.

P
rin

tin
g
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❍ Make sure the sheets behind the unit are also aligned with
the sheet feeder.

❍ Leave a 0.04 inch (1 mm) gap between the paper guide
and the edge of the sheet.

❍ Make sure the sheet is under the tabs on the sheet feeder
and paper guide.

Slide the paper
guide against the

edge of the sheet.

Insert the first
sheet into the

sheet feeder until
it stops.
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❍ From the File menu, select Print.

❍ Use the MultiPASS C5500 Printer Driver to select the
print options.

• Select Auto Feeder for the Paper Feed method.

• Select Banner for the Media Type.

❍ Select other options according to your software and
operating system. See your software instructions for
details.

• Enter 1 for the number of copies. Selecting any other
number may print the sheets in the wrong order.

• For the number of sheets, enter the number of sheets
you are printing.

❍ Click OK or PRINT to begin printing.

Allow the paper to flow over the edge of the table as it exits the
MultiPASS.

Open the
Windows

application you
will be using.

P
rin

tin
g
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The MultiPASS Desktop Manager is a full-featured Windows application
that enables you to use your MultiPASS C5500 from your computer. The
MultiPASS Desktop Manager coordinates the printing, PC faxing, and
scanning functions of the MultiPASS C5500. Its features include:

❍ Printing, PC faxing, and scanning control functions

❍ Manipulating and editing the faxed or scanned documents

❍ Folders that hold your faxes and scanned documents

❍ An Address Book where you store the names and fax numbers for
individuals and groups to whom you repeatedly send faxes

This chapter describes:

❍ Starting the MultiPASS Desktop Manager

❍ Exploring the MultiPASS Desktop Manager window

❍ Using the Desktop Manager folders

❍ Viewing documents in the Desktop Manager

❍ Setting up the Address Book

N Your MultiPASS C5500 is designed to be used with the MultiPASS
Desktop Manager. To use all the outstanding features of the MultiPASS
C5500 requires use of the Desktop Manager. To use the unit as a stand-
alone fax machine, see Appendix B.

3Using the MultiPASS
Desktop Manager
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Starting the MultiPASS Desktop Manager
When you start Windows, the MultiPASS Server is automatically 
started as well. The MultiPASS Server enables and monitors the
communication between the Desktop Manager and the MultiPASS
C5500. The MultiPASS Server must be open before you can open 
the Desktop Manager.

Once installed, you select the MultiPASS Desktop Manager from the
Programs list.

❍ Click the Start button and point to Programs.

❍ Point to Canon MultiPASS Desktop Manager 3.0 and then click
Canon MultiPASS Desktop Manager.

When you exit the Desktop Manager, you close only the Desktop
Manager window. Any documents you have set up to PC fax or print
remain active. The MultiPASS Server and the Send Fax Manager, which
tracks the progress of your active jobs, remain open and active.
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Exploring the MultiPASS Desktop 
Manager Window

When you start the MultiPASS Desktop Manager, you see a screen
similar to this:

Menu Bar
The menu bar contains the commands that enable you to perform the
various Desktop Manager tasks. Many of the commands can also be
accessed using their corresponding button on the toolbar.

Document Toolbar
The document toolbar provides quick access to certain tasks with a
selected document. When a task is unavailable, the toolbar button
appears dimmed.

MENU BAR

ACTION TOOLBAR

FOLDERS
LIST

COMMAND
BAR

STATUS BAR

DOCUMENT TOOLBAR

WORK
AREA

DUPLICATE REMOVE
PAGE

EDIT
KEYWORDS

MANUAL
INDEXINGSEARCH

SELECT
ALL SPLIT

LIST VIEW SHOW
SEARCH
RESULTS

DOCUMENT
VIEWARRANGE

MERGE
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Action Toolbar
The action toolbar provides quick access to certain Desktop Manager
tasks. When a task is unavailable, the toolbar button appears dimmed.

Like any Windows toolbar, you can move either the action or document
toolbar anywhere on the Desktop Manager workspace to suit your own
working habits.

ToolTips are also available, providing descriptions of the toolbar
buttons. To display a ToolTip, pause the mouse pointer when it is
directly over a button.

Folders List
The folders list contains folders that store your documents (sorted in
alphabetical order). The list conains both system-defined folders, which
were automatically created when you installed the software, and user-
defined folders, which you create as you need them. As you add folders
to the folder Cabinet, notice that the list displays similar to Windows
Explorer, in a hierarchical view.

Work Area
The work area appears to the right of the folders list and displays the
documents contained in the open folder. The documents are displayed
either as a graphic thumbnail of each document (Document View) or a
list of the documents (List view).

The width of the work area can be adjusted by dragging the border (the
split bar) between the work area and folders list.

FAX
MEMO

ADDRESS
BOOK

DELETE

FAX
SETUPSCAN FAX LOG

SEND FAX
MANAGER

HELP
CONTENTS

MANAGE
COVER
PAGESIMPORT

COVER
PAGE
DESIGNER
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Command Bar
The command bar is located at the bottom of the work area and
contains buttons that perform key processing tasks. In most cases, you
simply drag a document from the work area onto the command bar
button for the task you want to perform.

You can also launch other Windows applications such as your e-mail
program, Paint, or WordPad. Microsoft Paint is automatically placed on
the Process toolbar. See page 8-16 for deails on how to add other
programs to the Launcher.

A Phone button displays in the command bar if you connect a 
telephone to your MultiPASS and you check the “Telephone Attached 
to Unit” option in the Desktop Manager Setup Options dialog box.
(See Chapter 8, Setup and Other Utilities in the Desktop Manager.)

You use the process toolbar buttons as follows:

❍ Drag a document to the process button—For example, you can drag
a document from a folder or from the work area to the Print button
in order to print the document.

If a document is dragged to a button that cannot perform the 
task, the mouse pointer displays as a “No” icon (a circle with a
diagonal bar drawn through it    ).

❍ Highlight a document in a folder and then click a process toolbar
button—This method activates the command for the selected
document, as though the document had been dragged to the button.

❍ Double-click a launching icon—This starts the application as if it
were started from the Windows desktop.

Status Bar
The status bar displays information about the selected document or
folder, or a description of the currently selected menu or toolbar
command. It also displays the current date and time. The information is
for display only and cannot be edited.

VIEW E-MAIL

FAXPRINT

EXPORT
LAUNCH
APPLICATIONS
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Using the Desktop Manager Folders
The Desktop Manager stores and organizes documents in folders. Only
one folder can be open at a time. When you open another folder, the
current folder automatically closes.

You can organize your documents in any manner you want, placing
documents in folders, or folders within folders as may be desirable.

As previously mentioned, the organization of the folders list is much 
like Windows Explorer, which means you have great flexibility in
determining how best to store your documents.

System-defined Folders
When you installed the Desktop Manager, a number of system-defined
folders were automatically created—In Box, Sent Fax, Scan, Trash, and
Cabinet (which contains the folders you create). You can tell which
folder is open by the folder icon—it will look open or closed.

You cannot add new folders or documents to the system-defined folders.
The system-defined folders are reserved for use by the Desktop Manager
in the following ways:

❍ With the exception of the Trash folder, only the Desktop Manager
can place documents in system-defined folders, based on faxes sent
or received, or images scanned. Generally, you can only rename,
copy, move, or delete documents from these folders.

❍ The system-defined folders, including the Trash folder, cannot be
deleted or renamed.

❍ A document remains in a system-defined folder until you move it to
a user-defined folder, or delete it.

In Box Folder
The In Box folder is automatically open each time you start the Desktop
Manager (even if it is empty). It stores all incoming faxes that were sent
to you by other fax machines, received by your MultiPASS, and then
uploaded to your PC.
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Each received fax is displayed using a system-assigned name (for
example, Untitled 0001). You can change the name to something more
descriptive by highlighting the document, and choosing the Rename
command from the Edit menu, or by clicking the right mouse button
and choosing Rename. In the Rename dialog box, type the new name
and click OK. Documents which have not been viewed in the In Box
folder display in bold.

Scan Folder
The Scan folder stores all images you scan with the MultiPASS from the
Desktop Manager. Each document displays with a system-assigned
name, which you can change.

Sent Fax Folder
The Sent Fax folder contains all documents that have been successfully
sent as PC faxes and that you requested not to be deleted after sending.
Each sent fax displays with the name “Untitled”, which you can change.

Trash Folder
The Trash folder stores all the documents you remove from the folders
list or work area. You move a document to the Trash folder by dragging
it onto the Trash icon, or by highlighting the document and then using
the Delete key (on your keyboard), the Delete command from the Edit
menu (or by clicking the right mouse button), or the Delete toolbar
icon.

Once you move a document to the Trash folder, it remains there until
you choose the Empty Trash command from the File menu. The Empty
Trash command permanently removes all items in the Trash folder.

User-defined Folders
You can create an unlimited number of folders for your own use in the
file Cabinet; the Cabinet acts as your “root directory.” You cannot place
documents directly into the file Cabinet; you must place them in folders
within the file Cabinet.
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Creating a New Folder
1. Click the Cabinet icon, or the folder within which you want to store

the new folder.

2. Choose the New Folder command from the File menu, or click the
right mouse button and choose New Folder.

3. In the MultiPASS Create Folder dialog box, type a name for the
folder and click OK.

If you create multiple folders or place folders within folders, you can
navigate among your folders and documents just like you do in
Windows Explorer. To display the contents of a folder, either double-
click it or click the (+) next to the folder name. To collapse an open
folder tree, double-click it or click the (-) next to the folder name.
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Viewing Documents in the Desktop Manager
When you open a folder, you can view the documents which are
contained in that folder in a List View or a Document View.

When you first open the Desktop Manager, documents are automatically
displayed in List View. However, you can change to Document View at
any time by clicking the Document View button on the toolbar, or by
choosing the Document View command from the View menu.

If the number of documents within a folder exceeds the available work
area, horizontal and/or vertical scroll bars display. You can use them to
scroll the work area to view all the documents.

To open a folder, click the desired folder in the folders list.

Document View
Document View displays each individual document as a thumbnail titled
with the document name. For multiple page documents, the thumbnail
also displays the page count, as well as scroll arrows at the bottom and a
scroll box at the right side. The scroll arrows and scroll box enable you
to page through a multi-page document, displaying each page in turn or
moving to a particular page in the document.
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Document View allows you to work with an individual document at the
page level: scrolling pages, removing a page, splitting a document, or
merging two or more documents into a single document. You can
rearrange the document thumbnails within the work area as needed by
simply dragging them to the desired location. To equally align
thumbnails, choose the Arrange command from the View menu.

To view documents in a folder as thumbnails, make sure the folder is
open. Then choose the Document View command from the View menu
or click the Document View toolbar button on the Document toolbar.

List View
List View displays documents within the open folder as a list. Each
document in the list displays an icon representing the document type,
along with other pertinent information about the document (such as its
name, page count, disk storage size, date and time of creation, and its
origin). If the document is a fax, the connection number and ID are
displayed.

The icon designates the document type as fax, scan, or modified. A
modified document is a document where the fax cover page has been
removed, a scanned document that has been annotated, or a multi-page
document that has been split into multiple documents.
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Documents displayed in List View cannot be manipulated as in
Document View, such as splitting a document or merging two or more
documents. You can however, duplicate a document by highlighting it
and choosing the Duplicate command from the Edit menu, or by
clicking the right mouse button and choosing Duplicate.

To view documents in a folder as a list, make sure the folder is open.
Then choose the List View command from the View menu or click the
List View button from the Document toolbar.

Sorting Documents in the List
You can change the order of the listed documents using any of the
column labels displayed at the top of the list—type, name, number of
pages, size, and date—by simply clicking on the column label. You can
also select Sort By options from the View menu, or by clicking the right-
mouse button in the work area. Sorting by page, size, or date and time
displays documents with the largest document or most current
document last. The list will display in the selected order each time you
open the folder unless you change the sort option.

To change the order of the list, click the title of the appropriate column
at the top of the list. To return the sort to its previous order, click the
column again.

Viewing Documents
To view a document, double-click it, or choose the Open Document
command from the File menu. The MultiPASS Viewer will be launched
and will display the selected page.
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Setting Up the Address Book
One of the first things you'll want to do in the Desktop Manager is set
up your Address Book. Setting up an Address Book creates an easily
accessible list of names and fax/phone/e-mail numbers for all of your
business and personal contacts. Using the entries from the Address Book
makes sending a PC fax quick and easy.

Opening the Address Book
On the Tools menu or toolbar, click Address Book.

You see a screen similar to this:

ADDRESS BOOK
ENTRIES

STATUS BAR

COMMAND
BUTTONS
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Address Book Entries
Address Book entries are listed alphabetically by last name, displaying
both group and individual names, company name, phone, fax, and 
e-mail information. You can sort Address Book entries by any column
description by simply clicking on the column title. To return the sort 
to its previous state, click the column title again.

Status Bar
The status bar displays additional information for a selected Address
Book entry, based on whether the selected entry is an individual entry
(title, street address, and comments) or group entry (comments about
the group).

Command Buttons
Use the command buttons to perform various tasks while working with
the Address Book, such as editing an entry, deleting an entry, creating a
new entry or group, or importing/exporting information.

To close the Address Book, simply click OK.

To print the Address Book entries, click Print.

Working With Address Book Entries
There are two types of Address Book entries:

Individual
An individual entry allows you to identify each individual to whom you
frequently send PC faxes. Once entered, you can quickly specify the
recipient of a PC fax by selecting them from the Address Book.

Group
A group entry identifies two or more individual Address Book entries to
whom you repeatedly send the same PC fax. For example, you may want
to set up a group to include those individuals involved in a particular
business project. When you specify the group entry as the fax recipient
on your PC fax, the PC fax is sent to each individual in the group.

Sorting the Address Book
The Address Book is, by default, sorted alphabetically by last name. You
can change the sort by clicking on any column title. To return the sort to
its previous state, click the column title again.

M
ul

tiP
A

S
S

D
es

kt
op

 M
an

ag
er



3-14 Using the MultiPASS Desktop Manager Chapter 3

Adding and Editing an Individual Address
When setting up an individual Address Book entry, at a minimum, you
must specify the contact’s first or last name, and their fax number.
Optionally, if you want information available to include on a fax cover
page, you can enter the contact’s phone number, title, company name,
and address. You can also enter a comment to provide an internal
reference about the recipient, and an e-mail address.

1. With the Address Book open, click the desired command to add or
edit an individual entry.

• To add a new individual, click New Individual.

• To edit an individual record, highlight the entry in the list, then
click Edit.

2. In the Individual Entry dialog box, enter or change this information.

• First Name, Last Name

• Phone number, Fax number, and E-mail address

• Whether your primary preference is to use this listing for faxing
(the default selection) or e-mail

• Title, Company name, and Address (if you want the information
available for a fax cover page)

• Comments (as an internal reference)

• Use Outside Dialing Prefix (if you need to use a prefix to access
an outside line)
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3. Save your entry.

• If adding a new entry, click Add.

• If editing an existing entry, click Replace.

• To cancel without saving any entry/changes which may have
been made, click Cancel.

Entering Fax Numbers, Phone Numbers, and 
E-mail Addresses
When you enter the fax or phone number, or an e-mail address, you use
the actual numeric characters plus any valid characters that separate the
different segments of the number. For example, you can use 0 through 9,
dash (-), parentheses (), and the @ symbol. The following characters are
valid in the Desktop Manager:

Character Description

0 to 9 * # + Dialing digits

, p Pause

P Last Pause

T Tone switch over function

- ( ) Space Display-only characters; Space cannot be
used at the beginning of a number

N If your phone system requires a prefix number to access an outside
phone line, do not include it here. If required, define a prefix number 
in the Desktop Manager Setup Options dialog box (see page 8-4).
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Adding and Editing a Group Address
A group address consists of previously set up addresses, either
individual(s) or other group(s). When adding a new group, you 
assign a name to the group, then select previously defined addresses
from the Address Book to include in the new group. When editing 
an existing group address, you can add additional addresses or delete
addresses from the group.

1. With the Address Book open, click the applicable command to add
or edit a group entry.

• To add a new group, click New Group.

• To edit a group, highlight the entry in the Address Book, then
click Edit.

2. In the Group Name box, enter or change the name you want to
assign to this group.

• In the Address Book list box, click the individual entry you want
to add to the group, then click Add. Repeat this step for each
individual or group you want to add to this group.

• To remove an entry from the group, click the name in the Group
list on the right, then click Remove.

• Enter any desired internal reference comments for the group in
the Comments box.
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3. Save your entry.

• If adding a new group, click Create.

• If editing an existing group, click Replace.

• To cancel without saving any entry/changes which have been
made, click Cancel.

Using a Group Address
If you specify a group address when sending a fax, the address for each
individual contained in the group is listed. If you specify more than one
group address for a fax, any duplicate addresses are automatically
removed. Separate fax jobs are created for each recipient in the group.

Deleting an Address Book entry
You delete an Address Book entry when it is no longer needed.

To delete an entry, click the name in the Address Book, then click
Delete, or press the Delete key on your keyboard. If prompted, confirm
that you want to delete the entry.

Printing the Address Book
If you want a hard copy of the Address Book, you can print it as follows:

1. With the Address Book open, click Print.

2. In the Print dialog box, specify your print options and click OK.

This report provides you with a hard copy of your Address Book
information.
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Importing an Address Book
If you have an existing address book created in another application, you
can import it into the Desktop Manager. You can also specify which
fields you want to include.

Any ASCII text file containing information that is separated by a comma
or tab can be imported into the Desktop Manager Address Book.

❍ If the address information in the text file is separated by a comma,
the text file extension must be .CSV.

❍ If the address information in the text file is separated by a tab, the
text file extension must be .TXT.

You must save your text file as a comma or tab separated text file before
you import it into the Desktop Manager. If you attempt to import
information from an improperly formatted text file, an error message
displays alerting you to a problem and the import process stops.

For procedures on saving a text file in the correct format, refer to the
applicable application’s user documentation.

Importing Addresses From a Text File
1. With the Address Book open, click Import.

2. Select the file type.

• In the Import Address Book dialog box, select whether you are
importing a .CSV file or a .TXT file from the Files of Type list.

• Highlight the file you want to import, then click Open.
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3. In the Import/Export File Fields dialog box, select the address fields
you wish to import from the Address Book Fields list.

• Highlight the field, then click Add.

• To remove a field, in the File Fields list box, click the field, then
click Remove.

• To rearrange the order of the fields, highlight the field you want
to move, then click Move Up or Move Down.

• Once you have the fields in the desired order, click OK.

Exporting the Address Book
You can export the Address Book from the Desktop Manager as an
ASCII text file. Exported address information can be separated by either
commas or tabs.

❍ If you want to have address information separated by commas,
choose to export to the .CSV file format.

❍ If you want to have the address information in the text file separated
by tabs, choose to export to the .TXT file format.

N Address Book information can only be exported for individual entries.
Group addresses cannot be exported.
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1. With the Address Book open, click Export.

• A message displays informing you that Group addresses cannot
be exported. Click Yes to close the message.

2. In the Export Address Book dialog box, select whether you are
exporting a .CSV file or a .TXT file from the Files of Type list.

• Specify the location where you want to export the file, type a file
name for the file in the File Name box, then click Open. The
Import/Export dialog box displays.

3. Select the address fields you want to export from the Address Book
Fields list box.

• Highlight the field, then click Add.

• To remove a field, in the File Fields list box, click the field, then
click Remove.

• To rearrange the order of the fields, highlight the field you want
to move, then click Move Up or Move Down.

• Once you have the fields in the desired order, click OK.
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You can use the MultiPASS C5500 to send paper faxes or PC faxes.
PC faxing is the ability to send a fax from an application without first
printing the document. Using the MultiPASS C5500 and the MultiPASS
Desktop Manager, you can PC fax documents from any Windows
application that supports printing.

You can also set up an Address Book, containing fax and e-mail
information for people to whom you often send faxes, and design your
own fax cover page. To assist you in managing your faxes, a Fax Log
maintains a record of every fax you send or receive.

You can also customize your MultiPASS printer by changing the factory
default user settings. This might include the date format that displays on
your faxed documents, or how many times the MultiPASS calls another
fax unit if the other party’s line is initially busy. You can also register
one-touch/coded speed dial and group numbers using the Desktop
Manager and then download them to the MultiPASS. For details on
changing setup options, refer to Chapter 8, Setup and Other Utilities in
the Desktop Manager.

This chapter describes:

❍ Sending a document

❍ Sending a document to more than one location

❍ Adjusting the quality of your faxes

❍ Sending PC faxes

❍ Using the Send Fax Manager

❍ Using the Fax Log

❍ Designing a fax cover page

N Because the MultiPASS is a multitasking device, you can send a fax and
print a document at the same time.

4Sending Faxes With
the MultiPASS C5500
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Sending a Document
The MultiPASS starts sending a document while it is being scanned into
memory. When scanning a multipage document, the unit calls the other
party after the first page is scanned. Once connection is made, the
MultiPASS begins to transmit the information while the remaining pages
are being scanned. This is called Memory Sending.

Regular Dialing

❍ Place the document face down in the Automatic
Document Feeder (ADF). See page 1-14.

❍ The LCD display shows how much of the unit’s memory
is in use, then displays the current resolution, and then
the message DOCUMENT READY.

❍ Change the resolution if necessary. See page 4-13.

❍ Use the numeric buttons to dial the number.

TEL=       555  7899

Dial the other
party’s fax

number.

DOCUMENT READY

FAX STANDARD

MEMORY USED 0%

Feed the
document.
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The MultiPASS begins scanning the
document, and dials the number.

❍ After a few seconds, the display shows the transaction
number for the fax. This is a unique number the
MultiPASS assigns to the document and uses to identify
the document in transaction reports:

The MultiPASS continues to show these displays in order
while the fax is being scanned.

❍ After the document is scanned in, the MultiPASS shows
these displays while the fax is being sent:

ECM TX           P.001

11234567899

CANON FAX BACK

TX/RX NO.      0001

11234567899

CALLING

SCANNING      P.001

TX/RX NO.      0001

TX

Press START/COPY.
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❍ When the document has been sent successfully, the
display shows these messages.

The MultiPASS automatically redials if the receiving fax does
not answer, if the line is busy, or if a transmission error
occurs. You can specify the number of times it redials using
the Retries option in the Send Fax dialog box of the
MultiPASS Desktop Manager (see page 8-4). If all redial
attempts fail, the MultiPASS beeps intermittently for a few
seconds. If this happens, check the fax number and try
sending the fax again.

If the ALARM light is flashing, correct the error described in
the LCD display, and then press STOP. You may need to open
the operator panel to remove the document from the ADF
(see page 10-3).

Automatic Dialing
You can send a document using one-touch speed dialing, coded speed
dialing, or group dialing. You must register the one-touch speed dialing
numbers, the coded speed-dialing numbers, and the group dialing
numbers using the MultiPASS Desktop Manager before you can send
documents using these automatic dialing methods. See Setting Up Speed
Dial Assignments on page 8-12.

❍ Place the document face down in the ADF.

DOCUMENT READY

Load the
document.

TX/RX NO. 0001

TRANSMITTING OK
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❍ Press the one-touch speed dialing button (1 through 6)
assigned to the number you wish to fax to; the name
assigned to that button is displayed.

OR

❍ Press CODED DIAL and enter the appropriate two-digit
coded speed dialing code.

❍ If a number is not registered for the button or codes, the
LCD displays NO TEL # message. Make sure you pressed
the correct button or entered the correct code and that
the number you want to dial is entered correctly.

❍ If you make a mistake, press STOP. Then press the correct
one-touch speed dialing button or press CODED DIAL and
re-enter the code.

❍ If you do not press START/COPY within five seconds, the
MultiPASS starts sending your document automatically.

❍ If the ALARM light is flashing for any reason, correct the error
and press STOP. You may need to open the operator panel to
remove the document from the ADF (see page 10-3).

DIALINGPress START/COPY.

CCSI/MKT

CANON FAX BACK

Use automatic
dialing.
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Sending a Document Using Group Dialing
If you frequently send plain paper faxes to the same group of people,
you can use the MultiPASS Desktop Manager to assign a “group” of
numbers to a speed dial code. (See page 8-13.)

❍ Place the document face down in the ADF.

❍ Press the one-touch speed dialing button or press CODED
DIAL and the code under which you registered the group.

❍ The MultiPASS starts scanning your document into
memory five seconds after you select the group to 
which you will send the fax, even if you do not press
START/COPY (ten seconds if you are sending to more
than one group).

❍ After scanning the document into memory, the
MultiPASS automatically dials each number in 
the group.

SCANNING       P.001Press START/COPY.

02 CANON GROUP

Choose the 
group you wish 

to  send to.

DOCUMENT READY

Feed the
document.
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❍ If there is no group registered under the one-touch speed
dialing button or the two-digit code, the LCD displays the
NO TEL # message. Make sure you entered the correct
number and that the group has been registered correctly
to a speed dial code. (See page 8-13.)

❍ If you make a mistake when dialing, press STOP. You can
then try again.

Redialing

Manual
To start dialing again, just press REDIAL . The MultiPASS redials the
previous number you dialed with the numeric buttons. Make sure the
document is in the ADF.

Automatic
The MultiPASS automatically redials if the first attempt at sending fails
(for example, if the line is busy). The unit redials twice, and the time
between redials is two minutes. (These are the default settings.) The
LCD displays AUTO REDIAL and the transaction number while the
MultiPASS is redialing.

If the MultiPASS fails to make a connection after the last redial, it 
beeps. The LCD displays BUSY/NO SIGNAL; try sending again later.

You can change the number of redials (retries) and the time between
redials. The redialing options are set in the Send Fax dialog box of the
MultiPASS Desktop Manager; see page 8-4.

BUSY/NO SIGNAL

TX/RX NO.       XXXX

AUTO REDIAL
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To Cancel Automatic Redialing
To cancel automatic redialing, press the STOP button. However, you
cannot cancel redialing while the LCD displays AUTO REDIAL (the unit is
waiting to redial). In this case, wait until dialing begins and then press
STOP to cancel redialing. The MultiPASS asks you to confirm:

To cancel the redialing, press *. The MultiPASS beeps and the LCD
displays:

The unit then prints an error report:

Resending a Fax After an Error
If you get an error while sending a fax from memory, the MultiPASS can
resend it to the same destination without having to rescan it. To do this,
the On Error Resend option must be set in the Advanced: Send Fax
dialog box of the MultiPASS Desktop Manager. See page 8-5 for details.

You can also set how much of the fax is sent again:

❍ The entire document (All Pages)

❍ The first page of the document, the page on which the error
occurred, and all following pages (Error & First Pages)

❍ The page on which the error occurred and all pages following the
error (Error Pages)

N The fax is erased from memory after it is successfully sent or after the
resending fails.

PRINTING REPORT

TX/RX NO.       XXXX

TX/RX    CANCELLED

YES = (*)     NO = (#)
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Manual Sending
If you would like to speak with the other party before sending a fax to
them, you may do so; this is called manual sending. To use manual
sending, you must have a telephone connected to the MultiPASS.

❍ Place the document face down in the ADF.

❍ You can use regular dialing or any of the automatic
dialing methods.

❍ If a person answers, you can converse normally. When
you are ready to send the fax, ask them to press the start
button on their fax machine. Then press START/COPY on
your unit and hang up the telephone.

Faxing starts.

❍ Be sure to press START/COPY before you hang up, or you
will disconnect the call.

Converse with the
other party.

TEL=         4567899

Pick up the
telephone and 
dial the other

party’s fax 
number. 

DOCUMENT READY

Feed the
document.
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Cancel Sending
To stop sending before a fax is complete, follow these steps:

❍ If you are sending manually, the transmission is cancelled
immediately.

❍ If you are sending from memory, the LCD displays:

❍ Press * to cancel or press # to continue the transmission.

Transmission continues.

If you press STOP while the document is being scanned, you may need
to open the operator panel to remove the document (see page 10-3).

TX/RX CANCELLED

Press *
or #.

YES = (*)     NO = (#)

Press STOP.
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Sending a Document to More Than One
Location (Sequential Broadcasting)

Sequential broadcasting sends one document to more than one location.
You can send to a total of 57 destinations as follows:

One-touch speed dialing = up to 6 destinations
Coded speed dialing = up to 50 destinations
Regular dialing (numeric 
buttons dialing) = 1 destination only

You can enter the one-touch and coded speed dialing numbers in any
order. You simply press the one-touch speed dialing button, or press
CODED DIAL followed by the two-digit code.

You can also include one destination using regular dialing. This must be
the last number you enter because you must press START/COPY after
entering the number.

N If you often send to the same group of destinations, use group dialing
(see page 8-13).

Transmitting the Document

❍ Place the document face down in the ADF.

DOCUMENT READY

Feed the
document.
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❍ Simply enter the numbers one after the other:
press the desired one-touch speed dialing button 
or press CODED DIAL followed by the two-digit code.

❍ If you are sending to group dialing destinations, use the
one-touch speed dialing buttons and the CODED DIAL
button (along with the two-digit codes) to enter the
groups.

❍ You must press the second speed dialing number within
five seconds of pressing the first one. Each subsequent
speed dialing number must be entered within ten seconds
of the preceding one.

❍ You can enter only one number directly from the numeric
keypad using regular dialing. This must be the last
number you enter.

❍ The MultiPASS scans the entire document into memory
and begins sending.

TX
Press 

START/COPY.

TEL= 4567899

Dial the other
party’s number.
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❍ The MultiPASS begins the operation approximately ten
seconds after you press the last button (five seconds if you
press only one button) even if you do not press
START/COPY.

❍ The MultiPASS dials the destinations in numerical order
starting with the coded dial numbers, then the one-touch
numbers, and finally the regular-dial number (regardless of
the order in which you entered the numbers).

❍ To cancel a transmission, press STOP during the dialing
or transmission. All subsequent transmissions in the
sequence are cancelled. (You may need to open the
operator panel to remove the document; see page 10-3.)

N If the memory becomes full while scanning your document, the LCD
displays MEMORY FULL. (You may need to open the operator panel 
to remove the document; see page 10-3.) You can split the document
into two or three different jobs, or you can try sending the document to
one location at a time.

Adjusting the Quality of Your Faxes
Canon’s Ultra High Quality (UHQ™) imaging technology enables you
to send faxes that have a print quality very close to that of the original
document. The MultiPASS also allows you to adjust the resolution and
contrast it uses in sending faxes to best suit your particular document.

Setting the Resolution
Resolution is a measure of the fineness or clarity of a printout and is
usually expressed in horizontal and vertical dots per inch (dpi). Low
resolutions may cause text and graphics to have a jagged appearance,
while higher resolutions provide smoother curves and lines, crisp text
and graphics, and a better match to traditional typeface designs.
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The MultiPASS has three resolution settings. You use the B&W FAX/COPY
button to set the resolution for faxing documents.

❍ FAX STANDARD
Fax standard resolution (203 × 98 dpi) is adequate for most text
documents.

❍ FAX FINE
Fax fine resolution (203 × 196 dpi) is suited for documents with fine
print (smaller than the print in this sentence).

❍ FAX PHOTO
Fax photo resolution (203 × 196 dpi, with halftones) is for
documents that contain photographs. With this setting, areas of the
document that contain photos are automatically scanned with 64
levels of gray, rather than just two (black and white) which it uses
otherwise. This gives a much better reproduction of the photos,
though transmission time is longer.

N The COLOR COPY button is used only for making color copies; it is
inoperative when sending faxes.

B&W FAX/COPY
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❍ The LCD shows the current resolution.

❍ Press B&W FAX/COPY once or twice more to display the
resolution you want (FAX STANDARD, FAX FINE, or
FAX PHOTO).

❍ After about five seconds, the LCD returns to Standby
mode.

Setting the Contrast
Contrast is the difference in brightness between the lightest and 
darkest parts of a printed document. You can adjust the contrast the
MultiPASS uses for sending faxes (Darker, Standard, or Lighter) through
the Advanced: Send Fax dialog box in the MultiPASS Desktop Manager.
(See page 8-5 for details.) Standard is the default, and is adequate for
most documents. To darken a light original, choose Darker; to lighten 
a dark original, use Lighter.

08/11/98 FaxTel

FAX PHOTO

FAX FINE

FAX STANDARD

Press the
B&W FAX/COPY

button again.

FAX STANDARD 

Press the
B&W FAX/COPY

button.
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Sending PC Faxes
You can create a fax memo in the MultiPASS Desktop Manager or create
and send a PC fax from any Windows application that supports printing.
You can PC fax the document immediately, send it at a specific time, or
hold it in the Send Fax Manager to be sent at a future time.

N Before sending a PC fax, make sure that the date and time in your
computer is correct. The system date and time displays on all PC faxes
that you send. If you need to change the date and time, refer to your
Windows user documentation.

Specifying Send Fax Information
Whenever you send a PC fax, you see the MultiPASS Send Fax 
dialog box:
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Specifying a Fax Recipient
You must specify at least one fax recipient—the individual and/or group
to whom you want to send the fax. When specifying a recipient, you can
enter one-time information and/or include one or more recipients from
your Address Book.

A one-time recipient is specified by entering the recipient’s name (First
Name and Last Name), Company name, and Fax number in the
corresponding boxes of the Send Fax dialog box. In some office
environments, you may also need to enter a prefix for the fax number,
which is the number required to connect you to an outside phone line
(usually 9). If so, click the Use Outside Dialing Prefix option so that a
check appears. You define the outside dialing prefix in the Fax Setup
options; see page 8-4).

You can also add a new recipient to your Address Book directly from the
Send Fax dialog box as described below.

When you enter a fax number, use the actual numeric numbers plus any
valid characters that separate the different segments of the fax number.
For example, you can use 0 through 9, dash (-), or parentheses (). The
following fax/phone characters are valid in the Desktop Manager:

Character Description

0 to 9 * # + Dialing digits

, p Pause

P Last Pause

T Tone switch-over function

- ( ) Space Display-only characters. Space cannot be
used at the beginning of a number

Including a fax recipient from the Address Book

The Address Book box displays all recipients that you have set up in your
Address Book. You can include one or more recipients by highlighting
the name and clicking the Add button. Selected names display in the
Recipients box and appear disabled in the Address Book box. This is to
prevent you from selecting the same recipient twice.
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Removing a fax recipient

You can remove a name included in the Recipients box by clicking the
name and then clicking Remove. If the recipient was previously added to
the Address Book, the name again becomes available in the Address
Book box.

Adding a new recipient to the Address Book

1. Enter the recipient information in the First Name, Last Name,
Company, Prefix, Fax, and Email Address boxes.

2. Click New Individual Entry.

3. Complete the fields in the New Recipient dialog box as necessary
and click Add.

• For detailed instructions on adding a new individual to the
Address Book, refer to Working With Address Book Entries on
page 3-13.

Entering a subject

Enter text in the Subject box if desired.

Defining Send Fax Options
Attaching a cover page

If desired, you can attach a cover page to your fax. The MultiPASS
Desktop Manager contains a library of predefined fax cover pages, each
providing a different style for both business and personal use. In
addition, you can design your own cover page using the MultiPASS
Cover Page Designer and add it to the library. Available cover pages are
listed alphabetically in the Template list.

For instructions on designing your own cover page, refer to Designing a
Fax Cover Page on page 4-31.
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Previewing the cover page

To view a selected cover page before sending the fax, click Preview. The
cover page displays the specified recipient(s) and other fax information,
including memo text. This display is read only; you cannot edit it.

To print the cover sheet, choose the Print command from the File menu.
In the Print dialog, choose your printing options and click OK.

To close the Preview window, choose the Exit command from the File
menu. For instructions on editing a cover page, refer to Designing a Fax
Cover Page on page 4-31.

Entering fax sender information 

To identify yourself as the sender of the PC fax, enter your name and
telephone number in the From and Phone boxes. Once you send your
first PC fax, this information is automatically displayed the next time
you send a PC fax. You can change the information as necessary.
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Entering a memo

You can include a memo on the fax cover page if the cover page is
designed to accept memo text. The font, style, and size of the memo text
is determined by the particular design of the selected cover page. You
can change these attributes using the MultiPASS Cover Page Designer.
For instructions on editing a cover page, refer to Designing a Fax Cover
Page on page 4-31.

Deleting the fax after sending

If you select the Delete after Sending option, the fax is automatically
deleted after it has been successfully transmitted. This option makes it
easy to keep your computer free of unneeded documents, thereby
maximizing your available disk space.

If you do not select this option, the fax is automatically moved from the
Send Fax Manager to the Sent Fax folder after transmission.

Including annotations

Using the editing capabilities of the MultiPASS Viewer (described 
in Chapter 7, Working With Documents in the Desktop Manager, you 
may have modified your document—for example, by adding text
annotations, graphic or text stamps, or highlighting. In this case, you 
can choose to include these modifications by clicking the Include
Annotations option.

If you do not select this option, the original version of the document is
faxed, without any added annotations.

Processing the Fax
You can send your fax—either now or later—only when you have
specified at least one recipient and fax number. As necessary, you can
also place a fax on hold and return to it later. The following sections
provide additional information on these processing options.

Sending the fax now

When you click Send Now, the fax document is sent to the Send Fax
Manager until it is transmitted. Once transmission is complete, the fax 
is either moved to the Sent Fax folder or deleted, based on whether you
enabled or disabled the Delete after Sending option.



Chapter 4 Sending Faxes With the MultiPASS C5500 4-21

If a fax fails (for example, because of an incorrect fax number), it
remains in the Send Fax Manager until you attempt to resend it or 
delete it.

For more information on working with the Send Fax Manager, see 
page 4-25.

Sending the fax later

If you prefer to send the fax later, you can specify the date and time 
to send it by clicking Send Later. In the Send Later dialog box, select 
the desired transmission date and time from their respective lists, and
click OK.

The fax is sent to the Send Fax Manager for processing at the specified
date and time.

Holding the fax

You can place a fax document on hold at any time prior to sending 
it, as long as you have specified at least a fax number. The held fax is 
sent to the Send Fax Manager with no specified transmission time.
Any fax information you entered—such as recipients or cover page
information—is preserved. You can decide later whether to send the
fax—revising the send information as needed—or to delete it.

Canceling the fax

If you cancel the fax while working in the Send Fax dialog, you are
returned to the application where you originally initiated the Send Fax
(or Print using the MultiPASS Fax driver) command.
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Creating a Fax Memo
A fax memo is generally a brief (one-page maximum) fax sent directly
from the Desktop Manager, without using another Windows application
to create it. Operating directly from the Desktop Manager, you specify
the same fax options as described in the Specifying Send Fax Information
section starting on page 4-16.

❍ See Specifying Send Fax Information starting on page 4-16
for details.

In the Send Fax
dialog box, 

enter your fax
information and

send fax options.

From the Desktop
Manager, choose

the Fax Memo
command from
the File menu 

or toolbar.
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N Because the fax memo is not originating from a document created in
another Windows application, be sure to enter the memo message in the
Memo box. Also, because your fax memo does not originate from a
document that may have been annotated in the MultiPASS Viewer, the
Include Annotations option is not available.

The MultiPASS Desktop Manager sends the PC fax to the Send Fax
Manager, where it is automatically given a unique system-assigned
name, and its progress is tracked until it is actually transmitted. If you
specified multiple recipients, an individual fax job for each recipient,
with its own fax job number, is sent to the Send Fax Manager. Once
transmitted, the fax is placed in your Sent Fax folder (unless you
specified that it be deleted after transmission). A record of the sent 
fax is also recorded to the Fax Log.

Sending a PC Fax From a Windows Application

❍ Open the Windows application.

❍ Create and save the document.

❍ Make sure the document is open.

❍ In most Windows applications, you select Print or Print
Setup from the File menu or the toolbar.

❍ In the Print dialog box, make sure the Canon MultiPASS
C5500 Fax is selected as your printer, then click Print.

Select the Print
command in the

application.

Create a PC 
fax document.
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❍ See Specifying Send Fax Information starting on page 4-16
for details.

The MultiPASS Desktop Manager sends the PC fax to the Send Fax
Manager, where it is automatically given a unique system-assigned
name, and its progress is tracked until it is actually transmitted. If you
specified multiple recipients, an individual fax job for each recipient,
with its own fax job number, is sent to the Send Fax Manager. Once
transmitted, the fax is placed in your Sent Fax folder (unless you
specified that it be deleted after transmission). A record of the sent 
fax is also recorded to the Fax Log.

In the Send Fax
dialog box, 

enter your fax
information and

send fax options.
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Using the Send Fax Manager
For each PC fax you send, a job is created in the Send Fax Manager. To
display this window from the Desktop Manager, choose the Send Fax
Manager command from the Tools menu or toolbar.

To display the Send Fax Manager from the Windows desktop, click Start,
then point to Programs. Point to Canon MultiPASS Desktop Manager
3.0, then click Canon Send Fax Manager.

Menu Bar
The menu bar contains the commands that enable you to perform the
various Send Fax Manager tasks. Many of the commands can also be
accessed using their corresponding button on the toolbar.
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FAXES SENT
AREA

STATUS BAR
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Toolbar
The toolbar provides quick access for performing certain Send Fax
Manager tasks. In circumstances where a task is unavailable, the toolbar
button appears dimmed.

The toolbar contains the following options:

Faxes Sent Area
The Send Fax Manager shows you the status of your faxes, the fax
recipient (connection number and ID), its subject, number of pages and
size, and date and time. The job currently being processed—the active
job—displays at the top of the list. A job remains in the Send Fax
Manager until it has been successfully transmitted, in which case, it is
moved to the Sent Fax folder (unless you specified that faxes be deleted
after transmission), or until you delete it.

Status Bar
You can display additional fax information in the Status Bar, by clicking
on a job. When no job is selected, the Status Bar displays information
about all jobs.

Fax Status
The Send Fax Manager displays the current status of each job. While
working in the Send Fax Manager, you can:

❍ Stop an active job from PC faxing

❍ Send a PC fax that has been scheduled for sending later, held, or has
failed

❍ View a PC fax that has been scheduled for sending later, held, or has
failed (you cannot edit or save a document using this method)

❍ Delete a job that is not active

STOP DELETE HELP

RESEND OPEN
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One of the following statuses is assigned to each job in the Send Fax
Manager.

Active
The active job is the fax currently being PC faxed. When an active job
completes successfully, it is automatically moved to the Sent Fax folder
or deleted (based on whether you specified to delete after sending in the
Send Fax dialog box).

Queued
A queued job is a fax waiting to be PC faxed. Queued jobs are processed
in chronological order.

Scheduled
A scheduled job is a PC fax you specified to send at a later time.

Retry
A job receives the Retry status if the MultiPASS printer is busy with
another task, and unable to transmit the PC fax.

The Desktop Manager continues to try sending the fax until the
transmission is successful or the Desktop Manager exceeds the defined
number of retries. If a job cannot complete successfully within the
specified number of retries, the job is marked with a Failed status. The
job remains in the Send Fax Manager until you reprocess or delete it.

On Hold
A held job is a PC fax you chose to place on hold, rather than send it
immediately. The held job remains in the Send Fax Manager until you
choose to send or delete it.

Failed
A job receives a Failed status because a PC fax could not be sent
successfully. This occurs because the Desktop Manager exceeded the
defined number of retries. For example, a PC fax may have failed
because of a continuously busy fax line or an incorrect fax number.
When a job is changed to a Failed status, you will see a Fax Failed icon in
the notification area of the Windows taskbar. A failed job remains in the
Send Fax Manager until you attempt to reprocess or delete it.

Stopped
A stopped job is an active fax that you stopped from processing before it
was completed. The stopped job remains in the Send Fax Manager until
you attempt to reprocess or delete it.

S
en

di
ng

 F
ax

es



4-28 Sending Faxes With the MultiPASS C5500 Chapter 4

Stopping an Active Job
If necessary, you can stop the active job from processing. When you do
so, the Desktop Manager retains the job in the Send Fax Manager as a
stopped job. You can later reprocess or delete the job.

To stop an active job, open the Send Fax Manager and click Stop on the
toolbar, or choose the Delete command from the Edit menu.

Sending a Scheduled, Held, Failed, or Stopped PC Fax
A PC fax job remains in the Send Fax Manager if it is scheduled for
sending later, if it is on hold, if it failed to transmit in the specified
number of retries, or it was stopped. You can reprocess the job for
sending now or rescheduling it for a different time.

When you send a PC fax from the Send Fax Manager, the Send Fax
dialog box displays the information you initially entered for the PC fax.
You can change the information as needed. For example, for a PC fax
that failed because of a wrong fax number, you can correct the fax
number and resend it. Or, for a scheduled PC fax, you can specify a
different time for transmission.

Additionally, if a cover page had been attached to the fax, you can edit
any memo text or the cover page styles.

Sending a Fax
1. In the Send Fax Manager, click the job you wish to send, then click

the Resend button on the toolbar, or choose the Resend Fax
command from the Fax menu.

2. In the Send Fax dialog box, change any fax options as needed.

3. Process the fax as follows:

• To process the fax for immediate sending, click Send Now.

• To schedule the fax for a later time, click Send Later.
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Viewing a Job
Documents in the Send Fax Manager can be viewed, but not edited or
saved, as follows:

❍ Click the job you want to view, then click the Open Document
button on the toolbar, or choose the Open Document command
from the Fax menu.

❍ Double-click the job.

Deleting a Job
You can delete any job other than the Active job as follows:

❍ Click the job you want to delete, then press the Delete key.

❍ Click the job you want to delete then click the Delete button on the
toolbar, or choose the Delete command from the Edit menu.

Using the Fax Log
The Fax Log contains a list of fax activity (faxes sent and received). The
log lists information for each fax, such as transmission type and status,
connection number and ID, document name, number of pages, file size,
date and time the fax was sent or received, and the origin of the fax.

You can use the Fax Log for a variety of purposes, such as reviewing the
error status of a failed PC fax. When reviewing the Fax Log, you can also
print it.
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Displaying the Fax Log
In the Desktop Manager, choose the Fax Log command from the Tools
menu or the toolbar.

You see a screen similar to this:

❍ To display details and log notes about a particular fax document,
click the fax to highlight it.

❍ To delete an entry, highlight the entry and click Delete.

❍ To close the Fax Log, click OK.

❍ To print a hard copy of the Fax log, click Print.
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Designing a Fax Cover Page
In addition to the set of predefined fax cover pages that are
automatically installed into your system, you can design your own fax
cover page using the MultiPASS Cover Page Designer. You can also edit
or annotate any existing cover page—one installed with the Desktop
Manager software or created by you.

When you create a new cover page, you define the page layout,
background, graphics, and fax information fields. Fax information fields,
or variable fields, provide areas where you place recipient and sender
information for a specific fax. You can specify the size of the field, the
font, font size, and style of the text displayed for each variable.

You can use a new fax cover page by attaching it when sending a fax with
the MultiPASS Desktop Manager, or by printing a hard copy and using it
when sending a fax directly from the MultiPASS.

Opening the MultiPASS Cover Page Designer
From the MultiPASS Desktop Manager Tools menu, click Cover Pages,
then choose the Cover Page Designer command.

You can also select the Cover Page Designer from the toolbar.

To close the cover page designer, choose the Exit command from the File
menu in the Cover Page Designer window.
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Using the Cover Page Designer 
The Cover Page Designer window looks similar to this.

Menu Bar
The menu bar contains commands that allow you to create, edit, and
print your fax cover page. Many commands can also be accessed by
corresponding buttons on the toolbars.

File Toolbar
The File toolbar provides quick access to commands you use to open,
save, print, edit and zoom a fax cover page.

MENU BAR
FILE
TOOLBAR

LAYOUT
AREA

STATUS
BAR

IMAGE
TOOLBAR

DATA
FIELDS
(VARIABLES)

ANNOTATION
TOOLBOX

OPEN PRINT

COPY UNDO ZOOMSAVE

CROP REDO HELP
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Image Toolbar
The Image toolbar provides quick access to commands you use to select,
lasso, move, zoom, straighten, or annotate a fax cover page.

Annotation Toolbox
The Annotation toolbox allows you to add text and graphics to your
cover page. Annotations are integral elements of the cover page. Unless
you select to “hide them” by choosing the Hide Annotations command
from the View menu, they are sent with the cover page, and can be
printed, edited, and saved.

Data Fields (Variables)
The Data Fields list contains the fields of information you want to
include on the fax cover page. When you use the cover page with the
Desktop Manager, these fields are automatically filled in with the
appropriate information for a specific fax transmission.

Layout Area
The layout area allows you to visually create and edit the features of your
cover page. The size of the layout area corresponds to the size of a
standard fax page. You can use the horizontal and vertical scroll bars to
view different portions of the cover page, as necessary.
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LASSO

MOVE

ZOOM

STRAIGHTEN

ANNOTATE

SELECT, RECTANGLE, LINE, ELLIPSE, ARROW, POLYGON

FREE DRAW, HIGHLIGHTER, TEXT, STAMP, STICKY NOTE
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Creating a New Cover Page
The following instructions summarize the overall procedures for
creating a new fax cover page. Detailed procedures follow the summary.

❍ A blank document page displays:

❍ Use the tools on the Annotation toolbox.

• Use the Text tool to add labels for variable data fields
(such as To: and From:) or any other desired text

• Use the Stamp tool to add BMP formatted graphics
(such as a company logo or signature).

❍ Insert the data fields you want to include in the fax using
the options available in the Data Fields list.

❍ Position the fields at the desired locations on your
background. Optionally, adjust the appearance of each
field as necessary.

In the layout area,
prepare your fax

background.

With the
MultiPASS Cover

Page Designer
open, choose the

New command
from the 

File menu.
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❍ When you have completed the cover page design, choose
the Save command from the File menu or toolbar.

❍ In the Enter Title for New Cover Page dialog box, enter a
name for your cover page and click OK.

Preparing the Cover Page Background
The background includes the permanent text information and graphics
you want included on the cover page. For example, you may want to
include heading text that provides your company name and address
information, labels for the variables fields (such as To: and From:), and
one or more graphics that may represent your company logo or your
signature.

You can create a cover page background using the Cover Page Designer,
you can create a background in another application (such as Word for
Windows, Paint, or Photoshop®) and then import it as a TIFF file into
the Cover Page Designer. Once imported, you can edit, annotate, and
save the cover page just as if you originally created it in the Cover Page
Designer.

Importing a cover page background

❍ Create your cover page in the desired application.

❍ Save it as a TIFF file.

Create and save
your cover page.

Save the 
cover page.
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❍ You see a screen similar to this:

❍ In the Select Image for New Cover Page dialog box, locate
the cover page you want to import and click Open.

❍ You can now edit and save the cover page as desired.

Setting Preferences
Before working on your cover page, you may want to set the following
preferences in the Cover Page Designer to better suit your working
needs:

❍ Set the Unit of Measurement—On the File menu, click Preferences.
Set the unit of measurement to Pixels, Inches, or Centimeters from
the list and click OK.

❍ Display Rulers—On the View menu, click Show Rulers.

❍ Note the other settings that you can adjust to your working needs.

With the Cover
Page Designer

open, choose the
Import command

from the File
menu.
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Adding Labels and Text 
You may want to add labels for the data fields you will be using (such as
To: or From:) or other text to your cover page using the Text tool from
the Annotation toolbox. Once added, you can choose text attributes:
font, font size and color, special effects (underline, strikeout),
background color, and mode.

When selecting a font, font size, a color, or special effect, keep in mind
that it affects the entire text contained in the box. If you change any of
the attributes while editing text, or while the text box is selected, it
changes all the text in the box.

Adding text to the cover page

1. If not selected, click the Annotations button on the Image Toolbar.

2. On the Annotations toolbox, click the Text tool and drag the cursor
to draw an appropriately sized square or rectangle in the layout area.

3. Enter the new text.

4. Click the Select tool from the Annotations toolbox, then click the
new text.

5. Right-click inside the newly drawn square or rectangle to select the
desired text adjustment options from the Annotations option.

• Click Select Font to set font properties for the text

• Click Set Background Color to set a background color

• Click Set Foreground Color to set a text color.

6. Click outside the text box.

7. On the File menu, click Save. The new text is added to the cover
page.

N If this is the first time you have saved the cover page, the Enter Title for
New Cover Page dialog box displays. Enter a name for your cover page
and click OK.
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Editing text added to a cover page

1. On the Annotation toolbox, with the Selection tool selected, double-
click the text you added. The cursor changes to an insertion point.

2. Edit the text as needed.

3. Click outside the area of the text box.

4. On the File menu, click Save.

Adding Graphics
You can insert either a text or graphic image stamp on your cover page.
The Desktop Manager contains a library of available stamp images,
stored as BMP files, that were installed with the Desktop Manager
software. Additionally, you can add special graphics (such as a company
logo or personal signature) into the stamp library provided the graphic
is saved in a BMP format.

1. Choose the Select Stamp command from the Annotation menu.

2. In the Select Stamp dialog box, click Add. An Open dialog box
displays.

3. Locate the BMP file you wish to add to the Stamp library and click
Open. If you have multiple graphics you want to add, repeat this
step.

4. Click the first graphic you want to insert into the cover page and
click OK.
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5. Click the Stamp tool on the Annotation toolbox.

6. Click the mouse at the location where you want to place the graphic
in the layout area.

7. To add a different graphic to the cover page, choose the Select
Stamp command from the Annotation menu.

8. Click the graphic you want to insert and click OK.

9. Click the Stamp tool on the Annotation toolbox.

10. Click the mouse at the location where you want to place the graphic
in the layout area.

11. Adjust the size and characteristics of the graphics as desired (see
Modifying a Predefined Fax Cover Page on page 4-42.).

12. On the File menu, click Save. The graphic is added to the cover page.

Creating a text stamp

You can also create and use a Text Stamp on your cover page.

1. Choose the Select Stamp command from the Annotation menu. The
Select Stamp dialog box displays.

2. Click the Text Stamp tab.

3. Click Add.
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4. In the Text Stamp Edit dialog box, type the text you wish to assign to
the Stamp.

• To add a date to the stamp, click Date.

• To add the current time to the stamp, click Time.

• To change the font and text characteristics of the text, click Font.

5. Click OK to close the Edit Text Stamp dialog box.

6. Click OK again to save the text stamp and close the Select Stamp
dialog box.

Editing a text stamp

1. Choose the Select Stamp command from the Annotation menu.

2. Click the Text Stamp tab.

3. Click the stamp you want to edit, then click Edit.

4. Modify the text and click OK.

5. Click OK to close the Select Stamp dialog box.

Removing an image or text stamp

1. Choose the Select Stamp command from the Annotation menu.

2. Click the stamp you wish to remove, then click Delete. A
confirmation message displays.

3. Click Yes.

4. Click OK to close the Select Stamp dialog box.

Inserting a text stamp

1. Choose the Select Stamp command from the Annotation menu.

2. Click the Text Stamp tab on the Select Stamp dialog box.

3. Click the text stamp you wish to insert into the cover page and 
click OK.

4. Click the mouse at the location where you want to place the text
stamp in the layout area.
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Creating a Drawing Graphic
You can also annotate your cover page with one or more drawing objects
that include a straight line, a single-headed arrow, a hollow rectangle,
and a hollow circle or ellipse. When you draw the object, you can select
the color, line thickness, and style of line for the object.

1. On the Annotation toolbox, click the drawing object tool:
Arrow/Line, Rectangle, or Circle.

2. From the Annotation menu, select the color, line thickness, and style
of line for the object you are drawing. For an arrow or line, also
select the particular style you want to use.

3. At the desired location in the layout area, drag the cursor to draw
the object. When you release the mouse button, the object is
completed.

4. From the File menu, click Save. The new graphic is added to the
cover page.

Adding Variable Data Fields
You can insert variable fields that are filled in with actual data when you
attach the cover page to a particular fax. You can choose any or all of the
available fields, placing them at a desired location in the layout area.
Fields are placed on top of any cover page background or imges. Each
field displays sample text to illustrate the current font, font size, and text
attributes. Actual data is added to the field when the fax is sent.

Only the variable fields shown in the variables bin are available for you
to use in the cover page. You cannot add or delete a field to or from the
existing set. You also cannot use a single field more than once on a cover
page.

Inserting a field

1. Click the desired data field on the Variables Bin.

2. Drag the cursor to draw an appropriately sized square or rectangle
in the layout area.

3. Click the Selection tool from the Annotations toolbox, then click the
new data field.
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4. Right-click inside the newly drawn square or rectangle to select the
desired text adjustment options from the Annotations option.

• Click Select Font to set font properties for the text.

• Click Set Background Color to set a background color.

• Click Set Foreground Color to set a text color.

5. Click outside the text box.

6. Align the data fields as desired (see Modifying a Predefined Fax Cover
Page below.)

7. On the File menu, click Save. The data fields are added to the cover
page.

Modifying a Predefined Fax Cover Page
The following instructions summarize the basic procedures for
modifying a predefined fax cover page. Detailed procedures follow this
summary.

1. With the Cover Page Designer open, choose the Open command
from the File menu or toolbar. You see a screen similar to this:

2. Highlight the desired fax cover name and click OK.

3. With the cover page open in the Cover Page Designer, drag the
information fields to the locations that you prefer; delete and/or add
information fields.
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4. On the File menu, click Save or Save As.

• If you would like to keep the original page, use Save As to give
the modified page a new distinct name.

• If you would like to replace the original cover page, use Save.

Adjusting Text and Variable Fields
Once you have placed the desired text labels and variable fields into the
layout area, you can adjust the appearance of any text or data field. You
can resize, move, or delete text or data fields. When you delete a data
field, the field is removed from the layout area and returned to the
variables bin.

Additionally, you can set the text attributes for text or data fields and
align two or more fields on the right, left, top, or bottom.

❍ To select text or data field in the layout area:

• To select a single text box or data field, click the Select tool from
the Annotations toolbox, then click the text box or data field.

• To select more than one text box or data field, hold down the
Shift key and click the desired text and/or data fields.

❍ To move text or data fields, drag the selected text box or data field to
the new location.

❍ To delete a text box or data field, select the text box or data field and
press the Delete key.

Resizing a field

With the exception of the Memo field, most of the variable fields consist
of a single line of text. If the variable information to be placed in the
field is longer than the field size, the text does not automatically wrap
onto the next line. Instead, the text is truncated to fit the length of the
field. For this reason, you may want to resize fields to ensure that the full
line of text is visible on the cover page when the fax is sent.

Because the Memo field typically contains multiple text lines, this
variable field does provide for automatic text wrapping. However, make
sure the size of the Memo field is large enough to accommodate the
length of memo text that you may enter in the Send Fax dialog box. If
the Memo field is not large enough, not all the lines of a memo text may
be visible when the fax cover page is sent.

To resize the field, click the field and drag any sizing handle.
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Copying Fields
If you want to copy a field or graphic item and paste it into another
Windows application which supports a Paste option, you can do so
using the Copy command. When you copy a field or graphic item, it is
placed in the Cover Page Designer clipboard. From the clipboard, you
can paste it into any Windows application that supports this command.

1. Select the field/graphic element to be copied. Now choose the Copy
command from the Edit menu or toolbar, or click the right mouse
button and select Copy from the Edit menu.

2. Open the Windows application where you want to paste the item.

3. Paste the item into the Windows application (usually, by selecting
the Paste command from the Edit menu or toolbar).

Removing an Annotation
If you decide you no longer want an item to apear in your cover page,
you can remove it permanently by selecting it and pressing the Delete
key.

Adjusting the Orientation and View 
When creating or editing a cover page, you may want to adjust your view
of it by rotating or flipping the page.

From the Edit menu:

❍ Click Rotate, then choose 90, 180 (flipping the document upside
down), or  270.

❍ Click Flip, then choose Horizontal or Vertical.
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Straightening a Document Display
In designing a cover page, you may need to straighten the base image
(for example, a scan that is crooked) before you begin adding text or
graphics to it. You can straighten a cover page using the Straighten Tools.

1. Open the cover page in the Cover Page Designer. On the Image
toolbar, click the Straighten button. A Straighten toolbar displays
and crosshairs appear over the cover page.

2. On the Straighten toolbar, click the Rotate Clockwise or Rotate
Counterclockwise buttons until the cover page is evenly aligned in
the crosshairs.

3. Click the Straighten button.

4. On the File menu, click Save.

Adjusting the Display
The Cover Page Designer provides you with different levels of
magnification allowing you to work at the most comfortable size. You
can zoom in and out at predefined increments, or specify a particular
size or scale. You can also use the Fit Image to Window option, which
adjusts the document image size so that the entire cover page is visible
within the window.

To zoom in or zoom out on the cover page, do one of the following:

❍ From the View menu, click Zoom, then select the desired level of
magnification.

❍ From the File toolbar, select the desired level of magnification from
the list.
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❍ From the Image toolbar, click the Zoom tool and:

• To increase magnification, click the document.

• To decrease magnification, press and hold the Alt key, then click
the document.

To fit the cover page to the display window, click Fit Image to Window
from the View menu.

Scrolling through a Zoomed Cover Page
If you need to work on particular aspects of a cover page (for example,
to modify a recurring graphic), you can scroll through the cover page
while maintaining a high level of magnification. To do this, you use the
Navigator and Scroll tools.

1. From the View menu, click Show Navigator. The Navigator window
opens in the right corner of the screen. Inside the Navigator, a white
rectangle indicates the area of your cover page that is currently in
view.

2. On the Image toolbar, click the Move button. The cursor turns into
a hand.

3. While tracking your position in the Navigator window, click and
hold the left mouse button and drag the image to bring the desired
area of the cover page into view.
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Editing the Base Image 
While working with a cover page, you may need to edit the base image
that underlies all annotations. When editing a base image, you can select,
crop, or flip a specific area. For example, to create a novel effect, you may
want to flip an imbedded graphic on its vertical or horizontal axis.

Selecting an area of a cover page

1. On the Image toolbar, choose either the Select or Lasso tool.

• Use the Select tool for areas that fit easily inside a square or
rectangle.

• Use the Lasso tool for irregularly shaped areas.

2. Drag the cursor to draw the appropriately shaped container for the
area you want to select.

Cropping a cover page

1. Select the area of the cover page to which you want the entire cover
page to conform.

2. Choose Crop Inplace from the Edit menu or File toolbar.

Flipping a cover page

❍ To flip the entire cover page, select Flip from the Edit menu, then
choose Horizontal or Vertical.

❍ To flip a selected area of a cover page.

• Select an area of the cover page.

• Select Flip from the Edit menu, then choose Horizontal or
Vertical.
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Changing Text Attributes
Once you have placed text labels and fields in the layout area, you can
change the font and font size of the text, choose a text style (bold, italic,
underline), or change the font color. If you have multiple fields to which
you want to assign the same attributes, you can select the fields together
and make the change to all the selected fields at once.

1. In the layout area, select the label(s) or field(s) you want to change.

2. Choose the Select Font command from the Annotation menu. You
see a screen similar to this:

3. Choose the appropriate text attributes (notice that a sample of your
selections is displayed in the Sample box):

• Select the font and font size from their appropriate list boxes.

• Select Italic, Bold, or Italic Bold from the Font Style list box.

• Select Strikeout and/or Underline from the Effects options.

4. Click OK to apply the settings.
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Changing Text Color
1. In the layout area, select the field(s) you want to change.

2. Choose the Foreground Color command from the Annotation
menu, then choose the desired color.

Aligning Fields
When placing labels, graphics, or variable fields in the layout area, you
may be concerned that they properly align, to make them more visually
appealing. You can align two or more selected fields, based on the
position of the first field you select. The first field selected in the set of
fields to be aligned is the anchor for the alignment.

You can align fields, based on the first selected field, by their top,
bottom, left, right, horizontal center, or vertical center locations.

1. Select the two or more fields you want to align.

2. Choose the Align command from the Annotation menu, then select
the desired align option.

Adding Additional Annotations to Your Cover Page
The following sections describe additional ways in which you can
annotate your cover page.

Adding a Sticky-Note Annotation
Rather than add text directly to a cover page, as you do with the Text
tool, you can add a Sticky-Note on any portion of your cover page as a
graphic element.

When you add a Sticky-Note, you can choose the text attributes: font,
font size and color, background color, and special effects (underline,
strikeout).

You can type any text that you want for the Sticky-Note, editing the note
later if necessary. If you select a font, font size, a color, or special effect, it
affects the entire note. If you change any of the attributes while editing a
note, or while the note is selected, it changes all the text in the note.
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Adding a sticky-note

1. In the Annotations toolbox, click the Sticky-Note tool and drag the
cursor to draw an appropriately sized square or rectangle.

2. Click the Selection tool, then click the Sticky-Note.

3. Select the desired adjustment options from the Annotations menu.

• Click Select Font to set font properties for the text.

• Click Set Background Color to set a background color for the
note.

4. Type the text of your note.

5. To add the Sticky-Note to your cover page, click outside its borders.

Editing the text in a sticky-note

1. On the Annotations toolbox, with the Selection tool selected,
double-click the Sticky-Note. The cursor changes to an insertion
point.

2. Edit the text as needed.

3. Click outside the area of the Sticky-Note.

4. On the File menu, click Save.

Highlighting Your Document
You can add a color highlight to text or other images in your cover page.
To do this, select a color and then draw a rectangular highlight over the
desired area. All highlight colors are transparent and display in the color
you specify. When you print the document, the highlighted region prints
as gray shadings.

1. On the Annotations toolbox, click the Highlighter tool.

2. To select a highlighting background color, choose the Background
Color command from the Annotation menu, then select the desired
color.

3. Drag the cursor over the area you want to highlight. When you
release the mouse button, the highlight is completed.
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Reverting to the Last Saved Version
If you are dissatisfied with changes that you have made to your cover
page, you can discard them and return to the last saved version.

To revert to the last version, choose the Revert to Original command
from the File menu. When the confirmation message displays, click Yes.

Renaming a Cover Page
You can rename a cover page at any time in the Desktop Manager.

1. Choose the Cover Pages command from the Tools menu, then select
Manage Cover Pages.

2. In the Manage Cover Page List dialog box, highlight the cover page
you want to rename and click Rename.
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3. In the Rename dialog box, type the new name for the cover page and
click OK.

4. Click OK to close the Manage Cover Page List dialog box and save
your changes.

Printing a Cover Page
You can print your cover page to review it.

1. Choose the Print command from the File menu or toolbar.

2. In the Print dialog box, specify the desired print options and click
OK.

Deleting a Cover Page
You can delete a cover page that you no longer need from the Desktop
Manager.

1. Choose the Cover Pages command from the Tools menu, then select
Manage Cover Pages. The Manage Cover Page List dialog box
displays.

2. Highlight the cover page you want to delete and click Delete . A
confirmation message displays.

3. Click Yes to delete the cover page.

4. Click OK to close the Manage Cover Page List dialog box and save
your changes.
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The MultiPASS C5500 has four Receive Modes:

❍ Fax Only Mode

❍ Fax/Tel Mode

❍ Manual Mode

❍ Answer Machine Mode

You set the Receive Mode during the MultiPASS installation procedure.
(See your Quick Start Guide for details.)

You can change the Receive Mode and the Receive Fax options through
the MultiPASS Desktop Manager. See page 8-7 for details.

Receiving Documents
During reception of a fax:

❍ If the unit runs out of paper or if the BJ cartridge runs out of ink,
the MultiPASS receives the remainder of the document in memory.

❍ To stop receiving before the document is complete, press STOP.
Then press * to cancel reception.

❍ If the ALARM light is flashing for any reason, correct the error and
then press STOP. If necessary, see Chapter 10, Troubleshooting.

❍ If an error occurs, the MultiPASS beeps intermittently for a few
seconds. If this happens, contact the other party and have them
resend the document.

5Receiving Faxes
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Receiving Documents Automatically—Fax Only Mode
When you set up the MultiPASS for a dedicated fax line, the unit is
prepared to automatically receive a document whenever a call comes
over the fax line. If a voice call comes in, the caller will hear the fax tone.

Receiving Both Documents and Telephone Calls
Automatically—Fax/Tel Mode

In Fax/Tel Mode, the MultiPASS monitors all incoming calls over the
telephone line. When the MultiPASS receives an incoming call, it checks
to see if the call is from another fax machine trying to send a document
or from someone wanting to talk to you. You must have a telephone
connected to the MultiPASS to use this mode.

How Fax/Tel Mode Works
In Fax/Tel Mode, a telephone attached to the MultiPASS will not ring
when it receives a call from another fax machine that is trying to send a
document. This is so that you are not disturbed when your MultiPASS 
is communicating with another fax machine. The unit automatically
receives the document.

If the call is from a person, the MultiPASS rings to alert you to pick up
the phone. You must pick up the telephone connected to the MultiPASS.

If you do not pick up the telephone connected to the MultiPASS within
15 seconds (set by the Ring Time option), the unit stops ringing. It
checks again to make sure the call is not from a fax machine and then
hangs up.

N The MultiPASS does not recognize an extension telephone connected to
another phone jack (that is, not connected to the MultiPASS).

If a call comes in and you pick up an extension phone, the telephone
connected to the MultiPASS will continue to ring for 15 seconds, check
for a fax, and then hang up.
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Receiving Documents Manually—Manual Mode
You will want to set your MultiPASS to receive documents manually
when you want to personally check each incoming call to see if it is from
a fax or from a person. You must have a telephone attached to the
MultiPASS.

When the telephone attached to the MultiPASS rings, pick up the
telephone.

❍ If you hear a person’s voice, start your conversation. If the caller
wants to send a document after talking to you, confirm that the
document is loaded and request that the caller press the START
button. Wait on the line until you hear a slow beep or silence
(depending on the sending fax unit), then press START/COPY to
receive the document.

❍ If you hear a slow beep or silence, another fax is trying to send you a
document. Press START/COPY.

Your MultiPASS begins receiving the document.

❍ Hang up the telephone after the MultiPASS displays RECEIVE. If you
don’t hang up, the MultiPASS beeps intermittently for a few seconds
after you receive the document. To disable the beeping, turn off the
Off Hook Alarm option in the Advanced: Send Fax dialog box. (See
page 8-5 for details.)

Using the Telephone for Remote Reception of a Fax
If you pick up the handset of the telephone connected to the MultiPASS
and you hear a fax tone, you can start receiving the document manually
by entering a two-digit ID code from the phone. This is particularly
convenient if you are using a cordless phone and you answer the phone
away from the MultiPASS.

To use this feature, the telephone must be plugged into the telephone
jack of the MultiPASS (see your Quick Start Guide for details). The
Remote Receive option must be enabled in the Advanced: Receive Fax
dialog box. (The default is enabled.) For details, see page 8-9.
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Use the telephone to receive manual calls as follows:

1. When you answer a call and hear a long beep or silence, a fax is
being sent.

2. Enter the two-digit ID code on your telephone (the default code is
25). Wait for five seconds, then hang up. The MultiPASS then begins
receiving the document.

N If you have an answering machine connected to your MultiPASS and
you can control your answering machine from a remote telephone, make
sure the security code for this function is different than the two-digit ID
code described above. You change the two-digit ID code used by the
MultiPASS to make it distinct from the answering machine’s security
code. See page 8-11.

Using an Answering Machine—Ans. Machine Mode
Connecting an answering machine to the MultiPASS allows you to
receive faxes and phone messages while you are out of the office.

In Answer Machine Mode, the MultiPASS allows the answering machine
to answer incoming calls, then listens for a fax tone or for four seconds
of silence (also an indication that a fax is coming in), and automatically
receives the fax if it detects the tone or a four-second silence. (Four
seconds is the default; you can change this value.)

N Canon does not recommend using an “answering service” (like those
offered by local telephone companies that provide voice mail) on the
telephone line you are connecting to the MultiPASS. If you do subscribe
to an answering service, you may want to dedicate a separate line for fax
communication only and connect that line to the MultiPASS. Or, you
can see if your telephone company offers a Distinctive Ring Pattern
(DRP) service (see page 5-9 for details).
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Using the MultiPASS With an Answering Machine
Follow these guidelines when using the MultiPASS with an answering
machine:

❍ Set the answering machine to answer on the first or second ring.

❍ If the MultiPASS runs out of paper or ink in Answer Machine Mode,
it receives all faxes into its memory. The faxes then print
automatically when you add paper or replace the BJ cartridge.

❍ When recording the outgoing message on the answering machine:

• The entire message must be no more than 15 seconds long.

• In the message, tell your callers how to send a fax. For example:

“Hello. I can’t answer the phone right now, but please leave a
message after the beep. I’ll return your call as soon as possible. If
you would like to send a fax, press the start button on your fax
machine after you leave your message. Thank you.”

Printing Documents Received in Memory
If one of the following errors occurs while the MultiPASS is receiving 
a document, the unit stores the document in memory:

❍ BJ cartridge runs out of ink

❍ BJ cartridge is not installed

❍ Sheet feeder runs out of paper

❍ Paper jam occurs

The MultiPASS can store up to 42 letter-size pages (based on the CCITT
No. 1 chart) or 20 separate documents.

The LCD display shows REC’D IN MEMORY alternating with the error
message when the memory contains documents. The MultiPASS will
automatically print the contents of memory when you correct the
problem and press the STOP button.
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After printing the document(s) stored in memory, the MultiPASS erases
the document(s) from memory.

N If you are using the MultiPASS Desktop Manager and it is set to Save in
memory, the MultiPASS stores incoming faxes in its memory when the
computer is off. In this case, you will see the REC’D IN FILE message. See
Receiving Faxes to The MultiPASS Desktop Manager below for details.

Receiving While Copying, Printing,
or Registering

Because the MultiPASS supports multitasking, you can receive a
document or a phone call while you are:

❍ Making a copy

❍ Printing a document

❍ Entering information

If you are making copies or printing a document and the MultiPASS
receives a fax, it stores the document in its memory. It then prints the
document as soon as you finish making copies or printing. If you are
entering information into the LCD menu system and the MultiPASS
receives a fax, it prints the document immediately (it does not store 
the document in memory).

Receiving Faxes to the MultiPASS 
Desktop Manager

When your computer is on, you can automatically receive incoming
faxes to the MultiPASS Desktop Manager.

When your computer is off, the MultiPASS stores received faxes in its
memory until you either print them or you turn on the computer. When
you turn on the computer, you can send the faxes to the MultiPASS
Desktop Manager.

The MultiPASS can also print incoming faxes directly. If your computer
is going to be off for a while and you are expecting incoming faxes, it’s a
good idea to set the MultiPASS to automatically print incoming faxes.



Chapter 5 Receiving Faxes 5-7

Receiving a Fax Into the In Box
To receive a fax into the In Box of the MultiPASS Desktop Manager, your
computer must be on and the MultiPASS Server must be running. You
must also have selected Upload Fax in the Receive Conditions of the
Desktop Manager. (See page 8-8 for details.)

The Receive Conditions determine how your faxes are received by the
MultiPASS.

❍ When Computer is Off

• Set this to Print Fax to always print an incoming fax.

• Set this to Save in memory to save an incoming fax in the
MultiPASS’s memory. You can then print the fax, or upload 
it to the MultiPASS Desktop Manager after you turn on the
computer.

❍ When Computer is On

• Set this to Upload Fax to receive all your faxes to the 
MultiPASS Desktop Manager.

• Set this to Print Fax to always print an incoming fax.

R
ec

ei
vi

ng
 F

ax
es



5-8 Receiving Faxes Chapter 5

Printing a Received Fax When Your Computer Is Off
When a document is in its memory, the MultiPASS displays the message
REC’D IN FILE and alternately flashes the date.

To upload the fax to the MultiPASS Desktop Manager, simply turn on
the computer.

If you want to print a fax that is stored in memory in the MultiPASS
without turning on the computer, follow these steps:

The MultiPASS begins printing the
document.

N Once the MultiPASS prints a fax, it erases the fax from its memory.

Press START/COPY.

FILE PRINTPress < or > on
the one-touch 
speed dialing

keypad.

FUNCTION
On the MultiPASS,

press the
FUNCTION key.
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Using the Distinctive Ring Pattern Detection 
(DRPD) Feature

Some phone companies offer a distinctive ring pattern (DRP) service
whereby they assign two or more telephone numbers with distinctive
ring patterns to a single telephone line. If your phone company offers
such a service, you can have both a fax number(s) and a telephone
number(s) for your MultiPASS using only one telephone line.

Your MultiPASS will automatically detect incoming calls. Based on the
distinctive ring pattern, the MultiPASS knows if the call is from a fax
machine trying to send a document or from a telephone trying to make
a voice call.

Use the information in this section to set up the MultiPASS for use with
a DRP service. For more details on the DRP service, contact your local
telephone company. (Your telephone company may have a different
name for this service. Also, this service may not be offered in all areas.)

Types of Ring Patterns
Your telephone company will assign a distinctive ring pattern to each
number when you order the DRP service. The setting you make in the
MultiPASS must match the setting assigned by the telephone company.

You can set the MultiPASS for the following ring patterns:

❍ Normal ring—Ring type of normal telephone line
(Recommended for voice calls)

❍ Double ring—Two short rings at regular intervals
(Recommended for fax calls)

❍ Triple ring—Short-short-long at regular intervals
❍ Triple ring—Short-long-short at regular intervals
❍ Other ring type—Patterns other than those described above

You set the DRPD Switch Options in the Advanced: Receive Fax dialog
box (see page 8-11 for details).

You must set all DRPD ring numbers in the MultiPASS. You select the
ring pattern and then specify whether the pattern is for telephone calls,
faxes, or both (fax/tel switching). See the next section for details.

R
ec

ei
vi

ng
 F

ax
es



5-10 Receiving Faxes Chapter 5

How DRPD Responds to Calls
When there is an incoming call, the MultiPASS checks the incoming 
ring pattern and determines the type of pattern being received. The
MultiPASS may require up to 10 seconds to determine the pattern type.
During this time, any telephone device connected to the MultiPASS will
not ring. After the pattern is detected, the MultiPASS reacts according to
how you registered the setting.

Incoming Call Incoming Call
Your Setting From Fax From Telephone 

Fax Receives the fax document Answers as a fax 
without ringing. machine.

Tel Rings to alert you to pick Rings to alert you to pick 
up the telephone. Press up the telephone and 
START/COPY to receive the take the call.
fax (Manual Mode).

Fax/Tel Switches to receive mode Rings to alert you to pick 
for fax transmission signals up the telephone and 
and does not ring. take the call.

Communicating Using the Distinctive Ring Pattern
Detection (DRPD) Feature

Using the MultiPASS with a DRP service is almost the same 
as using it with a normal telephone line.

When you turn on DRPD, the Receive Mode defaults to Fax/Tel Mode.
(You cannot change this Receive Mode.)

When someone calls using the number assigned for telephone
communication, the MultiPASS rings in the pattern you registered 
for telephone calls. When you hear this pattern, simply pick up the
telephone connected to the MultiPASS and talk. If you do not pick up
the telephone, the MultiPASS continues to ring until the other party
hangs up.

When someone sends a fax using the number assigned for fax
communication, the MultiPASS does not ring. It receives the 
document automatically.
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You can use the MultiPASS C5500 to scan documents from the Desktop
Manager, or from any TWAIN-compliant Windows application.

When you scan a document in the Desktop Manager, the ScanGear
window displays, allowing you to set certain scanning options and
conditions. This chapter provides instructions on setting scan options
using the ScanGear window.

When you scan a document in a Windows application, the application
may or may not display the ScanGear window. If the ScanGear window
is not displayed, see the documentation for the Windows application
you are working in for instructions on setting scan options.

Typically, when you scan a document using the ScanGear window, you
first scan a preview of the document. The preview image allows you to
review the results of your scanned document and make any necessary
adjustments (for example, to size, tone, and so on). When you are
satisfied with the results, you then perform the final scan of the
document. The system then places the final image into the Desktop
Manager or your Windows application.

This chapter describes:

❍ Exploring the ScanGear window

❍ Scanning with the Desktop Manager

❍ Scanning from a Windows application

❍ Setting the preview scan options

❍ Adjusting the preview image for the final scan

❍ Adjusting the tone of the preview image 

MPC-5500—USERS MANUAL/V000/08-98
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Exploring the ScanGear Window
This section provides an overview of the basics of the ScanGear window.
Detailed instructions for using the various commands and components
of the window are provided in later sections of this chapter.

The ScanGear window looks similar to this:

Toolbar
The toolbar provides buttons for performing certain tasks when
scanning. In circumstances where a task is unavailable, the button 
on the toolbar appears dim.

Preview Area
The preview area displays a preview image of the document you scan. A
preview image enables you to adjust various document characteristics
before you perform the final scan. For example, you can make
adjustments to the size, the orientation, or the tone of the image.

TOOLBAR

PREVIEW
AREA

SCAN OPTIONS
TABS

STATUS BAR

CLEAR
PREVIEW

MOVE
IMAGE

NEGATIVE/
POSITIVE

ROTATE
LEFT RULERS HELP

CROP ZOOM
TOOL

MIRROR ROTATE
RIGHT

AUTO
TONE
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Scan Option Tabs
The Scan Option tabs provide adjustment options when performing a
preview or final scan.

Status Bar
The status bar displays information on the scan process status. This
information can include the scan mode, scan resolution, size (width and
height), and the resulting file size of the scanned image.

Displaying Information About the Scan Driver
You can display version and copyright information about the scan driver
using the About dialog box.

1. On the title bar in the ScanGear window, click the right mouse
button.

2. On the displayed menu, click About ScanGear.

3. To close the dialog box, click OK.

Scanning With the Desktop Manager
You can use the MultiPASS and the Desktop Manager to scan a color or
monochrome image. The resulting document is displayed in the Desktop
Manager and is automatically provided with a unique system-assigned
name. You can rename the document later as desired.

Each image you scan is placed into the Scan folder as a TIFF document.
A scanned document remains in the Scan folder until you move it or
delete it. A scanned document can be reviewed, annotated, printed, or
sent as a fax. For more information on these tasks, refer to Chapter 7,
Working With Documents in the Desktop Manager.

The following instructions summarize the overall procedures for
scanning an image. Detailed instructions follow later in this chapter.

1. Place the image you want to scan face down in the ADF (automatic
document feeder) of the MultiPASS.

2. In the Desktop Manager, select the Scan command from the Tools
menu or toolbar.
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3. In the ScanGear window, specify the scan preview options for your
document as necessary.

4. Click Preview.

5. Review the display of the scanned preview image in the scan
window. Adjust the properties of your image as necessary.

6. Replace your document in the document feeder of the MultiPASS.

7. Click Scan.

An indicator displays showing you the progress of the scan. Once
complete, the image is stored in the Scan folder, where it remains 
until you move or delete it.

Scanning From a Windows Application
You can use the MultiPASS to scan documents directly into a Windows
application that supports a TWAIN interface (such as Photoshop). Some
applications allow multiple page scans, while others do not. If you are
unsure whether your Windows aplication supports this feature, refer to
the user documentation for the application you are using.

The following instructions summarize the general procedures for
scanning an image. For specific information on scanning with your
Windows application and specifying MultiPASS as the scan device, refer
to the user documentation for the application you are using.

1. Place the image you want to scan face down in the ADF (automatic
document feeder) of the MultiPASS.

2. In your Windows application, choose the command to scan a
document.

In some applications, the appropriate command may be listed as
Acquire or Acquire Image.

3. In the ScanGear window, specify the preview scan options for your
document as necessary.

4. Click Preview.

5. Review the display of your scanned preview image. Adjust the
properties of the image as necessary.
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6. Replace your document in the ADF of the MultiPASS.

7. Click Scan.

When complete, the image appears in the display area of your Windows
application.

Setting the Preview Scan Options
Before previewing a scan, set the scan mode, resolution, preferences,
paper size, and color options. Additionally, when you are scanning a
black and white image, you can select one of the two black and white
options.

Setting the Scan Mode
For a preview image, you specify how your source image will be
acquired.

1. Click the Main tab.

2. From the Scan Mode list, select the desired option.

Your options include the following:

Color
Color images will contain 8 bits per pixel for red, green, and blue
channels. Each pixel will contain 24 bits.

Grayscale
Grayscale images contain 8 bits per pixel.

Text Enhanced
Text enhanced images are grayscale images (8 bits per pixel) converted to
black and white (1 bit per pixel) using Canon ImageTrust technology.

Black and White 
Black and white images are scanned at one bit per pixel. For applications
that request a black and white scan and do not use the scan driver
window, the scan driver automatically uses the Text Enhanced setting.
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Setting the Scan Resolution
You can set the resolution of a scanned image based on the selected
output device. This resolution becomes the base on which changes to
image size and scale are calculated. You can choose a preset resolution,
or create a custom resolution.

1. Click the Main tab.

2. In the Scan Resolution list, select the desired option.

Creating a Custom Resolution

You can define a custom resolution, change an existing custom
resolution, or delete a previously defined custom resolution.

1. From the Scan Resolution list, select Custom.

2. In the Custom Resolutions dialog box, type a name for your custom
resolution setting.

3. In the Resolution box, enter the preferred dpi setting.

4. Click Add. The new resolution name displays in the Resolution List.

5. Click OK to add the resolution setting.

Click Cancel to close the dialog box without adding the custom
resolution.

You can delete (Remove) or change (Replace) a custom resolution
setting at any time.
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Setting Preferences 
You can select a preference that governs how your source image is
scanned using the Preferences tab. On the Preferences tab, click the
desired preference checkbox.

Text Enhanced 
This option is designed for use with OCR (Optical Character
Recognition) software. This setting increases the contrast in black and
white scanning to promote the accurate recognition of characters in
OCR software. Resolution should be at least 300 dpi for OCR scans.

For applications that request a black and white scan and do not use the
scan window (including most OCR applications), the text enhanced
setting is automatically used.

Color Matching
This option allows you to match from the scanner’s color space to the
default monitor’s color space ensuring that the colors match as closely as
possible to the original image.

Change Monitor Profile
Clicking this button allows you to change your monitor profile which
will affect how color matching is performed.
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Setting Paper Size
Select a paper size that corresponds to the size of your source document.
If your document does not conform to one of the available sizes, you
can define a custom paper size.

Selecting a Standard Paper Size

1. Click the C5500 tab.

2. From the Paper Size list, select the desired option.

Setting a Custom Paper Size

1. Click the C5500 tab.

2. In the Paper Size list, select Custom.

3. In the Units list, select the unit of measure by which you want to
define your custom size.

4. In the Width and Length text boxes, enter the dimensions of your
source document.
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Setting Black and White Options
If you choose black and white as your scan mode, you can also select one
of the following black and white options from the C5500 tab:

Threshold
The Threshold option provides a high contrast evaluation of the image
in terms of blacks and whites only.

Halftone
The Halftone option simulates the tonal range of an image with a
precise pattern of lines and dots.

1. Click the C5500 Tab.

2. In the Black & White Options list, choose Threshold or Halftone.

Adjusting the Preview Image for Final Scan
Once an image has been previewed, you can adjust it, as necessary, for
the final scan by changing its selection size, its output size, aspects of its
orientation, or aspects of its tone. For information on adjusting the tone
of the preview image, see Adjusting the Tone of the Preview Image on
page 6-13.

Clearing the Preview Area
If the preview image does not serve your purpose, you can quickly
remove it from the preview area and rescan the image.

On the toolbar, click Clear Preview.
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Adjusting the Preview Image View
To make it easier to work with your preview image, you can change
aspects of its display.

Changing the View Size

You can enlarge a preview image to better view its details. Each
enlargement doubles the size of the image up to a maximum of four
times the size of the original image.

As you enlarged the image, you can just as easily reduce it. Each
reduction decreases the size of the image by one-half.

1. On the toolbar, click Zoom.

2. To enlarge, left-click the mouse pointer on the image.

To reduce, right-click the mouse pointer on the image.

Displaying Rulers

To work precisely with a preview image, you can display rulers on the
top and left borders of the preview area. The rulers display in inches or
centimeters, depending on what you have set as the unit of measure on
the Main tab.

On the toolbar, click Rulers.

Adjusting the Selection Size
When you first preview an image, the selection size is the same as your
source document paper size.

You can adjust the selection size of an image in order to isolate a specific
area of the image for a more restrictive preview scan. For example, in
scanning a letter, you may want to isolate and save a company logo by
itself, ignoring the rest of the letter.

You define the selection size of your image by drawing a border around
the part of the image that you would like to isolate. Alternatively, you
can define and orient the dimensions of the selection with respect to the
upper left corner of the preview area. Regardless of how you define a
selection, you can easily and quickly change its dimensions.
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In defining the selection size, regardless of the method you choose, you
can maintain the current height and width proportions of the image.

For example, you set the width to 4 inches and the height to 6 inches.
You change the width to 5 inches. If Keep Proportions is not selected,
the height stays at 6 inches. Thus, the proportion of the page height and
width changes. If Keep Proportions is selected when you change the
width, the height automatically changes to 7.53 inches. The lock icon
indicates that the page size will be maintained in the same proportion
whenever you change either the width or the height.

1. Click the Main tab.

2. If you want to preserve the current proportions of the image, click
the Keep Proportions button.

3. To draw the selected area, click Crop on the toolbar and drag the
mouse diagonally across the area of the image in the preview
window you want to select. The Width and Height text boxes display
the new sizes.

4. To further define the dimensions of the selected area, in the Width
and Height text boxes, type the appropriate values. The image
selection borders change to match the specified width and height.

5. If you want to select an entirely different area of the image, click
outside the crop lines to clear the current selection.

6. To preview the newly selected image area, click Preview.

Moving an Image
If the image is too large to see in its entirety, you can move the image
within the preview area to locate a relevant section.

On the toolbar, click Move Image and drag the zoomed image to display
the appropriate area or detail.

KEEP PROPORTIONS
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Reversing the Image Tone 
You can create a negative of an image for stylistic effect. A negative
image is created by inverting the dark and light areas.

On the toolbar, click Negative/Positive.

Mirroring an Image
By mirroring an image, you can create an alternate version. For example,
you can create an alternate version of your company logo.

On the toolbar, click Mirror.

Rotating an Image
You can rotate an image 90° left or right within the preview area to
change its orientation. When you rotate an image, the entire preview
area, including the rulers, rotates. For example, if the preview area is in
portrait orientation, it becomes landscape.

On the toolbar, click Rotate Left or Rotate Right.

Scaling the Image Output Size
You can scale the preview image to better fit your needs by saving it as a
data file. For example, if you reduce by 50% the scale of an image that is
7 inches wide by 9 inches high, the output image will be 3.5 inches wide
by 4.5 inches high.

However, in scaling an image for the final scan, keep in mind that the
values in the width and height text boxes remain the same.

1. Click the Main tab.

2. In the Scale box, enter a new percent.

The new output size is displayed under Output Size.
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Adjusting the Tone of the Preview Image
The tone of an image is its shading and combination of colors. Adjusting
grayscale tones can enhance the contrast of a grayscale image. You can
produce a wide range of visual effects in your preview image by
adjusting the different settings on the Tone tab.

If you selected black and white or text enhanced as the scan mode, the
Tone tab is not available for selection. In these cases, you must adjust the
tone of the image with the contrast/brightness settings on the C5500 tab.

Exploring the Tone Tab
The Tone tab looks similar to this:

Tone Toolbar
Using the buttons on the Tone toolbar, you can access settings which
affect different aspects of image tone, and give you great flexibility in
manipulating your image tone before scanning the image.

AUTO
TONE GAMMA

SPECIAL TONE
CURVES

CONTRAST/
BRIGHTNESS

HISTOGRAM

TONE
TOOLBAR

TONE
GRAPH
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Tone Graph
Viewing the tone graph gives you more detail about the tone setting. The
shape of the tone graph changes to reflect the selected channel’s current
tone settings. The graph is directly editable only when the Special Tone
Curves button is selected.

Auto Tone
You can specify that tone corrections be made automatically. On the
Tone tab, click the Auto Tone button.

The image in the preview area reflects your selection.
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Adjusting Contrast and Brightness
You can adjust the contrast and/or brightness of a grayscale image.

1. On the Tone tab, click the Contrast/Brightness button.

2. Move the Contrast and Brightness sliders to the left for less contrast
or brightness, and to the right for more contrast or brightness, until
the desired contrast is achieved.

The image in the preview area reflects your changes.
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Changing Gamma Curve Values
With the Gamma curve, you can change the mid-tones of the image to
increase its contrast, and enhance the overall image. When you increase
the Gamma value, light areas are made lighter and dark areas are made
darker.

For example, if you are scanning a photograph that has many dark
tones, simply adjusting the brightness and contrast may not improve the
image as effectively as adjusting the Gamma value.

1. On the Tone tab, click the Gamma button.

2. Move the Gamma slider to the left to decrease the mid-tone
intensity, and to the right to increase the mid-tone intensity, until
the desired effect is achieved. You can also type a value into the text
box.

3. To return to the original Gamma curve setting, click Reset.
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Adjusting Histogram Tone Levels
You can use a histogram tool to adjust the tone shadow for the preview
image.

Using the eyedroppers, you can sample the black-point, mid-point, and
white-point tone in the preview image and base the image tone settings
on the sampling. Using the corresponding text boxes, you can type a
value in the Black-point, Mid-point, and White-point text boxes.

Under the histogram chart, you can slide the black, gray, and white
buttons to adjust the tones. However, you cannot edit the histogram
directly.

When you adjust the black-point, all tones in the image darker than the
selected black-point are adjusted to black.

When you adjust the mid-point, all tones in the image between the
black-point and the white-point are adjusted to the selected mid-point.

When you adjust the white-point, all tones in the image lighter than the
selected white-point are adjusted to white.

When you find a combination of tone settings you like, you can save the
settings in a file and use it in future scanning sessions.

EYEDROPPER
BUTTONS
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Adjusting the Tones Using the Histogram Tool

1. On the Tone tab, click the Histogram tool button you want to use.

2. For the black-point, mid-point, or white-point, do one of the
following to make a change:

• Click the appropriately labeled Eyedropper button. Then click
the eyedropper on the portion of the image in the preview area
that is darkest (for black-point), lightest (for white-point), or in
the middle of the tonal range (for mid-point). Try zooming in
on the specific part of the image so you can be sure you are
selecting the shade you want.

• In the appropriately labeled text box, enter a tone value.

• Drag the appropriate arrow at the bottom of the histogram to
the level you want.

In the preview image, all tones are adjusted accordingly.

3. To reset to the default values, click Reset.

To save these settings to use on similar images, click Save. In the
Save As Dialog box, specify the file name and location where you
want to save the setting, and click Save.
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Using Tone Curves
You can use predefined tone curves to automatically correct the most
common problems with images: overexposure, underexposure, or too
high or too low a contrast.

You can also manipulate a curve in the Special Tone Curve area to create
your own tone curve. On the Tone tab, click the Special Tone Curves
button you want to use.

To automatically compensate for common problems in an image, choose
one of the options from the list.

Creating a Custom Tone Curve

If you want to experiment with tones, you can create a custom tone
curve. An effective way to do this is first to adjust the preview image
with an appropriate predefined tone curve and then edit the results.

Editing a tone curve involves adding handles to an existing tone curve
and dragging them to change tonal levels in the image. When you drag a
handle to a white area, the shape of the curve changes, and the tones of
the preview image are adjusted.

All handles on the tone curve, including the end points, can be dragged
anywhere within the tone graph. A handle that is dragged outside the
tone graph is deleted, and the tone curve automatically conforms to the
remaining points. Except for the end points, you can delete all handles.
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1. In the Select Special Curve list, select Edit Custom Curve.

2. To add a handle to the tone curve, click on or near the curve.

3. To move a handle, drag the handle into a white area and release it.

4. To remove a handle, do one of the following:

• Drag the handle outside the tone graph

• Right-click your mouse pointer on the handle.

5. To undo all changes that you have made to the curve, click Reset.

To save your custom curve, click Save. In the Save As dialog box,
enter a file name and directory, and click Save.

The curve is saved with the file name extension .CRV.
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Opening a Custom Tone Curve

Custom tone curve files are saved in the MultiPASS directory. Use the
following steps to open a custom tone curve setting that you previously
saved.

1. On the Tone tab, click the Special Tone Curves button, and then
click Load.

2. In the Open dialog box, select the file name you want to load and
click Open.

Adjusting Contrast/Brightness for Black and 
White Scan Mode

For black and white scans, the contrast and brightness settings are
located on the C5500 tab.

Depending on the black and white option you choose for your scan, you
can adjust the contrast, brightness, or both of your preview image.

If you use halftone as your scan option, you can adjust both the contrast
or brightness of the image.

If you use threshold as your scan option (it is by definition a high
contrast image mode), you can only adjust the brightness of the preview
image.
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On the C5500 tab, under Black and White Options, use the available
slider to adjust the brightness or contrast.

N These tone adjustments are only for black and white images. If you 
select grayscale or color as your scan mode, you adjust the contrast 
and brightness of the image only on the Tone tab.
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This chapter contains information and instructions for managing,
manipulating, and modifying your documents in the MultiPASS
Desktop Manager. It includes:

❍ Managing your documents in the Desktop Manager

❍ Modifying a document

❍ Printing a document

❍ Adjusting the MultiPASS viewer default options

Managing Your Documents in the 
Desktop Manager

Once you send a PC fax, receive a fax, or scan an image, the resulting
document is available in the Desktop Manager. You can perform a
variety of tasks with your documents, as described in this chapter.

Selecting Documents in the Desktop Manager
To work with a document, you select it in the open folder, while in either
Document View or List View. If you are in Document View, generally
you can select one or more documents at a time for whatever task you
need to perform.

7Working With Documents 
in the Desktop Manager
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Selecting a Document in Document View
With the folder open, do one of the following.

❍ For a single document, click the document thumbnail.

❍ For multiple nonsequential documents, hold the Ctrl key while
clicking on each document you want to select.

Selecting a Document in List View
With the folder open, click the document name in the list.



Chapter 7 Working With Documents in the Desktop Manager 7-3

Printing a Document in the Desktop Manager
You can print a document from any folder in the Desktop Manager.

1. In either Document View or List View, do one of the following.

• Click the document you want to print; this highlights the
document. Then, choose the Print command from the File
menu.

• Drag the document to the Print button on the Process toolbar.

2. In the Print dialog box, make sure the Canon MultiPASS C5500
Printer is selected, and click OK.
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Creating a Folder
To better organize your documents in the Desktop Manager, you can
create additional folders when needed and store them in the Cabinet.
Like creating any Windows folder, you can name the folder anything 
you like.

1. In the Desktop Manager, click the Cabinet, or if you want to store 
a folder within a folder, click the applicable folder.

2. Choose the New Folder command from the File menu.

3. In the Create Folder dialog box, enter a name of your new folder
and click OK.

Moving a Document
You can move a document from:

❍ A system-defined folder to a user-defined folder

❍ A system-defined folder or user-defined folder to the Trash folder

❍ One user-defined folder to another user-defined folder

You cannot move a document into a system-defined folder other than
the Trash folder.

1. In either Document View or List View, open the folder containing
the document you want to move.

2. Drag the document to the desired folder.

In Document View, the document is placed in the first available grid
space. In List View, the document is placed in the appropriate sort order.
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Copying a Document
A document can be copied within the same user-defined folder, or 
from one folder to a different user-defined folder. When you copy a
document within the same folder, the copy is assigned the same name as
the original document, with an added unique number. For example, if
you copy a document called Document 1, the new copy will be named
Document 2.

Copying a Document Within the Same 
User-defined Folder
1. Open the folder with the document you want to copy.

2. Click the document to highlight it, then click the Duplicate button
on the Document toolbar, or choose the Duplicate command 
from the Edit menu. Or, right-click on the document and select
Duplicate.

Copying a Document From One Folder to Another
1. Open the folder with the document you want to copy.

2. Drag the document, while holding down the Ctrl key, to the desired
folder.

Renaming a Document or Folder
You can rename a user-defined folder or a document at any time. Folder
names must be unique within the Desktop Manager. Document names
must be unique within a folder.

Whenever you attempt to rename a folder or document, the system
verifies whether the new name is unique. In the event of a conflict, the
system alerts you of the conflict. A folder or document name can
contain blank spaces.
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To rename a document, do one of the following.

❍ Click the document, then choose the Rename command from the
File menu, or click the right mouse button and choose Rename. In
the Rename dialog box, type the new name and click OK.

❍ In Document View, click the document thumbnail. Then click 
the document name to position the insertion point. Using the
Backspace and Delete keys, edit the name of the document as
desired.

To rename a folder, do one of the following.

❍ Click the folder. Then, on the File menu, click Rename. In the
Rename dialog box, enter the new name and click OK.

❍ Right-click on the folder and select Rename. Enter the new name in
the Rename dialog box and click OK.

❍ Click the folder name. Enter the new name in the highlighted
rectangle.

You cannot rename a system-defined folder.

Deleting a Document or Folder
You can delete a document or user-defined folder when it is no longer
needed.

When you delete a document, it moves to the Trash folder. To
permanently delete a document(s), you must empty the Trash folder.

When you delete a folder, it is removed from the Desktop Manager
window immediately and permanently deleted. You don’t have to empty
the trash to permanently delete folders.
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Deleting a Document
Open the folder with the document you want to delete and click the
document, then do one of the following.

❍ Choose the Delete command from the Edit menu.

❍ Press the Delete key on your keyboard.

❍ Click the right mouse button and choose Delete.

When the confirmation message displays, click Yes. The document is
moved into the Trash folder.

Deleting a Folder
Click the folder you want to delete, then do one of the following.

❍ Choose the Delete command from the Edit menu

❍ Press the Delete key on your keyboard

❍ Click the right mouse button and choose Delete.

When the confirmation message displays, click Yes.

N If you have documents in a folder you are attempting to delete, choosing
Yes on the confirmation message will delete both the documents and the
folder. Deleted documents are moved into the Trash folder.

Restoring a Deleted Document
If a document is in the Trash folder, you can restore it to its original
folder provided it was deleted from a user-defined folder.

1. In the Desktop Manager, click the Trash folder.

2. In the Trash folder, drag the document you want to restore into its
applicable user-defined folder.

Documents that have been deleted from the Trash folder cannot be
restored.

D
oc

um
en

ts
 in

D
es

kt
op

 M
an

ag
er



7-8 Working With Documents in the Desktop Manager Chapter 7

Emptying the Trash Folder
Documents remain in the Trash folder until you move them to a user-
defined folder, delete them individually, or empty the Trash folder and
delete all documents in the folder.

To prevent out-of-date documents from unnecessarily taking up space
on your hard disk, you should periodically review the Trash folder and
remove the documents no longer needed.

Choose the Empty Trash command from the File menu, or click the
right mouse button on the Trash folder and choose Empty Trash. If
prompted, confirm that you want to empty the Trash folder.

Once emptied, all documents are permanently removed from the
Desktop Manager (and your hard disk).

Importing a Document
If you have a document residing on your hard disk or a diskette, you can
import it into the In Box or a user-defined folder using the Desktop
Manager. You can import a document saved in any of the following
formats: TIFF, BMP, FPX, JPG or PCX.

1. Open the In Box or user-defined folder into which you want to
import a document.

2. Choose the Import command from the File menu, or click the right
mouse button on the folder and choose Import.

3. In the Import File dialog box, specify the drive, directory, and name
of the file you want to import, and click Open.
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Exporting a Document
You can export a document from the Desktop Manager, saving it to any
specified drive and directory. When you export a document, you are
actually saving a copy of the original document. Documents can be
exported as a TIFF, BMP, FPX, PCX or JPEG file.

1. Open the folder with the document you want to export.

2. Click the document you want to export, then choose the Export
command from the File menu.

3. In the Export File dialog box, specify the drive and directory where
you want to place the exported file, and click Save.

If you export a multiple page document, each page must be
exported as a separate document.

Attaching a Document to Electronic Mail (E-mail)
If you have a MAPI-compliant e-mail application (such as Microsoft
Exchange®) installed on your system, you can attach a document in the
Desktop Manager to an e-mail message. When you select a document
and use the E-mail command, the Desktop Manager opens your e-mail
application, and attaches the selected document to a blank e-mail
message. You cannot, however, open your e-mail application from the
Desktop Manager if you don’t plan on attaching a document.

To attach a document to an e-mail message, select the document you
want to attach and drag it to the E-mail button on the Process toolbar.
You can also choose the Send E-mail command from the File menu.
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Manipulating a Document in Document View
If you are working in Document View, you can manipulate your
documents in the open folder in a variety of ways. For example, you can
arrange documents in a preferred order, remove a page, split a single
document, or merge one document with another.

Arranging Documents in Document View
A document thumbnail in Document View retains its position until you
rearrange it. You can arrange one or more documents manually or
automatically.

When you arrange documents automatically, they are positioned within
a grid, with row positions filling from left to right.

Arranging documents manually

With the desired folder open, select the document you want to move
and drag it to the desired location within the work area.

Arranging documents automatically

With the desired folder open, choose the Arrange command from the
View menu or the Document toolbar, or click the right mouse button in
the work area and choose Arrange.

Scrolling Through a Multi-page Document
You can scroll through a multiple-page document to position yourself at
the page you want to remove or where you want to split the document.

As you scroll pages in the document, the current page number updates
instantly. After scrolling, the top page is retained even if the folder is
closed and reopened.

For the selected document, do one of the following.

❍ Click the left and right scroll arrows displayed with the page
numbers for the document.
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❍ Drag the scroll tab on the right side of the document.

Removing a Page From a Document
You can remove the current top page of a document. For example, you
may want to remove the cover page from a received fax.

1. Scroll through the document until the page you want to remove is
on top.

2. Choose the Remove Page command from the Edit menu or the
Document toolbar.

Splitting a Document
As may be desirable, you can split a document into two documents 
from any page after the first page. In other words, you cannot split a
document on page 1. For example, you split a 10-page document,
beginning at page 5. The original document consists of pages 1 through
4. The newly created document consists of pages 5 through 10.

The original document—consisting of at least the first page, up to the
page where the split occurred—retains the original name. The newly
created document is assigned a new unique name, which can be changed
as desired.

1. Scroll to the page where you want to split the document. The top
page represents the first page for the newly created document.

2. Choose the Split command from the Edit menu or Document
toolbar.
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Merging a Document
You can merge two documents to combine them into a single document.
The documents are merged in the order you select them. In other words,
the first document selected becomes the top pages of the second
document selected. Both documents are merged into the second
document.

1. Select the two documents you want to merge (by holding the Ctrl
key and clicking each document).

2. Choose the Merge command from the Edit menu or Document
toolbar.

Indexing and Searching for Documents
Each document you add to the Desktop Manager stores key information
about itself into an internal database giving you great flexiblity when it
comes to document indexing and searching. You can also manually
index your documents, adding keywords and other parameters that you
can use later when searching for documents.

To index your documents, you first set up your index and then you
assign the index criteria to your documents.

Setting Up the Index
The Desktop Manager allows you to search for documents by date 
and text, as well as by creator, owner, and keyword. Before you can use
these search criteria however, you must first add them to the Desktop
Manager.
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Adding a creator to the index

1. In the Desktop Manager, on the Tools menu, point to Index By, and
then click Creators.

2. In the Edit Creator List diaog box, click Insert.

3. Type the creator name you wish to add to the index and press Enter .

• Repeat steps 2 and 3 for each creator you want to add.

You can Remove or Change a creator.

To close the Edit Creator List dialog box and save your index entries,
click Close.
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Adding an owner to the index

1. In the Desktop Manager, on the Tools menu, point to Index By, and
then click Owner.

2. In the Edit Creator List diaog box, click Insert.

3. Type the owner you want to add and then press Enter .

• Repeat steps 2 and 3 for each owner you want to add.

You can Remove or Change an owner.

To close the Edit Owner List dialog box and save your index entries,
click Close.
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Adding keywords to the index

1. In the Desktop Manager, on the Tools menu, point to Index By, and
then click Keywords.

2. In the Edit Keyword List diaog box, click Insert.

3. Type the creator name you wish to add to the index and press Enter .

• Repeat steps 2 and 3 for each creator you want to add.

You can Remove or Change a keyword.

To close the Edit Keyword List dialog box and save your keywords, click
Close.
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Assigning Index Criteria to Documents
After setting up your index entries, you can assign them to your
documents. You can index your documents by creator, owner, or
keyword.

1. In the Desktop Manager, click the document for which you want to
add index entries.

2. On the Tools menu, click Manual Index.

• The Manual Indexing dialog box for this document displays
showing you the existing Creator, Owner, and any Keywords
assigned to the document.

3. If you want to review this document, click Display Document.
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4. To change the Creator of the document, click the Creator button.

• Highlight the creator you wish to assign to the document and
click OK.

• To edit the Creator list, click Edit List. (See page 7-13.)

5. To change the Owner of the document, click the Owner button.

• Highlight the owner you wish to assign to the document and
click OK.

• To edit the Owner list, click Edit List. (See page 7-14.)
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6. To change Keywords assigned to the document, click the Keywords
button.

• Click a keyword you wish to assign to the document, then click
Add.

• To remove a keyword, highlight it in the assigned list and click
Remove.

• To remove all keywords, click Clear.

• To edit the Keyword list, click Edit List. (See page 7-15.)

• After assigning the keywords, click OK.

7. After making your index entries, click the Submit button to save the
entries and close the dialog.
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Searching for Your Documents
You can search for a particular document by Date, Creator, Owner,
Keyword, or Text string.

1. On the Tools menu, click Search.

2. To search by Date or Time, enter the desired From and To dates
and/or times to display all documents created within this period.

3. To search by Creator, click the Creator button. Highlight each
Creator by which you want to search and click Add.

• To remove a selected item, highlight it in the assigned list and
click Remove.

• To remove all selected items, click Clear.

• After making your selections, click OK.

4. To search by Owner, click the Owner button. Highlight each Owner
by which you want to search and click Add.

• To remove a selected item, highlight it in the assigned list and
click Remove.

• To remove all selected items, click Clear.

• After making your selections, click OK.
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5. To search by Keywords, click the Keywords button. Highlight each
Keyword by which you want to search and click Add.

• To remove a selected item, highlight it in the assigned list and
click Remove.

• To remove all selected items, click Clear.

• After making your selections, click OK.

6. To search by a Text string, enter the Text by which you want to
search and choose any desired search critiera including:

Word Match
• Any—Look for the specified text in any part of a word.

• Exact—Look for exact text matches only.

• Start of Word—Look for the specified text in the start of a word
only.

• Text—Search on text.

• Annotation—Search on annotations.

Search On
• Full—Search for all documents.

• Last Results—Search only for the last search result.
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7. Click Search.

The search is conducted on all of your folders. Any documents that
match the document attribute criteria are included in the result list.
The documents are listed in descending order based on the number
of search items located in the document.

• To display a document, highlight it in the Results list and click
the Display button, or double-click the document name.

• To start a new search, click the Search button. (This
automatically closes the current Search Results dialog box.)

• Click Close to close the Results List dialog box.

To re-display the Results List for the last search made, from the Tools
menu, choose the Show Results command.
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Modifying a Document
You can open a document to view its contents, and then annotate it with
notes, highlighting, stamps, sticky notes, or graphics (line/arrow,
rectangle, circle). Although you can save the document with the
annotations, they are only added markings placed on the original
document, not an integral part. The original contents of the document
remain intact. If you choose to fax or print the modified document, you
have the option NOT to include the annotations with the document.

When you open a document for annotation, the document displays in
the MultiPASS Viewer.

To open a document in the MultiPASS Viewer, do one of the following
in the Desktop Manager:

❍ Double-click the document.

❍ Select the document you want to open, then choose the Open
Document command from the File menu.

❍ Drag the document to the Open Document button on the Process
toolbar.

STICKY-
NOTE

DRAWN
GRAPHIC
(CIRCLE AND
ARROW)

STAMP

HIGHLIGHT
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To annotate a document:

1. With the document open in the MultiPASS Viewer, adjust the size of
your view of the document as needed.

2. Insert the desired annotations.

3. Choose the Save command from the File menu to save the
annotations with your document in the Desktop Manager.

To close the MultiPASS Viewer, choose the Exit command from the File
menu. If you neglected to save your annotations, you are prompted to
do so before the program closes.

Exploring the MultiPASS Viewer Window
The MultiPASS Viewer window is similar to this:

MENU BAR

FILE TOOLBAR

ANNOTATION
TOOLBOX

IMAGE
TOOLBAR

LAYOUT AREA

STATUS BAR
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Menu Bar
The menu bar contains commands that enable you to perform various
tasks with your document. Some of the commands can also be accessed
by their corresponding buttons on the toolbar.

File Toolbar
The File toolbar provides you quick access to commands needed to
open, save, print, edit, and zoom a fax cover page.

Image Toolbar
The Image toolbar provides you quick access to commands needed to
select, lasso, move, zoom, straighten or annotate a document.

Annotation Toolbox
The Annotation toolbox allows you to add text and graphics to a
document. Annotations are not integral elements of the document. You
can choose to send them with the document, or hide them using the
Hide/Show Annotations command in the View menu.

SELECT

LASSO

MOVE

ZOOM

STRAIGHTEN

ANNOTATE

SELECT, RECTANGLE, LINE, ELLIPSE, ARROW, POLYGON

FREE DRAW, HIGHLIGHTER, TEXT, STAMP, STICKY NOTE

OPEN PRINT CROP REDO HELP

SAVE COPY UNDO ZOOM
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Document Display Area
The document itself is displayed and modified in the Document Display
Area. You can page or scroll through the document, enlarge or reduce
the view of the document, or change the orientation. The display area
also contains the results of any annotations you may add to the
document.

Status Bar
The status bar appears at the bottom of the window, and contains useful
information about the document that you are currently viewing.

Adjusting the Size and View of a Document
With different tools in the MultiPASS Viewer, you can adjust both the
size of your document as well as the manner in which it is displayed.

Adjusting the Size of a Document
Adjusting the size of a document can be useful in planning other tasks.
For example, if a document consists solely of a large graphic, you may
want to reduce its size so that it can be used later in creating a
background for a cover page.

Changing the size of a document involves changing the number of pixels
used to represent it. Such a change permanently alters the document file.

1. Choose the Image Size command from the Adjust menu.

2. In the Image Size dialog box, enter the dimensions of the newly
sized document.

3. Click OK. The document file is resized.
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Adjusting Your View of a Document
In annotating a document, you may need to adjust your view of it. One
of the ways you can adjust the view of an open document is to hide or
show the different components of the MultiPASS Viewer.

To show or hide the components of the window, select the View menu.
In the View menu, click Toolbars, Status Bar, Rulers, Navigator, and/or
Annotations. There are three toolbars: FileTools, Image Palette, and
Straighten Tools. Click the option to show (checkmark) or hide (no
checkmark) the toolbar.

For Status Bar, Rulers, Navigator, and Annotations, clicking on a
command turns the display of the item on and off and changes the
command name from Show to Hide.

Changing the Document Orientation
You may need to rotate a document for easier reading. For example, the
document may represent a fax you received that was originally sent in
landscape mode or was fed into a fax machine in an inverted position.
The change in orientation applies to the entire document, not just the
currently displayed page.

In the Edit menu, click Rotate. From the Rotate submenu, click 90, 180
(flipping the document upside down), or 270.

Straightening a Document Display
You may receive a scanned document that displays crookedly in the
Desktop Manager. Instead of re-scanning the document, you can
straighten the document display using the Straighten Tools in the
MultiPASS Viewer.

1. With the document open in the MultiPASS Viewer, click the
Straighten button on the Image toolbar. Crosshairs display over
your document, and the Straighten toolbar displays.

ROTATE
CLOCKWISE

ROTATE 
COUNTERCLOCKWISE

STRAIGHTEN
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2. On the Straighten toolbar, click the Rotate Clockwise or Rotate
Counterclockwise buttons until the document is evenly aligned in
the crosshairs.

3. On the Straighten toolbar, click the Straighten button.

4. Save your changes.

Adjusting the Document and Display Size
The MultiPASS Viewer also offers different levels of magnification to
enable you to work at the most comfortable size for your document. You
can zoom in and out at predefined increments or specify a particular
size or scale.

You can use the Fit to Width option to fill the width of the window with
your page display, or use the Fit to Window option to adjust the
document image size so that the entire document is visible within the
window.

To zoom in or zoom out on the document, do one of the following.

❍ From the View menu, click Zoom, then select the desired level of
magnification.

❍ From the File toolbar, select the desired level of magnification from
the list.

❍ From the Image toolbar, click the Zoom tool and:

• To increase magnification, click the document.

• To decrease magnification, press and hold the Alt key, then click
the document.

To fit the cover page to the display window, click Fit Image to Window
from the View menu.
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Scrolling through a Zoomed Cover Page
If you need to work on particular aspects of a document (for example,
to modify a recurring graphic), you can scroll through the document
while maintaining a high level of magnification. To do this, you use the
Navigator and Scroll tools.

To select a specific size or scale for enlarging or reducing the document,
click Zoom on the View menu. On the Zoom menu, click the desired
size. Or, click the size or scale from the list box on the toolbar.

1. From the View menu, click Show Navigator. The Navigator window
opens in the right corner of the screen. Inside the Navigator, a white
rectangle indicates the area of your document that is currently in
view.

2. On the Image toolbar, click the Move button. The cursor turns into
a hand.

3. While tracking your position in the Navigator window, click and
hold the left mouse button and drag the image to bring the desired
area of the document into view.
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Editing the Base Image 
While working with a document, you may need to edit the base image
that underlies all annotations. When editing a base image, you can select,
crop, or flip a specific area. For example, to create a novel effect, you may
want to flip an imbedded graphic on its vertical or horizontal axis.

1. On the Image toolbar, choose either the Select or Lasso tool.

• Use the Select tool for areas that fit easily inside a square or
rectangle.

• Use the Lasso tool for irregularly shaped areas.

2. Drag the cursor to draw the appropriately shaped container for the
area you want to select.

Cropping a document
You can crop a document to any size that you select.

1. Select the area of the document to which you want the entire
document to conform.

2. Choose Crop Inplace from the Edit menu or File toolbar.

Flipping a Document or Selected Area
Flipping a document may be useful; for example, if you want to create a
mirror image of a graphic.

To flip the entire cover page, select Flip from the Edit menu, then choose
Horizontal or Vertical.

To flip a selected area of a cover page, select the area and then select Flip
from the Edit menu; now choose Horizontal or Vertical.
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Adding Annotations to Your Document
To annotate a document through the MultiPASS Viewer, you must click
on the Annotate button on the Image toolbar. The Annotation Tools are
then displayed on the screen and the Annotation menu is added to the
menu bar.

The following sections describe the various ways you can annotate your
document.

Setting Font Defaults
In adding annotations to your document, you can use a number of
different text tools. Each tool includes options for adjusting font style,
size, and effects. Additionally, you can also select a set of font properties
to be used as defaults whenever font properties are not customized for a
particular tool.

1. Choose the Select Font command from the Annotation menu.

2. In the Font dialog box, select your preferred options.

3. Click OK.
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Adding Text to a Document
You can add text on any portion of your document. When you do so,
you can choose the text attributes: font, font size and color, and special
effects (underline, strikeout), background color and mode.

You can type any text that you want, editing it later as necessary. If you
select a font, font size, a color, or special effect, it affects the entire note.
If you change any of the attributes while editing a note, or while the note
is selected, it changes all the text in the note.

1. If not selected, click the Annotations button on the Image toolbar.

2. On the Annotations toolbar, click the Text tool and drag the cursor
to draw an appropriately sized square or rectangle in the layout area.

3. Enter the new text.

4. Click the Select Annotations tool from the Annotations toolbar, then
click the new text.

5. Right-click inside the newly drawn square or rectangle to select the
desired text adjustment options from the Annotations option.

• Click Select Font to set font properties for the text.

• Click Set Background Color to set a background color.

• Click Set Foreground Color to set a text color.

6. Click outside the text box.

7. From the File menu, click Save. The new text is added to the
document.

Editing text added to a document

1. On the Annotation toolbox, with the Selection tool selected, double-
click the text you added. The cursor changes to an insertion point.

2. Edit the text as needed.

3. Click outside the area of the text box.

4. From the File menu, click Save.
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Adding a Sticky-Note
Rather than add text directly to a document, as you do with the Text
tool, you can add a Sticky-Note to any portion of the document.

When you add a Sticky-Note, you can choose the text attributes: font,
font size and color, background color, and special effects (underline,
strikeout).

You can type any text that you want for the Sticky-Note, editing the note
later if necessary. If you select a font, font size, a color, or special effect,
it affects the entire note. If you change any of the attributes while editing
a note, or while the note is selected, it changes all the text in the note.

1. In the Annotations toolbar, click the Sticky-Note tool and drag the
cursor to draw an appropriately sized square or rectangle.

2. Type the text of your note.

3. Click the Select Annotations tool, then click the Sticky-Note.

4. Select the desired adjustment options from the Annotation menu.

• Click Select Font to set font properties for the text.

• Click Background Color to set a background color for the note.

5. To add the Sticky-Note to document, click outside its borders.

Editing the text in a sticky-note

1. On the Annotation Toolbar, with the Selection tool selected, double-
click the Sticky-Note. The cursor changes to an insertion point.

2. Edit the text as needed.

3. Click outside the area of the Sticky-Note.
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Inserting a Stamp
You can add either a text or graphic image stamp to your document. The
Desktop Manager contains a library of available stamp images, stored as
BMP files, that were installed with the Desktop Manager software.
Additionally, you can add graphics into the stamp library provided the
graphic is saved in a BMP format.

1. Choose the Select Stamp command from the Annotation menu.

2. In the Select Stamp dialog box, click Add. An Open dialog box
displays.

3. Locate the BMP file you wish to add to the Stamp library and click
Open. If you have multiple graphics you want to add, repeat this
step.

4. Click the first graphic you want to insert into the document and
click OK.

5. Click the Stamp tool on the Annotation toolbox.

6. Click the mouse at the location where you want to place the stamp
in the layout area.

7. To add a different stamp to the cover page, choose the Select Stamp
command from the Annotation menu.

8. Click the stamp you want to insert and click OK.
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9. Click the Stamp tool on the Annotation toolbox.

10. Click the mouse at the location where you want to place the stamp
in the layout area.

Creating a Text Stamp
You can also create and use a Text Stamp on a document.

1. Choose the Select Stamp command from the Annotation menu. The
Select Stamp dialog box displays.

2. Click the Text Stamp tab.

3. Click Add.

4. In the Text Stamp Edit box, type the text you wish to assign to the
Stamp.

• To add a date to the stamp, click Date.

• To add the current time to the stamp, click Time.

• To change the font and text characteristics of the text, click Font.

5. Click OK to close the Edit Text Stamp dialog box.

6. Click OK again to save the text stamp and close the Select Stamp
dialog box.
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Editing a text stamp

1. Choose the Select Stamp command from the Annotation menu.

2. Click the Text Stamp tab.

3. Click the stamp you want to edit, then click Edit.

4. Modify the text and click OK.

5. Click OK to close the Select Stamp dialog box.

Removing an image or text stamp

1. Choose the Select Stamp command from the Annotation menu.

2. Click the stamp you wish to remove, then click Delete. A
confirmation message displays.

3. Click Yes.

4. Click OK to close the Select Stamp dialog box.

Inserting a text stamp

1. Choose the Select Stamp command from the Annotation menu.

2. Click the Text Stamp tab on the Select Stamp dialog box.

3. Click the text stamp you wish to insert into the document and click
OK.

4. Click the mouse at the location where you want to place the text
stamp in the layout area.

Highlighting Your Document
You can add a color highlight to text or other images in a document. To
do this, select a color and then draw a rectangular highlight over the
desired area. All highlight colors are transparent and display in the color
you specify. When you print the document, the highlighted region prints
as gray shadings.

D
oc

um
en

ts
 in

D
es

kt
op

 M
an

ag
er



7-36 Working With Documents in the Desktop Manager Chapter 7

Highlighting a region

1. On the Annotations toolbox, click the Highlighter tool.

2. To select a highlighting background color, choose the Background
Color command from the Annotation menu, then select the desired
color.

3. Drag the cursor over the area you want to highlight. When you
release the mouse button, the highlight is completed.

Creating a Drawing Graphic
You can also annotate a document with one or more drawing objects
that include a straight line, a single-headed arrow, a hollow rectangle,
and a hollow circle or ellipse. When you draw the object you can select
the color, line thickness, and style of line for the object.

1. On the Annotation toolbox, click the drawing object tool:
Arrow/Line, Rectangle, or Circle.

2. From the Annotation menu, select the color, line thickness, and style
of line for the object you are drawing. For an arrow or line, also
select the particular style you want to use.

3. At the desired location in the layout area, drag the cursor to draw
the object. When you release the mouse button, the object is
completed.

Revising Your Annotations
Once you have added annotations to your document, you can revise
them as needed. For example, you may want to resize, move, delete or
cut, or copy and paste an annotation.
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Selecting One or More Annotations
To revise an annotation, you must first select it. In most situations, you
can select one or more annotations at a time.

To select a single annotation, click the Select Annotations button on the
Annotations toolbar. Then click the annotation.

To select multiple annotations, make sure the Select Annotations button
is selected. Then hold down the Shift key and click each annotation. You
cannot resize an annotation using this method.

Moving an Annotation
You can move an annotation from one position to another.

Select the annotation and drag it to the desired location.

Resizing the Annotation
When you create an annotation, you draw it to the desired size. If the
original size proves unsuitable, you can resize the annotation either
smaller or larger.

Click the border of the annotation and drag any sizing handle.

Copying Fields
If you want to copy a field or graphic item and paste it into another
Windows application that supports a Paste option, you can do so using
the Copy command. When you copy a field or graphic item, it is placed
in the Cover Page Designer clipboard. From the clipboard, you can paste
it into any Windows application that supports this command.

1. Select the field/graphic element to be copied. Then, choose the Copy
command from the Edit menu or toolbar, or click the right mouse
button and select Copy from the Edit menu.

2. Open the Windows application where you want to paste the item.

3. Paste the item into the Windows application (usually, by selecting
the Paste command from the Edit menu or toolbar).
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Removing an Annotation
If you decide you no longer want an item to appear in a document, you
can remove it permanently by selecting it, then pressing the Delete key.

Reverting to the Last Saved Version
If you are dissatisfied with changes that you have made to your
document, you can discard them and return to the last saved version.

Choose the Revert to Original command from the File menu.

Printing the Document
You can print a copy of the document currently open in the MultiPASS
Viewer, with or without any annotations you may have created. Prior to
printing, you can specify certain print setup options.

N To print the document without annotations, you must select Hide
Annotations from the View menu prior to printing. (To do so, the
Annotation toolbar must be closed.)

On the File menu, click Print or Print Setup. Specify your print options
and click OK.
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Previewing the Document Before Printing
1. Choose the Print Preview command from the File menu.

2. From the Print Preview window, you can:

• Click Print to print the document.

• Click Next Page or Prev Page to view other document pages.

• Click Two Pages to view two pages at a time.

• Click Zoom In or Zoom Out to better view the document.

• Click Close to close the window without printing.

Adjusting the MultiPASS Viewer 
Default Options

As you work in the MultiPASS Viewer, you can change options that
affect the view and scale of the open document.

1. Choose the Preferences command from the File menu.

2. In the Preferences dialog box, select your options.

• Select a Unit of Measurement from the list.

• Enable or disable the “Automatically fit window to image on any
change” option.

• Enable or disable the “High quality when zooming” option.

3. Click OK.
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This chapter contains information and instructions on changing your
MultiPASS C5500 setup options in the Desktop Manager, and using
other Desktop Manager utilities. It includes:

❍ Fax setup

❍ System setup

❍ Launcher setup

❍ Making a phone call from the Desktop Manager

❍ Using the MultiPASS Server

❍ Closing the MultiPASS Server

❍ Disconnecting the MultiPASS

❍ Uninstalling the MultiPASS software

8Setup and Other Utilities in the
Desktop Manager
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Fax Setup
The Desktop Manager contains setup options that define the fax
operation of your MultiPASS C5500 and that affect the general
operation of the Desktop Manager. You can set options that affect
preferences, sending a PC fax, receiving a fax, and using the speed 
dial features.

When you first install the Desktop Manager, setup options are set to
appropriate default settings. The default settings enable you to begin
using your MultiPASS with the Desktop Manager immediately. However,
you can change option settings as needed.

Because you can make changes to some option settings either on the
MultiPASS unit or in the Desktop Manager, be aware of the following:

❍ Any option setting you make on the MultiPASS unit does not display
in the Desktop Manager Setup Options dialog box.

❍ Any change you make to an option in the Desktop Manager
overrides the corresponding setting you may have made on the
MultiPASS unit itself.

Therefore, before you make changes to these option settings, decide
where you prefer to make your changes—on the MultiPASS unit or in
the Desktop Manager. Establishing a preference for changes will help you
avoid overriding your previous settings.

N When the MultiPASS is connected to your PC, we recommend that you
use the Fax Setup dialog box in the Desktop Manager. Do not make your
changes using the operator panel of the MultiPASS.

The following instructions summarize the overall procedures for
changing MultiPASS Fax Setup options in the Desktop Manager.
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1. In the Fax Setup dialog box, click the appropriate tab to display the
options you want to verify or change.

2. Once you have the appropriate Fax Setup tab displayed, specify your
changes.

3. To save changes and close the dialog box, click OK. When prompted,
choose whether or not you want to overwrite the settings on your
MultiPASS.

• To exit the dialog box without saving your changes, click Cancel.

When you save your changes, the MultiPASS Fax Setup options are saved
in the Desktop Manager, as well as on the MultiPASS unit.

Setting Up Fax Preferences
To set up various fax options, choose the Fax Setup command from the
Setup menu.

You see the Fax Setup dialog box. You can change the following options
on the Preferences tab.
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Date Format
You can select the format used to display the date on the MultiPASS
LCD and for printing the date on a fax from the list.

Display Language
You can select the language to be used on the MultiPASS LCD from the
list.

Telephone Attached to Unit
If you have a telephone attached to your MultiPASS, click this checkbox.
When selected, you can use the Desktop Manager to dial a phone
number.

When you select this option, the Phone command (in the File menu and
toolbar) becomes available in the Desktop Manager.

Volume
You can set the volume level of the various sound components of your
MultiPASS to best suit your office environment.

Setting Up Send Fax Options
You can change the following options on the Send Fax tab.
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Fax Information
You can specify the following information that displays as the header for
a PC fax: your name, company name, and fax number. Initially, you set
up this information when you installed the Desktop Manager.

Phone Line
You can specify the dialing method the MultiPASS printer will use:
touch tone or rotary pulse. You also specify any prefix used to access an
outside phone line (usually 9).

Retries
You can specify the number of retries the system should attempt when
sending a fax transmission, and the length of time between each retry.

Report
You can specify whether or not you want a report to print with each fax
transmission (Every trans.), or only when there is an error (Only
Errors). You can also specify if you want an image of the first page of the
fax included in the report. (The report prints the image for plain paper
faxes only, not for PC faxes.)

Restoring the Default Settings
If you want to restore the option default settings after making changes,
click Use Defaults.

Setting Up Advanced Send Fax Options
You can change the following options by clicking Advanced on the Send
Fax tab.
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Speed
You can set the transmission speed used to send faxes. The higher the
setting, the faster the transmission. If you experience problems when
sending faxes, try a lower speed setting.

Pause Duration
You can set the length of the pause that you may have to insert when
dialing a long distance number.

Error Correction (ECM)
You can select this option to reduce system and line errors when sending
a fax. With this option selected, the system checks each outgoing fax for
lost data. If data has been lost from a portion of a page, the system
transmits that portion again after confirming that all data within that
portion can be transmitted successfully.

Auto Start Send
When you select this option, the MultiPASS starts scanning
automatically when you enter a number and press START or when you
press a speed dial number. If you don’t select this option, you must press
START twice to scan the document.

Off Hook Alarm
You select this option to turn on the alarm if the telephone’s handset is
off-hook.

Image Contrast
You can select a setting that determines the level of contrast in the 
faxes you send. The Standard setting is usually appropriate for most
documents. However, based on the lightness or darkness of your original
fax document, you may prefer to lighten (Lighter) or darken (Darker)
the contrast for the fax transmission.

Fax Heading Position
You can select where you want the sent fax heading information (your
fax number, your name, and date and time) to print on the faxes you
send. This information is known as the Transmit Terminal Identification
(TTI).

On Error Resend
You can select this option if you want the MultiPASS to automatically
redial when an error occurs while sending a fax. If this option is selected,
you also select which pages should be resent:

❍ All Pages—all pages of the fax.
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❍ Error and First Page—the page on which the error occurred, all
pages following the error, and the first page of the fax.

❍ Error Pages—the page on which the error occurred, and all
following pages.

Setting Up Receive Fax Options
You can change the following options on the Receive Fax tab.

Paper Size
You can select the size of the paper you are using for printing a fax.

Reduction
You can specify whether you want an incoming fax reduced to ensure
the contents fits on the paper on which it is printed. If you want to
reduce the incoming fax, you can fit to height only, or both the height
and width, to fit the paper size.

Answer Receive Mode
You can select the mode by which you want the MultiPASS to receive
incoming calls:

❍ Fax Telephone Switching (FaxTel)—Automatically switch for
receiving a call either as a fax or telephone call
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❍ Dedcated Fax Receive (FaxOnly)—Automatically receive only fax
calls

❍ Manual Receive (Manual)—Require you to manually answer the
incoming call and then set the MultiPASS for an incoming fax

❍ Answering Machine Mode (AnsMode)—Automatically receive a call
with your answering machine

❍ Distinct Ring Pattern Detect (DRPD)—Automatically switch
between receiving a call either as a fax or telephone call based on the
ring tone for each type of call (This setting is applicable only if you
subscribe to a special network service with your phone company
that defines multiple ring tones for your phone line.)

Answer Silent Receive
You select this option to set the MultiPASS not to ring for an incoming
fax. (This is applicable only in FaxTel Mode and Fax Only Mode.)

Answer Number of Rings
If you cleared the Silent Receive option, indicating you want the
MultiPASS to ring for incoming fax calls, you specify the number of
times the MultiPASS should ring for the fax call. The MultiPASS will
only ring if you have connected a telephone.

Receive Conditions
You can specify how the system should handle an incoming fax under
the following conditions.

❍ If your computer is turned off:
You set the MultiPASS to print the fax (Print Fax) or save the fax in
its memory (Save in Memory).

❍ If your computer is turned on:
You set the MultiPASS to move the fax to the Desktop Manager on
your computer (Upload Fax), or to print the fax (Print Fax).

Report Print
You can specify whether or not you want a report to print with each fax
reception, or only when there is an error.

Restoring the Default Settings
If you want to restore the option default settings after making changes,
click Use Defaults.
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Setting Up Advanced Receive Fax Options
To change the following Advanced Receive Send Fax options, click
Advanced on the Receive Fax tab. You see this dialog box:

Speed
You can set the transmission speed used to receive faxes. The higher the
setting, the faster the fax is received. If you experience problems when
receiving faxes, try a lower speed setting.

Error Correction (ECM)
You can select this option to reduce system and line errors when
receiving a fax. With this option selected, the system checks each
incoming fax for lost data. If data has been lost from a portion of a page,
the system receives that portion again after confirming that all data
within that portion can be received successfully.

Ink/Toner Saver Mode
You can select this option if you want to print documents in the
Desktop Manager using a reduced amount of ink, thereby saving ink.
When using this option, the printed document may appear to be less
bright or contrasted.
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Fax/Telephone Switching Options
You set the options if your Receive mode is Fax/Tel switching.

Listen Time Before Ringing
When a call is received, the MultiPASS checks to see if the call is from a
fax machine or a telephone. If the MultiPASS does not have enough time
to detect the fax tone, it assumes the call is from a telephone. You use
this option to set the appropriate amount of time to allow the
MultiPASS to check for the type of call.

Ring Time
When your MultiPASS is set to receive both fax and telephone calls, it
rings to inform you of an incoming telephone call. If you do not pick up
the telephone within a certain amount of time, the MultiPASS stops
ringing. You use this option to set the appropriate amount of time the
MultiPASS should ring.

Ring Tone
You can set the volume level of the ring tone.

Default Action If No Answer to Telephone
You set this option to Receive if you want the MultiPASS to handle an
incoming call, detected as a telephone call that is not answered, as an
incoming fax. If no fax is received, the line is then disconnected. If you
set this option to Disconnect, the MultiPASS automatically disconnects
the unanswered call, without trying to receive a fax.

Answering Machine Mode Options
You use this option only if you set the Receive mode on the Receive Fax
tab to answering machine mode, and your fax sender may be using a fax
machine that does not emit a send fax signal.

Receive Fax If No Signal
Select this option to have the MultiPASS automatically receive a call as a
fax call if a send fax signal is not detected for the number of seconds you
specify. Clear this option to have the MultiPASS remain in answering
machine mode even if no send fax signal is detected. If no sound is
detected by the MultiPASS (such as the caller speaking to leave a
message), the answering machine disconnects.

Silent Period
Set the number of seconds you want the MultiPASS to check for a send
fax signal.
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Remote Receive
You select this option so that you can receive a fax by pressing an ID
code on the telephone attached to the MultiPASS. If you select this
option, you must assign a remote identification number that signals the
MultiPASS to receive the fax.

Remote Identification Number
If you enable the Remote Receive option, you assign the identification
number you will use to set the MultiPASS to receive a fax. The default
number is 25.

DRPD Switch Options
You can select this option if you subscribe to the Distinctive Ring
Pattern Detection (DRPD) service through your phone company. You
then specify each ring pattern you have been assigned, with its associated
action, fax ID, and fax number.

When you select this option, the Receive mode is automatically set to
receive both fax and telephone calls.

Ring Pattern
If you subscribe to DRPD through your phone company, select the ring
pattern assigned to each phone number by your phone company:
Normal (single-ring), Double (double-ring), S-S-L (short-short-long
ring), S-L-S (short-long-short ring), or Other.

Action
If you subscribe to DRPD through your phone company, select the type
of call to be received for each selected ring pattern. Typically, you would
specify telephone calls for one ring pattern and fax calls for the other
ring pattern. However, if necessary, you can specify that a selected ring
pattern switch between receiving telephone and fax calls.

Fax ID
If you subscribe to DRPD through your phone company, enter your
name or company name (or some other fax recipient identification) for
each selected ring pattern. This information is transmitted to the caller’s
fax machine and displayed in the caller’s LCD as verification.

Fax Number
If you subscribe to DRPD through your phone company, enter the
phone number assigned for receiving a call for each ring pattern. This
information is transmitted to the caller’s fax machine and displayed in
the caller’s LCD as verification.
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Setting Up Speed Dial Assignments
On the Speed Dial tab, you can set up fax numbers for speed dialing
with the MultiPASS. You use the fax recipients set up in your Address
Book, assigning the desired individual to speed dial codes. If the
recipient has not yet been set up in the Address Book, you can add the
recipient while creating speed dial assignments. You can also set up a
group speed dial, by assigning two or more individuals to a single speed
dial assignment.

For reference, you can print the list of speed dial assignments to display
near the MultiPASS.

Assigning an Individual to a Speed Dial Code
This section provides instructions for assigning a single recipient to a
speed dial code.

1. In the Address Book list box, click on the recipient that you want to
assign to a speed dial code.

2. Select the speed dial code to which you want to assign the recipient,
and click Add.
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To remove a recipient from a speed dial code, select the speed dial
assignment, and then click Remove.

To print the speed dial assignment list, click Print List. Because of the
list columns width, the first and last names of an address book entry
may not fully display.

To add a recipient to the Address Book, click New. In the New Individual
Entry dialog box, complete the appropriate information for the recipient
and then click Add. For detailed instructions on completing the New
Individual Entry dialog box, see Adding and Editing an Individual
Address on page 3-14.

Defining a Group Speed Dial Code
This section provides instructions for assigning two or more recipients
to a speed dial code.

1. On the Speed Dial tab, make sure the desired recipients for your
group are set up as individual speed dial assignments.

2. Select the speed dial code to which you want to assign the group of
recipients, and click Group Dial.

3. In the Group Name box, enter a name for the group assignment.
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4. In the Speed Dial list box, select the first recipient and click Add.
Repeat this procedure until the desired recipients are included in the
Members list box.

• To remove a member from the group, select the member in the
Members list box and click Remove.

• When all the desired members are listed in the Members list
box, click OK to save your group.

• To close the dialog box without saving your group, click Cancel.

System Setup
You can set up various system settings using the System Setup dialog box.

Choose the System Setup command from the Setup menu.

You see the System Setup dialog box:
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Include Annotations On
You can specify on what documents you want to display or hide
document annotations—on Printed Pages, E-mail Attachments, Files
Exported to Windows, or Send Fax Image. To enable the option (and
show annotations), click the applicable checkbox.

E-Mail Attachments
You can specify the format you wish to use for color and monochrome
document e-mail attachments—BMP, FPX, JPG PCX, or TIF. To make a
selection, click the applicable button.

Document Deletion
Click the “Confirm before Deleting” checkbox to display a confirmation
message before deleting a document.

Other
Click “Automatic Indexing” to allow for automatic indexing.

After making your settings, click OK.

Launcher Setup
You can change the contents of the Launcher using the Launcher
Properties dialog box. Choose the Launcher Setup command from the
Setup menu.

You see the Launcher Setup screen:
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1. Click the next Empty location, then click Edit; or click a blank
launcher icon, click the right mouse button, and click Edit.

2. Click Browse. A standard Windows Browse dialog box displays.

3. Locate the .EXE file you wish to add to the Launcher, highlight it,
and click Open.

4. Select a File Type (Conversion) option from the File Type list. This
allows you to start an application by dragging and dropping a
document onto the Launcher Bar application and have the
document converted into the specified format. You can specify that
documents be converted to:

• Bitmap (*.bmp)

• Flashpix (*.fpx)

• JPEG (*.jpg)

• PC Paintbrush (*.pcx)

• TIFF (*.tif)

• Plain text (*.txt)

5. Click OK to close the Edit Launcher Items dialog box.

6. Click OK to close the Launcher Setup dialog box and add the
program to the Launcher bar.

N You can also drag and drop an .EXE file from the Windows desktop or
Windows Explorer onto an empty Launcher spot, then edit the
application’s properties as desired.
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Editing a Launcher Application
1. Choose the Launcher Setup command from the Setup menu.

2. Click the desired application, then click Edit.

• Change the assigned Program file or file type as desired and
click OK.

• To re-arrange the order of Launcher items, highlight an
application, then use the Move Up or Move Down buttons.

• To delete an item, highlight it and click Delete .

3. Click OK to close the Launcher Properties dialog box.

You can also click the right mouse button on a launcher icon, then click
Edit to edit a launcher application or Delete to delete the icon.

Using the Launcher
You can use the Launcher in one of two ways:

❍ Click an application to start it.

❍ Drag and drop a document onto an application to start the
application and display the document in the specified file format.

When you launch a document, a copy of the document is displayed in
the application with a system assigned name. If you save the document,
it is saved with the system assigned name in your C:\Windows\Temp
directory. If you want to give the document a more meaningful name,
use the Save As command. Any modifications made to the document are
made to the copy, and not the original document stored in the Desktop
Manager.
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Making a Phone Call From the Desktop
Manager

You can use the MultiPASS and Desktop Manager to dial telephone 
calls if:

❍ You have a telephone attached to the MultiPASS 

❍ You selected the “Telephone Attached to Unit” option on the
Preferences tab in the Setup Options dialog box in the Desktop
Manager.

You can place a call to any individual you want, whether or not the
individual has been set up in the Address Book. At the time you are
attempting to make your call, you can also set up an individual in the
Address Book.

Placing a Phone Call
1. Choose the Phone command from the File menu or toolbar.

2. In the Phone dialog box, enter the phone number you want to call,
or select an Address Book entry.

When you enter the phone number, you use the applicable numeric
characters and any valid characters that separate the different
segments of the phone number. For example, you can use 0 through
9, dash (-), or parentheses (). Other characters are also available for
entering a phone number. For a complete list of the characters that
are valid in the Desktop Manager, refer to Appendix B.
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3. To add an individual to the Address Book, click New Individual and
complete the Individual Entry dialog box. For details on completing
the Individual Entry dialog box, see Adding and Editing an
Individual Address on page 3-14.

4. With the phone number entered or selected, click Dial.

5. When the Dialing Phone dialog box displays, you are prompted to
pick up the handset.

6. When you have completed your call, click Exit.

Using the MultiPASS Server
The MultiPASS Server is a utility that tracks the current status of the
MultiPASS, incoming and outgoing faxes, print and scan jobs, and any
error conditions needing your attention. When you install the
MultiPASS Desktop Manager, the MultiPASS Server is placed in the
Windows Startup menu. Therefore, the MultiPASS Server starts each
time you start up Windows.

The MultiPASS Server displays as an icon in the notification area of the
Windows taskbar or as a window. In either case, the MultiPASS Server
alternates the status message shown for more than one activity occurring
at the same time. For example, if the sending of a fax and an out-of-
paper error condition occur at the same, the MultiPASS Server alternates
the display of the corresponding messages.
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If you close the MultiPASS Server, you can open it from the Windows
desktop:

❍ From the Windows desktop, click Start, point to Programs, then
point to MultiPASS Desktop Manager 3.0, and click MultiPASS
Server.

From the Desktop Manager, choose the MultiPASS Server command
from the Tools menu to open the MultiPASS Server window.

Using the Minimized MultiPASS Server 
The minimized MultiPASS Server appears as an icon in the notification
area of the Windows taskbar.

The graphical appearance of the icon depicts the type of activity it is
reporting. For example, the scan graphic is used to depict the status of
scan activity.

Click the right mouse button on the icon to display a menu allowing you
to open the MultiPASS Server window, open the Desktop Manager,
specify that the icon always be on top, display device information, and
close the MultiPASS Server.

To open the MultiPASS Server window from the icon, click Restore on
the MultiPASS Server menu.

To open the Desktop Manager from the MultiPASS Server icon, click Go
To Manager on the MultiPASS Server menu.

To keep the icon on top, click Always On Top. To display information
about the MultiPASS, click on Device Information.

To close the MultiPASS Server, click Close on the MultiPASS Server
menu.

Using the MultiPASS Server Window
The MultiPASS Server window displays the status of MultiPASS activity
only. You cannot use the MultiPASS Server to interrupt an activity.
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The MultiPASS Server window contains commands that enable you to:
open the Desktop Manager, specify the MultiPASS Server as the top
window at all times, display device information, close the window and
return to the minimized MultiPASS Server, and close the MultiPASS
Server.

To open the menu on the MultiPASS Server window, click the right
mouse button in the MultiPASS Server window.

To open the Desktop Manager, click Go To Manager on the menu. Or,
click the Manager (M) in the window title bar.

To specify the MultiPASS Server as the top window, click Always On Top
on the displayed menu.

To display information about the MultiPASS, click on Device
Information.

To return to the MultiPASS Server icon, click Minimize on the
MultiPASS Server menu. Or, in the window title bar, click the Minimize
button (–).

To close the MultiPASS Server, click the Close button in the window 
title bar.

Status Messages
The MultiPASS Server reports the following statuses for the MultiPASS.

Idle
The MultiPASS is currently inactive.

Scanning
The MultiPASS is scanning an image. The MultiPASS Server window
displays the number of the page currently being scanned.

Printing
The MultiPASS is printing a document.

Sending Fax
The MultiPASS is sending a fax document. The MultiPASS Server
window displays the number of the page currently being faxed.

Receiving Fax
The MultiPASS is receiving a fax document. The MultiPASS Server
window displays the number of the page currently being received.
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Attention Needed
The MultiPASS needs your attention for situations such as the
MultiPASS being out of paper. The MultiPASS Server window describes
the nature of the attention required.

When you have corrected the situation, the status message automatically
clears.

Error Warning
The MultiPASS has a problem that needs your immediate attention, such
as when the MultiPASS Server can no longer detect the MultiPASS. The
MultiPASS Server window displays the nature of the problem with a
comment indicating a corrective action.

When you have corrected the situation, the status message automatically
clears.

Closing the MultiPASS Server
If you decide you need to disconnect the MultiPASS from the designated
port and/or attach another device to the port, you should close the
MultiPASS Server first. If you close the MultiPASS Server first, you avoid
receiving error messages when the MultiPASS Server detects it can no
longer communicate with the MultiPASS.

When you start the Desktop Manager again at a later time, the
MultiPASS Server is automatically reopened if your MultiPASS has been
reconnected to the port. You can also open the MultiPASS Server from
the Windows desktop without opening the Desktop Manager.

If you are closing the MultiPASS Server, you may want to set the
MultiPASS to print any received faxes (see page 8-7 for details on setting
Receive Conditions). With the MultiPASS Server closed, received faxes
cannot be moved to the Desktop Manager.

Received faxes can be stored in memory on the MultiPASS. However, if
the memory becomes full, the MultiPASS is unable to receive more faxes
until you print the faxes stored in memory.

Before closing the MultiPASS Server, close the MultiPASS Desktop
Manager. Then, in the notification area of the Windows taskbar, click the
right mouse button on the MultiPASS Server icon and click Close.
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Removing the MultiPASS Server From StartUp
Closing the MultiPASS Server does not remove it from the Windows
StartUp group. If you have disconnected your MultiPASS, the next time
you start Windows, the MultiPASS Server will try to open. At that time,
the MultiPASS Server will be unable to detect the device and it will
display an error message.

When you close the message dialog box, the MultiPASS Server closes
automatically, because it cannot detect the MultiPASS unit. Your port
remains available for you to use with other devices.

However, if you would like to prevent the message from displaying each
time you start Windows, you can remove the MultiPASS Server from the
StartUp group.

The following instructions summarize the procedures for removing a
program from Windows StartUp. For more details, refer to your
Windows user documentation.

1. On the Windows desktop, click the right mouse button on Start.

2. On the displayed menu, click Open.

3. In the Start Menu window, double click the Programs icon.

4. In the Programs window, double-click the StartUp icon.

5. In the StartUp window, click the MultiPASS Server icon and press
the Delete key.

Restarting the MultiPASS Server
If you reconnect the MultiPASS to the port and want to begin using the
Desktop Manager again, the MultiPASS Server is restarted automatically
when you open the Desktop Manager. You can also open the MultiPASS
Server without opening the Desktop Manager.

1. On the Windows desktop, click Start and then point to Programs.

2. On the Programs menu, point to Canon MultiPASS Desktop
Manager 3.0, then click Canon MultiPASS Server.

The MultiPASS Server starts automatically.
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Adding the MultiPASS Server to StartUp
When you reconnect your MultiPASS printer device, you will probably
want to add the MultiPASS Server to the StartUp group again (if you
removed it as described earlier). With the MultiPASS Server in StartUp,
the MultiPASS Server automatically opens when Windows is started.

The following instructions summarize the procedures for adding a
program to Windows StartUp. For more details, refer to your Windows
user documentation.

1. Open Windows Explorer.

2. Display the contents of the C:\Program Files\Canon\
MultiPASS directory and click the right mouse button on
MONITR32.EXE.

3. In the displayed menu, click Create Shortcut (a shortcut item
appears).

4. Click the plus (+) signs next to the Windows folder, the Start Menu
folder, and then the Programs folder.

5. Drag the shortcut item (created in Step 3) to the StartUp folder.

The MultiPASS Server will automatically be started when you start
Windows.

Disconnecting the MultiPASS
You can disconnect the MultiPASS if you want to use the parallel port
for another purpose. Before disconnecting your unit, be sure to close the
MultiPASS Server.

1. Turn off your computer.

2. Unplug your computer from all electrical sources.

3. Unplug the MultiPASS from all electrical sources.

4. On the back of your computer, remove the cable connector from the
parallel printer port.

5. On the MultiPASS, release the wire clips and remove the cable
connector from the port.

6. Plug your computer back in to the electrical source.
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Uninstalling the MultiPASS Software
If you are planning on reinstalling the MultiPASS Desktop Manager, you
must first uninstall the current installation of the software. When you
uninstall the software, you remove the MultiPASS Desktop Manager and
related printer, fax, and scanner drivers. The following items are not
removed, so that you can reinstall the MultiPASS Desktop Manager at a
later time and continue to use your data files, address book, cover page
templates, search keys and so on:

❍ MultiPASS directory

❍ Data folders and files (such as Fax Log and Address Book)

❍ System files shared with other applications

When uninstalling, you remove the MultiPASS printer and fax drivers,
and the Desktop Manager software.

Removing the Printer and Fax Drivers
1. From the Windows desktop, click Start, and then point to Settings.

2. On the Settings menu, click Printers.

3. In the Printers dialog box, click the Canon MultiPASS Printer icon
and press the Delete key.

• Repeat this step for the Canon MultiPASS Fax icon.

Uninstalling the Desktop Manager
1. Close the MultiPASS Desktop Manager and all MultiPASS-related

utilities (such as the Cover Page Designer).

2. Close the MultiPASS Server. (See page 8-23 for details.)

3. From the Windows desktop, click Start, point to Settings, and
choose Control Panel.

4. Double-click the Add/Remove Programs option.
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5. Highlight Canon MultiPASS Desktop Manager 3.0 and click the
Add/Remove button.

6. Follow the on-screen instructions.

Uninstalling the Scan Software (ScanGear)
1. Click Start, and then point to Settings.

2. On the Settings menu, click Control Panel.

3. In Control Panel, double-click Add/Remove Programs.

4. In Add/Remove Programs Properties dialog box, click Canon
ScanGear for MultiPASS 4.0, and then click the Add/Remove
button.

5. Follow the on-screen instructions.

Completing the Uninstall Process
Once you have deleted the drivers, the Desktop Manager, and the scan
software, be sure to restart the computer.

Reinstalling the Desktop Manager
When you want to reinstall the MultiPASS Desktop Manager, see your
Quick Start Guide for details.

N Be sure to restart your computer after uninstalling the Desktop Manager
and before reinstalling.
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This chapter describes the routine maintenance required for your
MultiPASS C5500. It includes:

❍ MultiPASS guidelines

❍ Routine maintenance

❍ Cleaning inside the MultiPASS 

❍ Printing the nozzle check

❍ Cleaning the BJ cartridge print head

❍ BJ cartridge guidelines

❍ Replacing the BJ cartridge

❍ Replacing a BJ tank in the BC-21e Color BJ Cartridge

❍ Storing a BJ cartridge

❍ Transporting the MultiPASS 

9Maintaining the
MultiPASS C5500
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MultiPASS Guidelines
Follow these guidelines to avoid damage to your MultiPASS and harm to
you or others:

❍ Place the MultiPASS on a stable surface. Do not use an angled stand.
Avoid setting the unit in direct sunlight.

❍ Do not install the MultiPASS near devices that contain magnets or
generate magnetic fields, such as speakers.

❍ Do not subject the MultiPASS to strong physical shock or vibration.

❍ Make sure the area where you use the unit is free from dust.

❍ Keep the MultiPASS clean. Dust accumulation can prevent the unit
from operating properly.

❍ To assure proper electrical contact, make sure the unit is firmly
plugged in.

❍ Never pull on the cord to unplug the MultiPASS. Pull on the plug
itself.

❍ Do not overload the electrical outlet where the MultiPASS is plugged
in.

❍ For your safety, unplug the MultiPASS during electrical storms.

❍ Lift the MultiPASS from the bottom only. Do not lift the unit by the
operator panel or any of its trays.

GRIP HERE
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Routine Maintenance
Your MultiPASS requires little routine maintenance. Follow these
guidelines to keep your MultiPASS in good operating condition:

❍ Before you clean the MultiPASS, be sure to print any faxes stored in
memory.

❍ Do not use tissue paper, paper towels, or similar materials for
cleaning; they can stick to the components or generate static charges.

❍ Be sure to disconnect the power cord before cleaning the unit.

❍ Lightly wipe the unit’s exterior with a clean, soft, lint-free cloth
moistened with water or diluted dishwashing detergent solution.

❍ Never use thinner, benzene, alcohol or any other organic solvent, as
it may damage the surface of the MultiPASS.

Cleaning Inside the MultiPASS
To prevent ink spots and paper dust from accumulating inside the
MultiPASS and affecting print quality, clean the unit’s print 
area periodically. Follow these guidelines:

❍ Never use volatile liquids such as thinners, benzene, acetone,
or any other chemical cleaner to clean the interior of the 
MultiPASS, or you can damage its components.

❍ Avoid touching the print head or ribbon cable inside the 
MultiPASS.

Chapter 9 Maintaining the MultiPASS C5500 9-3
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❍ Disconnect the power cord from the MultiPASS before cleaning.

❍ Open the printer cover by grasping the paper guides and lifting.

❍ Use a clean, soft, dry, lint-free cloth to remove any ink or paper
debris from the printer’s interior, especially around the platen.
Make sure not to touch the cartridge.

❍ Check the small black rollers. If they are dirty, clean them with a
soft, dry cloth.

❍ When finished, close the printer cover, and plug the MultiPASS back
in.

Cleaning the Scanner Components
Periodically check and clean the scanning components as explained here.
Be sure to disconnect the power cord from the MultiPASS.

Open the 
operator panel 

by gently pulling
it toward you.
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❍ Separation guide
Wipe with a dry, soft cloth.

❍ White sheet and scanning glass
Use a clean, soft, lint-free cloth moistened with water to
clean the white sheet and scanning glass, then wipe them
with a soft, dry, lint-free cloth.

❍ Separation roller
Wipe with a soft, dry clean cloth to clean the rollers.

N If the scanning components are dirty, the documents you send or print
will also be dirty.

Be sure to use a soft cloth to avoid scratching the components.

C Do not use tissue paper. Dust from the tissue paper causes static
electricity.

Clean the
components.
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❍ Dirt and dust particles that collect on the underside of
the operation panel also affect the quality of the
documents you copy or send.

❍ Use a soft, dry, clean cloth to wipe up paper dust around
the rollers.

❍ Press the center of the operator panel until it locks into
place.

❍ Plug the unit back in.

When you are
finished, close the

operator panel.

Clean the shaded
areas of the

operator panel
and the unit.
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Printing the Nozzle Check
Use this test print to check that each print head nozzle is operating
properly.

Make sure the MultiPASS is plugged in.

The pattern starts printing.

When the BC-21e Color BJ Cartridge is installed, the pattern includes all
four colors: yellow, magenta, cyan, and black. In the color pattern, you’ll
notice that lines are missing between the colors. This is normal.

The following sample shows the Nozzle Check when the optional BC-20
Black BJ Cartridge is installed.

Press 
START/COPY.

NOZZLE CHECK
Press either of the
< > buttons until

NOZZLE CHECK
appears in the LCD.

FUNCTION
Press FUNCTION.

Chapter 9 Maintaining the MultiPASS C5500 9-7
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Cleaning the BJ Cartridge Print Head
To maintain the best possible print quality, you need to clean the 
BJ cartridge print head from time to time. Your MultiPASS is 
equipped with a print head cleaning function. If you notice some
degradation in the print quality, try cleaning the print head.

C Cleaning the print head consumes a small amount of ink. Cleaning too
often reduces the amount of ink in the BJ cartridge.

❍ Make sure the MultiPASS is plugged in.

The unit cleans the print head.

❍ When cleaning ends, the MultiPASS beeps once to let you
know it is done, and returns to Standby mode.

❍ Do this five consecutive times if necessary.

❍ If the problem persists, install a new BJ cartridge.

Press START/COPY.

HEAD CLEANING
Press the < or >

button until
HEAD CLEANING

appears in the
LCD display.

FUNCTION

Press FUNCTION.



Chapter 9 Maintaining the MultiPASS C5500 9-9

BJ Cartridge Guidelines
You can use these cartridges with the MultiPASS:

❍ BC-21e Color BJ Cartridge
Contains the print head unit and two replaceable 
BJ tanks, one color (cyan, magenta, yellow) and 
one black. You can replace the BJ tanks without 
replacing the print head unit when you run out of
ink.

❍ BC-20 Black BJ Cartridge
Contains the print head unit and black ink only. Use
this optional cartridge when you will be printing
with black ink only and for fast, five page per minute
printing. When you run out of ink, you replace the
complete cartridge.

❍ BC-22e Photo BJ Cartridge
Contains the print head unit and color and black 
inks. Use this optional cartridge when you want to
produce photo-realistic color printing. When used
with Canon’s High Resolution Paper (HR-101), this
ink produces images comparable to your favorite
photographs. When you run out of ink, you replace the complete
cartridge.

❍ BC-29F Neon BJ Cartridge
Contains the print head unit and neon color and black inks. Use this
optional cartridge when you want to add hot new colors to
everything from your business graphs to stickers for your kids.
These amazing, bright fluorescent colors make your pictures, graphs,
and fun images really stand out. When you run out of ink, you
replace the complete cartridge.
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BJ Cartridge and BJ Tank Maintenance
The most important thing you can do to extend the life of your 
MultiPASS and to ensure optimum print quality is take 
care of the BJ cartridges.

C Spilled ink can stain any surface. Open BJ cartridges and BJ tanks
carefully, and follow the guidelines presented here to protect against
spilled ink.

❍ If you are using both the BC-21e Color BJ Cartridge and any of the
optional BJ cartridges, make sure you store the cartridge not being
used in the Ink Cartridge Storage Box.

❍ Keep BJ cartridges and BJ tanks in their sealed containers until you
are ready to use them.

❍ Do not remove the BJ tanks from the BC-21e Color BJ Cartridge
unnecessarily. This may cause the ink to clog.

❍ Make sure both BJ tanks are installed in the BC-21e Color 
BJ Cartridge. Attempting to use the BC-21e Color BJ Cartridge 
with one BJ tank only may cause ink clogging.

❍ If spilled, the ink is difficult to remove. Therefore, it’s a good idea to
keep the BJ cartridges and BJ tanks out of the reach of children.

❍ Do not touch the print head area on the BJ cartridge. Ink may leak
out and cause stains.

C Hold the BJ cartridge on the sides only. Do not touch the silver plate on
the bottom of the BJ cartridge or the silver metal or circuit area on the
side. The metal area may become hot during printing.
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Using Ink
Canon has more engineers dedicated to creating quality ink for
providing the best results for output on Bubble Jet printers than any
other organization. Canon does not prohibit the use of third-party 
inks and the use of third-party inks does not invalidate the product’s
limited warranty. However, Canon cannot guarantee the quality or
performance of your printer when you are using inks from other
suppliers.

Canon’s limited warranty does not cover damage caused to Canon’s
Bubble Jet products that is attributable to the use of third party parts or
supplies, including inks. The limited warranty remains in effect for its
life once that particular damage has been properly repaired.

N For optimum printing results, Canon recommends that you use the
Canon BC-21e Color BJ Cartridge or the optional Canon BC-20 Black,
BC-22e Photo, and BC-29F Neon BJ Cartridges with your MultiPASS.

When replacing BJ tanks in the BC-21e Color BJ Cartridge, Canon
recommends that you use the Canon BCI-21 Color and BCI-21 Black 
BJ Tanks.

Replacing the BJ Cartridge
The actual amount of ink that you use will vary depending on the print
density of a page. If the majority of your output is graphics, you may
need to change cartridges or tanks more often than when you are
printing text only. See Appendix A, Specifications, for details on the life
expectancy of the BJ cartridges.

You may need to replace the BJ cartridge or a BJ tank when any of the
following conditions exist:

❍ You have been using the cartridge for over one year.

❍ Your printed output is not crisp and clear, and there are gaps in the
characters (missing dots) even after you have cleaned the print head
at least five times.

❍ You see the CHANGE CARTRIDGE message in the LCD.

Chapter 9 Maintaining the MultiPASS C5500 9-11



If you are using the BC-21e Color BJ Cartridge and your output is
blank, one of the BJ tanks is probably out of ink. See the instructions
starting on page 9-16 for replacing a BJ tank.

The following procedure describes how to replace the BC-21e Color 
BJ Cartridge with the optional BC-20 Black BJ Cartridge. Follow the
instructions in this section to replace an old BJ cartridge or to change 
BJ cartridges when you are switching between the BC-21e and any of the
optional BJ cartridges.

You only need to replace the BC-21e Color BJ Cartridge when the print
head is damaged (or after printing approximately 2000 pages). If one of
the BJ tanks (either color or black) in your BC-21e Color BJ Cartridge is
out of ink, see the next section (page 9-16) for instructions on how to
replace a BJ tank.

To replace the BJ cartridge, follow these steps:

The cartridge holder moves to the center
of the unit.

❍ Grasp both sides and lift it up.Open the
printer cover.

Press the
CARTRIDGE

button.
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C Do not try to move the cartridge holder manually; this may damage the
unit. If the cartridge holder does not move and the unit beeps several
times, unplug the MultiPASS C5500 and let it cool for several minutes.
(The device has an automatic protection mode that prevents it from
overheating.) After allowing it to cool, plug the unit in again and press
the CARTRIDGE button to move the cartridge holder to the center of
the unit.

Hold the BJ cartridge on the sides only. Do not touch the silver plate on
the bottom of the BJ cartridge or the silver metal or circuit area on the
side. The metal area may become hot during printing.

❍ Gently pull up on it.

❍ Dispose of the old BJ cartridge, or store it in the 
Ink Cartridge Storage Box.

Dispose of 
or store the 

BJ cartridge.

Lift the green 
lock lever on the
cartridge holder.
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❍ Peel the protective foil off the new BJ cartridge’s
packaging, and remove the cartridge.

❍ Carefully lift off the orange cap from the cartridge’s 
print head; then remove the orange tape. Remember 
that spilled ink can stain any surface; protect yourself
and your work area.

❍ Make sure the cartridge label faces you.

❍ Be careful not to touch the silver plate on the bottom 
of the BJ cartridge or the silver metal or circuit area on
the side.

Slide the
BJ cartridge

straight into the
cartridge holder. 

Remove the
protective

material
from the

BJ cartridge.

Open the
BJ cartridge

package.

CAP TAPE
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❍ The BJ cartridge locks into position.

❍ Do not apply excessive force.

The MultiPASS cleans the print head and
moves the cartridge holder to the home
position on the right side of the unit.

N Be sure to set the paper thickness lever for the type of BJ cartridge you
installed. See page 2-16 for details.

When exchanging one cartridge type for another (such as replacing a
BC-21e with a BC-20), be sure to select the appropriate Color Model in
the Graphics tab of the MultiPASS Printer Properties prior to printing
from a Windows application.

Close the 
printer cover, 
and press the

CARTRIDGE
button.

Make sure the
cartridge is

aligned against
the back of the

holder, then 
lower the green

lock lever.
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Replacing a BJ Tank in the BC-21e Color 
BJ Cartridge

If you perform a print operation correctly but the output is blank,
portions are missing, or colors are very wrong, a BJ tank may be out 
of ink. If the output is still blank after cleaning the print head at least
five consecutive times, replace the empty BJ tank in the BC-21e Color 
BJ cartridge.

You leave the BJ cartridge in the MultiPASS when replacing a BJ tank.

The cartridge holder then moves to the
center of the unit.

❍ Grasp both sides and lift it up.

C Do not try to move the cartridge holder manually, or you may damage
the unit. If the cartridge holder does not move and the unit beeps 
several times, unplug the MultiPASS and let it cool for several minutes.
(The device has an automatic protection mode that prevents it from
overheating.) After allowing it to cool, plug the unit in again and press
the CARTRIDGE button to move the cartridge holder to the center of the
unit.

Open the
printer cover.

Press the
CARTRIDGE

button.
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❍ The color BJ tank is on the left; the black BJ tank is on the
right.

❍ Grasp the tab on the top of the tank and pull forward to
release the BJ tank.

❍ Then lift the BJ tank up and out of the BJ cartridge unit.

❍ Dispose of the BJ tank properly. You may want to place it
in a plastic bag to keep from spilling any residual ink.

❍ Remove the orange protective cap.

❍ Do not touch the bottom of the BJ tank; you may get ink
on your hands.

Take the new 
BJ tank out of 
its packaging.

Remove the 
empty BJ tank.
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❍ If you are replacing both tanks, repeat steps 3 through 6
for the other BJ tank.

❍ Make sure each tank is properly seated in its slot.

The cartridge holder then moves to the
home position on the right side of
the unit.

N Before you unplug the MultiPASS, make sure the BJ cartridge is in the
home position on the right side. If you unplug the unit while it is
printing, or move the BJ cartridge from the home position, the cartridge
will not be capped and may dry out.

Close the printer
cover, and press
the CARTRIDGE

button.

Press firmly on
the tab on top of
the new BJ tank

until it snaps 
into place.

Slide the new 
BJ tank into 

the empty slot.
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Storing a BJ Cartridge
Whenever you unwrap a BJ cartridge, you must either install it in the
MultiPASS or store it in the Ink Cartridge Storage Box to prevent the
print head from drying and clogging.

❍ When opening the Ink Cartridge Storage Box, press in on
the release tab that locks the cover in place.

❍ You must insert the cartridge correctly or the storage box
will not close.

❍ The protective cap must be removed from the cartridge
before you set it in the storage box.

❍ Be sure the lid snaps closed.Close the 
storage box.

Carefully set 
the cartridge in
the storage box.

Open the 
Ink Cartridge
Storage Box.
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N Whenever you remove a BJ cartridge from the MultiPASS, store the
cartridge in the storage box (unless you are disposing it).

If you have more than one Ink Cartridge Storage Box, you can hook
them together. Simply connect them by the slides and grooves on the
sides of the containers.

Transporting the MultiPASS
If you need to transport the MultiPASS, be very careful. DO NOT
remove the BJ cartridge.

❍ With the cartridge holder on the right side of the unit,
tape the BJ cartridge and cartridge holder to the side of
the unit.

❍ Unplug the power cord.

❍ Disconnect the telephone lines and parallel cable.

❍ Remove the sending document support.

❍ Remove the document support and output tray extension.

Lower the paper
rest and remove

all trays.

Disconnect 
all cables.

Make sure the 
BJ cartridge is in

the home position.
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❍ Carefully pack the unit in its original packing materials.

❍ Do not remove the BJ cartridge from the MultiPASS or
ship a BJ cartridge or a BJ tank from which you have
removed the protective cap. An opened BJ cartridge or 
BJ tank that is not installed in the MultiPASS or the Ink
Cartridge Storage Box may leak, and the print head may
dry out. Also, if you do not tape the BJ cartridge to the
side of the unit, ink may spill into the MultiPASS.

N If you no longer have the shipping carton your MultiPASS came in, pack
the unit in a suitably sized, sturdy cardboard box, using bubble wrap,
foam peanuts, or other suitable packing materials. (If you use foam
peanuts, be sure to wrap the unit in plastic first to prevent the packing
materials from entering any openings in the unit.)

Pack the unit.
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This chapter contains information to help you solve problems you may
have when using the MultiPASS C5500. It includes:

❍ Paper jams

❍ LCD messages

❍ Printing problems

❍ Print quality problems

❍ Color printing and copying problems

❍ Paper feeding problems

❍ Faxing problems

❍ Telephone problems

❍ Copying problems

❍ General problems

❍ Technical notes

❍ Memory Clear Report

If you have a problem with your MultiPASS C5500 and you cannot
resolve it by referring to the information in this chapter, contact the
Canon Computer Systems Customer Care Center. See page 1-4 for
details.

Canon’s support personnel are trained in the technical support of
Canon’s products and should be able to help you with your problem. If
your printer requires service, they can provide you with the telephone
number of your local Canon Authorized Service Facility (ASF).

N Attempting to repair the MultiPASS yourself may void the limited
warranty as to that repair. See the limited warranty card for details.

Chapter 10 Troubleshooting 10-1
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If you need to contact Canon directly, make sure you have the following
information:

❍ Product name—MultiPASS C5500

❍ Serial number

❍ MultiPASS Desktop Manager version number

❍ Place of purchase

❍ Nature of problem

❍ Steps you have taken to solve the problem and the results

The serial number is located on the label on the back of the unit:

The version number of MultiPASS Desktop Manager is included in the
About information. In the Desktop Manager, click Help and then click
About.
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Paper Jams
On occasion, the document feeding into the MultiPASS or the paper in
its sheet feeder may misfeed or jam. You can usually clear the problem
easily.

N You need not unplug the MultiPASS to clear paper jams.

Jams in the Automatic Document Feeder (ADF)

Stops the operation.

❍ Gently pull the operator panel toward you.

❍ It opens only slightly.

Open the 
operator panel.

Press STOP.

CHECK DOCUMENT

Chapter 10 Troubleshooting 10-3



❍ While holding the operator panel open, remove the
document.

❍ Pull it in either direction, but DO NOT force it.

❍ If a multipage document is loaded, remove the entire
document from the ADF.

❍ Gently press the operator panel until it clicks closed.

❍ Fan and stack the sheets, and replace the stack in the ADF.

❍ Start your operation again.

Close the 
operator panel.

Remove the
document.
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Jams in the Sheet Feeder

❍ Fan the paper, and tap it on a flat surface to even out 
the stack.

❍ Reinsert the paper into the sheet feeder. Make sure you
adjust the paper guide to the stack, and that the stack
does not exceed the limit mark.

This clears the error message.

❍ If the ALARM light is on, press RESUME to eject the page
and clear the error message.

❍ If you are printing from a Windows application, follow
any instructions displayed on your computer.

If the paper jam occurred while a fax was being received, the MultiPASS
will store the fax in memory and print it when the jam is cleared.

Press STOP 
or RESUME.

Remove the stack
of paper from the

sheet feeder.

Gently pull any
jammed paper out

of the unit.

CLEAR PAPER JAM
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LCD Messages
The following messages are displayed in the LCD when the 
MultiPASS is performing a function or encounters an error.
The Error Code appears on the Activity Report.

Message Error Code Cause Action
AUTO REDIAL — The MultiPASS is Wait for the MultiPASS

waiting to redial the to try redialing. If that
other party’s number doesn’t work, wait until
because the line was the MultiPASS starts to
busy or the other dial the number, then 
party did not answer press STOP to cancel
when you tried to send redialing. Try to send
the document. the document again at a

later time.

BUSY/NO SIGNAL #005/018 The telephone number Try sending the
you dialed is busy. document at a later

time.

The fax number dialed Check the fax number
was incorrect. and dial again.

The other party’s fax is Contact the other party
not working. and have them check

their fax.

The other party is not Contact the other party
using a G3 machine. and have them send or

receive the document
using a G3 machine.

The touch tone/rotary Set your MultiPASS
pulse setting on your to the setting that
MultiPASS is incorrect. matches your telephone

line (see page 8-4).

The receiving fax did Contact the other party
not answer within 35 and have them check
seconds. their fax. You can try to

send the document
manually. For an over-
seas call, add pauses to
the registered number.

CARTRIDGE JAMMED Cartridge holder cannot Clear the paper jam or
move. This is normally whatever is obstructing
due to a paper jam. the cartridge holder 

and then press STOP.
Do not attempt to 
move the cartridge
holder manually.
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Message Error Code Cause Action
CHANGE CARTRIDGE #052 The BJ cartridge is Replace the BJ cartridge.

empty or its ink has The unit will then 
dried out. print any documents

received in memory.

CHECK DOCUMENT #001 The document is Remove the document
jammed in the ADF. you are trying to send or

copy and start again.

CHECK PAPER SIZE The size of the paper Set the correct paper 
in the sheet feeder and size in the Receive Fax
that specified in the dialog box of the 
MultiPASS setup are Setup Options in the 
different. MultiPASS Desktop

Manager (see page 8-7).

The sheet feeder is Add paper to the sheet
empty or paper is feeder or check for a
jammed. jam. Then try to print

again.

There is a sheet of Make sure there is no
paper in the manual paper in the manual
feed slot. feed slot when you are

receiving a fax.

CHECK PRINTER — There may be an Check for a paper clip,
obstruction that is not paper jam, or the plastic
allowing the cartridge orange cap off the BJ
mechanism to move cartridge. Press STOP
right or left. and try your operation 

again.

The BJ cartridge may be Press STOP. Reinstall
defective. the cartridge and try

your operation again.

In either case, if the
error does not clear, try
unplugging the unit.
Wait several minutes,
then plug it back in.
Also, try installing a new
BJ cartridge.

CLEAR PAPER JAM — There is a paper jam Remove any paper from
or the sheet feeder is the sheet feeder. Clear
empty. the paper jam (see page

10-5). Then reload paper
in the sheet feeder. Press
RESUME or STOP.

COMMUNICATING — You tried to send a fax Wait until the fax is
PLEASE WAIT using Manual mode sent, or use memory

when the MultiPASS sending.
was already sending
a fax from memory.
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Message Error Code Cause Action
DIALING — The MultiPASS is Press STOP if you 

dialing the receiving want to cancel the 
fax machine. transmission.

DOC TOO LONG #003 It took more than 32 Divide the document 
minutes to send or and send or copy each 
copy a document. part separately.

It took more than 32 Contact the other party.
minutes to receive a Have them divide the
document. document and send 

each part separately.

The document is longer Use a copy machine to
than 39.4 inches (1 m). make a reduced copy of

the document and send
the copy.

DOCUMENT READY — The document in the Send the fax, scan the 
ADF is ready for faxing, document, or make the
scanning, or copying. copy.

ECM RX — The MultiPASS is ECM transmissions may
receiving a fax take longer than normal
using ECM. transmissions. Turn

off ECM if you need to
receive quickly, or if you
know your local lines
are in good condition.

ECM TX — The MultiPASS is ECM transmissions may
sending a fax using take longer than normal
ECM. transmissions. Turn off

ECM if you need to 
transmit quickly, or if
you know your local
lines are in good
condition.

HANG UP PHONE — The telephone is Place the telephone
off hook. properly into its cradle.

INSTALL BC-20/21 — The BC-22e or BC-29F Remove the BC-22e or 
BJ Cartridge is installed, BC-29F BJ Cartridge
so the MultiPASS cannot and install the BC-21e
print any received faxes, or BC-20 BJ Cartridge.
or make copies.

INSTALL BC-21 — The BC-20, BC-22e, Remove the BC-20,
or BC-29F BJ Cartridge BC-22e, or BC-29F 
is installed. BJ Cartridge and install

the BC-21e BJ Cartridge.

LOAD PAPER — The MultiPASS is out Load paper in the sheet
of paper (the sheet feeder. Make sure the
feeder is empty). stack does not exceed

the limit mark. Then 
press START/COPY.
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Message Error Code Cause Action
MEMORY FULL #037 The memory of the Print out any documents

MultiPASS is full that are stored in 
because it has received memory. Then start the 
too many documents, operation again.
or a very long or 
detailed document.

Memory is full because Divide the document 
you tried to send too and send each part 
many pages at once, separately.
or a very long or
detailed document.

MEMORY FULL — The MultiPASS is If sending a fax, the
PLEASE WAIT sending a fax and its MultiPASS continues to 

memory is full. send the fax as memory
becomes available.

MEMORY USED nn% — Shows the percentage of If you need more space,
memory currently in use. print or send any

documents in memory.

NO ANSWER #005 The receiving fax Make sure you dialed 
machine does not the correct number.
answer. Try again later.

NO RX PAPER #012 The other party’s fax is Contact the other party
out of paper or its and have them install
memory is full. paper in their fax.

NO TEL # #022 The one-touch or coded Register the number
speed dialing number (see page 3-14).
has not been registered.

NOT AVAILABLE NOW #025 In manual sending, you Use regular dialing.
entered a speed dialing
number that is assigned
to a group.

PHOTO INK USED — The BC-22e Photo BJ You must change this
Cartridge is installed cartridge to copy or
in the MultiPASS. receive a fax.

PLEASE WAIT — The MultiPASS is Wait until the date and
warming up. Receive Mode appear in

the LCD display, then
begin.

PUT IN CARTRIDGE — The BJ cartridge is Make sure the BJ 
not properly installed. cartridge is installed

correctly and the green
lock lever is down.

Tr
ou

bl
es

ho
ot

in
g



Message Error Code Cause Action
REC. PAPER JAM #009 The MultiPASS has no Add paper or clear the 

paper in its sheet feeder, jam, then press STOP.
or has a paper jam. If a document was  

received in memory,
the unit will automa-
tically print it from
memory.

RECEIVED IN FILE — The computer was Turn the computer on 
off and a document to upload the file to the
was received in the Desktop Manager or 
memory of the press FUNCTION then 
MultiPASS. select FILE PRINT from

the menu to print the
document.

REC’D IN MEMORY — The paper or ink ran out, Add paper to the sheet
or a paper jam occurred, feeder, change the 
so the MultiPASS BJ cartridge, or clear 
received the document the paper jam. Press
in memory. STOP to clear the error

message. The MultiPASS
automatically prints the
document stored in
memory.

START AGAIN — An error has occurred Start the procedure 
in the phone line or in again from the 
the system. beginning.

STOP KEY PRESSED — You pressed the STOP Resume operation.
button to cancel the
current operation.

TALK — The MultiPASS is set Answer the call.
for Fax/Tel mode and
you are receiving a
telephone call.

TX/RX CANCELLED — You pressed STOP to Try sending again.
cancel the transmission.

TX/RX NO. nnnn — When the MultiPASS Write the number down 
sends or receives a fax, if you’ll need it later.
it assigns it a unique
identification number
(nnnn).
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Printing Problems

Problem Cause Solution

The ALARM light The MultiPASS may have a Clear any paper jams. See 
comes on and the paper jam. page 10-3.
MultiPASS beeps
while printing If the MultiPASS has no 

paper jam, unplug it, wait 
5 seconds, then plug it in again.
If the problem is fixed, the
ALARM light will be off, the 
BJ cartridge will move to its 
home position, and the LCD 
display will show the date and 
Receive Mode (Standby Mode).

If the ALARM light stays on,
call the Customer Care Center.
See page 1-4.

Data from computer is The power cord may not Check that the power cord
not printed be plugged in securely. is plugged securely into the

unit and into the wall outlet.
If the MultiPASS is plugged
into a power strip, make sure
the power strip is plugged in
and turned on.

The interface cable may not Check the interface cable 
be securely connected to the connection.
MultiPASS and the computer.

The interface cable may Make sure the cable is a
not be the correct type. bi-directional parallel interface

cable less than 6.6 feet in
length.

The MultiPASS may have been Unplug the MultiPASS and
plugged in or the computer may turn off the computer. Plug
have been turned on when you the unit back in and turn
connected the interface cable. the computer back on again.

The orange tape may not be Be sure to remove the tape
removed from the BJ cartridge. from the BJ cartridge when 

you install it. See page 9-14.

The BJ cartridge may not Make sure the BJ cartridge is
have been installed properly. installed correctly. See page

9-11.
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Problem Cause Solution

Data from computer is The print head unit may need Clean the print head. See
not printed (continued) cleaning. page 9-8.

The BJ cartridge may need to be Replace the BJ cartridge. See
replaced. (It may be out of ink.) page 9-11.

The application you are Check the computer and the
printing from may not be application to make sure they 
set up properly. are configured correctly.

Make sure your application has
the MultiPASS selected as the
printer.

The MultiPASS may not be set Make sure the MultiPASS is
as the default printer or the selected as the default or
selected printer. current printer.

Make sure the MultiPASS Server
is running.

The printer driver may be Make sure the MultiPASS 
configured with the wrong printer driver is configured
port. to use the computer’s 

parallel port. See page 2-7.

The computer’s parallel port Make sure your computer’s 
may be disabled. CMOS has the primary 

parallel port set to LPT1.
(Your computer should have
a Setup Program that lets you 
do this.) See your computer’s
documentation.

Another hardware device or Disconnect the peripheral
software application is device and uninstall or remove
attempting to communicate any software associated with
with the same parallel port this device and any software
to which the MultiPASS is communicating with the 
connected. parallel port.

BJ cartridge moves, The BJ cartridge or a BJ tank Make sure the BJ cartridge
ink does not appear may not be installed properly. and its BJ tank(s) are properly

installed. Make sure the orange
tape is removed from the print
head area (see page 9-14).

The nozzles on the BJ Perform the print head
cartridge may be clogged. cleaning procedure (see page 

9-8) and print the nozzle check
(see page 9-7).

A BJ tank may be empty Check the BJ tanks and
(BC-21e Color BJ cartridge). replace them if necessary.

10-12 Troubleshooting Chapter 10



Chapter 10 Troubleshooting 10-13

Problem Cause Solution

The printed output is There may be a communication Make sure the computer 
not what you expected problem between the MultiPASS and the application are 

and your computer. configured correctly for 
communicating with the
MultiPASS.

The interface cable may not Check the interface cable’s 
be securely connected to the connections.
MultiPASS and the computer.

The interface cable may not Make sure you are using a
be the correct type. bi-directional parallel interface 

cable that is less than 6 feet 
(2 m) long.

You may not be using the Make sure you have
correct printer driver. selected the MultiPASS

printer in your application.

Another hardware device or Disconnect the peripheral
software application is device and uninstall or remove
attempting to communicate any software associated with
with the same parallel port this device and any software
to which the MultiPASS is communicating with the 
connected. parallel port.

You may not have the best Try selecting Coated Paper for
media type selected. the Media Type rather than

Plain Paper. See page 2-9.

Previous software settings Make sure the MultiPASS
may not be cleared. was cleared of the previous 

software settings before the 
print job started. See the 
application’s documentation.

Printout does not Paper may not be loaded Make sure the paper is loaded
match paper size and aligned correctly in and aligned correctly. See

the sheet feeder. page 2-19.

The application’s page Make sure the paper size and
size and margin settings margin set in your application
may be incorrect. are correct for the paper in the

sheet feeder.

The selected printer driver Make sure you select the
may be incorrect. MultiPASS printer in your

application.

The MultiPASS suspends The print head may have Stop your print operation
print after every line is become too hot. If this happens, and wait several minutes to
printed the MultiPASS may be slowing allow the unit to cool. Then

its print speed at the end of each start your operation again.
line to protect the print head. Tr
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Problem Cause Solution

Print jobs vanish or you Another Windows application Uninstall or remove the
are printing garbage on your computer may be software application.

trying to communicate with
the printer port the MultiPASS
Server is using. This conflict
can result in strange printing
behavior.

Make sure the MultiPASS If the MultiPASS Server icon
Server is loaded. does not appear on the bottom

of your screen, turn on the
MultiPASS Server.

The printout curls Your pages may include a Remove each sheet as it is
large amount of ink. printed. Allow it to dry, then

roll it in the opposite direction
of the curl.

Your computer indicates A device time-out occurs when Make sure the MultiPASS is
a device time-out the computer sends data to the plugged in, and that its 

MultiPASS, but the MultiPASS interface cable is securely
does not respond. The attached to the unit and to
MultiPASS may be unplugged, the computer. Clear any paper 
not connected to the computer, jams, and make sure paper is 
or have a paper jam. loaded properly in the sheet

feeder.

Print Quality Problems
Problem Cause Solution
Print quality is not what The paper you are using Make sure you are using 
you expect; print is not may not be supported by the recommended paper 
clear; splashed or missing the unit. (see page A-2).
dots, white streaks

You may be printing on the Some paper has a right side 
wrong side of the paper. for printing. If the print quality

is not as clear as you would like
it to be, try turning the paper
over and printing on the other
side.

The print head nozzles Clean the print head (see 
may be clogged. page 9-8); repeat cleaning 

if necessary. If print quality is
not recovered after executing
the cleaning five times, replace
the BJ cartridge.
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Problem Cause Solution

Print quality is not what BJ cartridge may be Make sure the BJ cartridge
you expect (continued) installed incorrectly. and/or BJ tanks are installed

correctly.

A BJ tank in the BC-21e Replace BJ tanks as necessary.
Color BJ Cartridge may be See page 9-16.
empty.

The print head may be The BJ cartridge may need
worn out. to be replaced. Replace it with

a new one (see page 9-11).

Output appears jagged The resolution selected via Check your printer driver to
printer driver may be see what Print Quality you
Draft (180 dpi). have selected. Printing in Draft

mode will give the output a
jagged look. Changing the
Print Quality to Standard
should correct this problem.

Fonts do not print as Bitmapped fonts designed Make sure you installed an
smoothly rounded for dot matrix printers do outline font manager, such
characters not print smoothly rounded as Adobe® Type Manager or

characters when used with Bitstream® Facelift, or that
high resolution printers like you are choosing a TrueType®

the MultiPASS. font.

Certain MS fonts, such as Choose another font.
MS Serif, will print jagged.

Output is faint You may be using Draft Try using Standard print
print quality or Fine mode. quality.

Printing takes too You may be using Fine Turn off Fine mode.
much time mode.

Blurred or smudged ink The print medium you are Try a different paper type;
using may not be supported however, use only print media
by the MultiPASS. specified in Appendix A,

Specifications.

You may be printing on Paper has a right side for 
the wrong side of the sheet. printing. If the print quality is

not as clear as you would like,
try turning the paper over and
printing on the other side.
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Color Printing and Copying Problems
Problem Cause Solution

Printer prints only in The MultiPASS printer driver Make sure the MultiPASS is
black (you are printing may not be selected. the default printer in your  
from an application that application.
supports color printing 
but your output is 

The printer driver may not be Check that you selected Color

black ink only)
selecting color. in the Color Model dialog box 

of the Graphics tab of the 
printer driver.

The color BJ cartridge may Print the Nozzle Check pattern
not be installed or may not to make sure the BC-21e Color 
be working properly. BJ Cartridge is installed and

firing correctly.

If a BJ tank is empty, replace it.

The print head unit may Clean the print head (see
need cleaning. page 9-8).

The application you are using Make sure your application
may not support color supports color printing.
printing.

Colors are broken or The print mode may be If you are printing high 
uneven wrong. density graphics on plain

paper, set the Media Type to
Coated Paper on the Paper tab
of the printer driver.

If you are printing a thin Choose cyan, yellow,
line with a nonprimary magenta, or black instead.
color, your software may 
be telling the unit to place
a color every other dot,
with white in between.

Colors print incorrectly The MultiPASS printer Make sure the MultiPASS
driver may not be selected. is the default printer in your

application.

The driver may not be Check that you selected 
selecting color. Color in the Color Model

dialog box in the Graphics tab
of the printer driver.

The driver may not be Make sure the correct paper 
selecting the right media. type is set in the driver.

Colors are missing The print head may need to Clean the print head (see 
be cleaned. page 9-8).
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Problem Cause Solution

Colors in a line are The print settings may not If you are printing high
uneven or different be the best for the images density color graphics on
from previous lines you are printing. plain paper, change the Media

Type setting from Plain Paper
to Coated Paper.

Be sure to experiment with
different settings and different
types of paper.

Hue changes The print nozzles may be Clean the print head. See
clogged with dust. page 9-8.

A BJ tank may be empty. Replace empty BJ tanks as
needed. See page 9-16.

Blue looks like purple Blue prints out as purple Within the MultiPASS printer
because of the difference in driver, selecting Match (screen
color technology used by match) in the Color Adjustment
the screen and printer; the dialog box of the Custom Setting
screen uses RGB (Red, Green, window will result in a lighter
Blue) color and the MultiPASS blue. If you are not using
uses CMYK (Cyan, Magenta, screen matching, decreasing
Yellow, Black) color. Due to the the amount of magenta by 30%
technology differences, when produces a royal blue.
cyan and magenta are mixed
together, blue  prints dark blue

If you are just looking for a

or purple compared to the screen.
nice blue color, try cyan. It 
prints beautifully and fast 
and is available in almost all
applications that support color.

Color images are Check to see if your MultiPASS If so, change the Media Type
missing some detail printer driver is set to Plain setting from Plain Paper to

Paper, Color Mode, and Coated Paper.
Halftoning=Pattern.

Paper Feeding Problems
Problem Cause Solution

Paper does not load The sheet feeder may contain Make sure the stack of paper
too many sheets. in the sheet feeder does not

exceed the limit mark.

Paper may not be inserted Make sure the stack of paper
correctly. is inserted into the sheet feeder,

and the paper guide is adjusted
correctly. Tr
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Problem Cause Solution

Paper is loaded skewed Paper may not be stacked Make sure the stack of paper
(printing is skewed) correctly in the sheet feeder. is straight in the sheet feeder.

Make sure the right side of the
stack of paper is aligned against
the right side of the sheet
feeder and the paper guide is
aligned against the left side.

Make sure the paper exit path
is clear.

Multiple sheets load Paper may not be stacked Make sure paper is installed
into unit at the same correctly. correctly in the sheet feeder.
time

Sheets of paper may be Be sure to fan the stack of
sticking together. paper before placing it in the

sheet feeder.

Too much paper may be Make sure the paper rest is
stacked in the sheet feeder. extended and the paper is

stacked correctly in the sheet
feeder.

Make sure the stack of paper
does not exceed the limit mark.
If necessary, remove a few
sheets from the sheet feeder.

Do not stack more than 
approximately 100 sheets of
plain paper in the sheet feeder.

Do not force the stack into the
sheet feeder.

Different types of paper may Load just one type of paper.
be stacked in the sheet feeder.

Make sure you are loading
paper that matches the
specifications of this unit.
See Appendix A, Specifications,
for details.

Transparencies or back The film may not be loaded Make sure you load no more
print film do not feed correctly. than 50 sheets of transparencies
correctly or 10 sheets of back print film

in the sheet feeder.
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Problem Cause Solution

Repeated paper jams The paper you are using may Fan the paper before stacking
occur be causing the jams. it in the sheet feeder. This

keeps the sheets of paper from
sticking together.

Check that the paper you are
using and your printing
environment are within the
specifications of the unit. See
Appendix A, Specifications,
for details.

Envelopes do not load Envelopes may not be Make sure the envelopes are
loaded correctly. loaded properly. (See page 

2-25.)

Make sure there are no more
than 10 envelopes in the sheet
feeder.

You may need to choose Make sure you select the
the envelope setting in correct envelope size in the
your printer driver. Paper Setting dialog box in

your printer driver.

Envelopes may not match Envelopes must be U.S.
specifications for this unit. Commercial number 10 

(9.5 × 4.1 inches) or 
European DL envelopes 
(220 × 110 mm).

Faxing Problems
Problem Cause Solution

Cannot send a The MultiPASS may have Unplug the unit and let it
document overheated. cool for several minutes. Try

sending again.

The MultiPASS may not be If you have a pulse line, be 
set for the type of telephone sure the MultiPASS is set
line in use (pulse/tone). for pulse dialing.

The document may not Remove the document, stack
have been fed correctly it, and feed it into the unit
into the MultiPASS. correctly (see page 1-13).

Make sure the operator panel 
is closed.
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Problem Cause Solution

Cannot send a The one-touch or coded Check the one-touch or coded
document (continued) speed dialing number you speed dialing button and be

used may not be registered sure it is registered correctly.
for the feature you want 
to use.

The other party’s fax may be Call the other party and ask
out of paper. them to make sure paper is

installed.

There may be other documents Allow time for the current 
being sent from memory. document to finish sending.

The telephone line may not Make sure there is a dial tone
be working properly. when you lift the telephone.

If not, contact the local
telephone company.

The receiving fax machine may Make sure the receiving fax 
not be a G3 fax machine. machine is compatible with 

the MultiPASS (which is a G3
fax machine).

Images on faxes The receiving fax machine may Check the MultiPASS by
received from the not be working properly. making a copy. If the copy is
MultiPASS are clear, the problem may be in 
spotted or dirty the receiving fax machine.

The document may not be Remove the document and
properly inserted in the feed it correctly into the 
ADF. ADF. See page 1-13.

Cannot send or receive The other party’s fax may Some fax units do not 
using Error Correction not support ECM. support ECM transmission.
Mode (ECM) If the other party’s fax does

not support ECM trans-
mission, then the document is
sent in the normal mode
without error checking.

Errors occur frequently The phone line may be in Lower the transmission speed.
while sending or receiving poor condition, or you may See the Advanced: Send Fax

have a poor connection. dialog box (page 8-5) and the
Advanced: Receive Fax dialog
box (page 8-9).

The sending fax machine may The sending fax machine
not be functioning properly. usually determines the fax’s

quality. Call the sender and 
have them make sure the top 
cover and scanning glass on 
their fax machine are clean.
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Problem Cause Solution

Cannot receive a The MultiPASS may not be To receive faxes automatically,
fax automatically set to receive automatically. the Receive mode must be

Fax Only or Fax/Tel mode.

The MultiPASS may have a Print out any document 
document stored in memory. stored in memory. (See 

page 5-5.)

The MultiPass Desktop Check the In Box in the 
Manager may have Desktop Manager.
received the fax.

An error may have occured Check the LCD for an error
during reception. message. See page 10-6.

The sheet feeder may be Make sure paper is loaded
empty. in the sheet feeder.

The telephone line may not Make sure all phone line
be connected properly. connections are secure.

The MultiPASS is printing The incoming fax is stored 
a document. in memory and will print

when the print job is 
complete.

The MultiPASS does The MultiPASS may not For the MultiPASS to switch
not switch automatically be in Fax/Tel mode. automatically between
between telephone and telephone and fax reception,
fax transmissions the Receive mode must be 

set to Fax/Tel mode.

There may be a document Make sure you have printed
in memory. out any documents in memory.

An error may have occured Check the LCD for an error
during reception. message. See page 10-6.

The sheet feeder may be Make sure paper is loaded in
empty. the sheet feeder.

The sending fax may not Some fax units cannot send
send the CNG signal that the CNG signal that tells your
tells the MultiPASS that the MultiPASS the incoming signal
incoming signal is a fax. is from a fax. In such cases,

you will have to receive the
document manually.

Cannot receive a You may have pressed Always press START/COPY
document manually START/COPY after hanging before hanging up the 

up the telephone. telephone. Do not press 
START/COPY after you hang
up the telephone; this will 
disconnect the call. Tr
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Problem Cause Solution

Print quality is poor You may not be using the Be sure you are using paper
correct type of paper. that meets the paper

requirements for the
MultiPASS (see page A-1).

The print head may need Clean the print head 
to be cleaned. (see page 9-8).

The sending party may be Make a copy on your
having a problem. MultiPASS. If the image is

OK, then your MultiPASS is
operating properly. Contact
the other party and have
them check their machine.

Error correction (ECM) Make sure Error correction
may be disabled. (ECM) is set to on in the

Advanced: Receive fax
dialog box of the Desktop
Manager.

Faxes do not print The BJ cartridge may not Be sure to remove the orange
be installed correctly. tape from the BJ cartridge

before you install it in the
MultiPASS (see page 9-14).

Make sure the BJ cartridge is
installed correctly (see page 
9-11).

The print head may need Clean the print head several 
cleaning. times (see page 9-8).

The BJ cartridge may need Try another BJ cartridge.
to be replaced.

The MultiPASS may have a Faxes will not print when
BC-22e Photo or BC-29F these cartridges are installed.
Neon BJ Cartridge installed. Replace the cartridge with a

BC-21e Color or BC-20 Black
BJ Cartridge.

Fax images print blotched The telephone lines may ECM sending/receiving should
or uneven be in poor condition, or eliminate such problems.

you may have a bad However, if the telephone 
connection. lines are in poor condition,

you may have to try again.

The other party’s fax may Remember, the sending fax
have a problem. usually determines document

quality. Be sure the other
party’s top cover and scanning
glass are clean.
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Telephone Problems
Problem Cause Solution

You cannot dial The telephone line may Be sure the telephone line is
not be connected properly. correctly connected to the

MultiPASS (see your Setup
Guide).

The unit may not be getting Make sure the power cord is
power. connected to the MultiPASS

and to an AC outlet; make
sure the AC outlet has power.

The MultiPASS may not If you have a pulse line, be 
be set for the type of sure the MultiPASS is set for
telephone line in use pulse dialing (see page 8-4).
(pulse/tone).

The phone disconnects The MultiPASS may not be Make sure the MultiPASS
while you are talking plugged in properly. is plugged in correctly.
on the line

If the MultiPASS is in Disable the Silent Receive
Answer Machine Mode and option on the Receive Fax
Silent Receive is enabled, tab of the Desktop Manager.
the unit will switch to fax 
receive mode when it detects
a period of silence.

Copying Problems
Problem Cause Solution

The MultiPASS will not The MultiPASS may have a Replace the empty BJ tank.
make a copy BC-21e Color BJ Cartridge See page 9-16.

installed, and its black BJ tank
may be empty.

The telephone may be off hook. Make sure the telephone is 
in its cradle.
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Problem Cause Solution

The MultiPASS will not The document may not be Make sure a document is set
make a copy (continued) loaded correctly. in the ADF and the LCD

displays DOCUMENT READY.

Make sure the operator panel
is closed.

The BJ cartridge is not Make sure the BJ cartridge is
installed. installed correctly.

The MultiPASS may not be Try to print a document from
be operating properly. your computer.

MEMORY FULL The MultiPASS’s memory Print out any faxes stored in 
appears in the LCD is full. memory. Then print one copy 
when you are making at a time.
multiple copies

General Problems
Problem Cause Solution

The MultiPASS has The power cord may not be Make sure the power cord is
no power securely plugged into the unit. plugged securely into the unit

and into a wall outlet.

If the power cord is connected
to a power strip, make sure the
strip is connected to an outlet
and turned on.

The power cord may not be Check the power cord by
supplying power. substituting another, or by

using a voltmeter to test it for
continuity.

The MultiPASS will not The MultiPASS may have a Replace the empty BJ tank.
print reports BC-21e Color BJ Cartridge See page 9-16.

installed, and its black BJ
tank may be empty.

The BC-22e Photo BJ Cartridge Remove the BC-22e and install
may be installed. the BC-21e Color or BC-20

Black BJ Cartridge.

Nothing appears in the The MultiPASS may not be Check the plug and be sure it is
LCD display receiving power. firmly plugged into the power

connector and the wall outlet.

If the display remains blank,
unplug the MultiPASS, wait five
seconds, then plug it in again.
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Technical Notes

Using Other Bi-directional Devices
If you have another bi-directional device (such as a Windows Printing
System printer or a later-model laser printer) installed on your computer
and you are attempting to use the same port on which you have the
MultiPASS connected, you may experience undesirable results when
printing a document.

Be sure the MultiPASS is the only device configured to a particular port.
The MultiPASS operates properly only with a dedicated parallel port.

MultiPASS Hardware Cannot Initialize
If you see the following screen during the installation process, try to
solve the problem by following the procedures below.

1. Confirm that the MultiPASS unit is plugged into a power source and
that the date and Receive Mode are displayed in the LCD before
turning on the PC or starting Windows. It is recommended that the
MultiPASS be connected directly to an AC outlet and not a power
strip to which your computer is connected.

2. Check both ends of the printer cable—at the computer and at the
MultiPASS—to confirm that the cable is securely fastened.

3. Confirm that the MultiPASS is configured for the correct parallel
port in the Details tab of the Printer Properties. In addition, confirm
that there are no port conflicts in the Device Manager tab of the
System Properties. Tr
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4. Remove any pass-through devices, switch boxes, zip drives, tape
backups, docking stations, scanners, and any software associated
with these products. The software drivers for these products are
customarily executed from the Load and Run lines of the computer’s
Win.ini or the StartUp Group. Please refer to the product’s
manufacturer for information on how to properly remove the
hardware and software.

5. If the above procedures do not resolve the problem, please call the
Canon Computer Systems Customer Care Center. See page 1-4 for
details.

N If the error message clears, be sure to start up your system and check the
MultiPASS. The problem may be cleared.

Memory Clear Report
The Memory Clear Report summarizes the documents that were cleared
from memory when a power failure occurred. This report is generated
automatically.

❍ If you experience a power failure, any documents stored in memory
will be lost.

❍ When you turn on the MultiPASS after power is restored, the
MultiPASS automatically prints out a list of documents that were
stored in the memory at the time of the power failure.

*****************************

*** MEMORY CLEAR REPORT***

*****************************

MEMORY FILES DELETED

TX/RX NO MODE CONECTION TEL/ID PGS. SET TIME ST. TIME

0079 TRANSMIT 3122685700 1 08/03 12:54

0080 RECEIVE 337582111 2 08/04 12:59
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Printing Method
Bubble Jet ink on-demand

Paper Handling
Automatic feed
Manual feed

Sheet Feeder Capacity – Auto Feed Only
Maximum thickness of stacked paper: 0.4 inches (10 mm)
Plain paper

(20 lb or 75 g/m2) Approx. 100 sheets (0.4" stack)
Glossy photo paper 1 sheet
Banner paper 1 sheet (2 to 6 long)
Brilliant white paper Approx. 100 sheets (0.4" stack)
High resolution paper Approx. 80 sheets (0.4" stack)
T-shirt transfers 1 sheet
Bubble Jet paper Approx. 100 sheets (0.4" stack)
Fabric sheets 1 sheet
Transparencies 50 sheets
Back print film 10 sheets
Envelopes 15 envelopes (U.S. Commercial 

number 10 or European DL)

Paper Size
Letter 8.5 in × 11 in
Legal 8.5 in × 14 in
A4 210 mm × 297 mm
A5 148 × 210 mm
B5 182 × 257 mm
Banner 8.5 in × 11 in sheets;

maximum length 66 in (1676 mm)
U.S. Commercial  

number 10 envelope 9.5 in × 4.1 in
European DL envelope 220 mm × 110 mm

ASpecifications



A-2 Specifications Appendix A

Media Type Recommended
Glossy photo paper Canon Glossy Photo Paper GP-201
Banner paper Canon Banner Paper
Brilliant white paper Canon Brilliant White Paper
High resolution paper Canon High Resolution Paper HR-101
T-shirt transfers Canon T-Shirt Transfers TR-101
Greeting cards Canon Greeting Cards GC-101
Bubble Jet paper Canon Bubble Jet Paper (water-resistant) 

LC-301
Fabric sheets Fabric Sheet FS-101 for Canon Bubble 

Jet printers
Transparencies Canon CF-102 Transparencies
Back print film Canon Back Print Film BF-102
High gloss film Canon High Gloss Film HG-101
Envelopes Commercial number 10 or European DL

Paper Weight
17 to 30 lb (64 to 105 g/m2) 

Print Speed 
BC-21e Color BJ Draft mode—up to 2.5 ppm 
Cartridge Standard mode—up to 1.4 ppm 

Fine mode—up to 0.23 ppm 

BC-20 Black Draft mode—up to 6.5 ppm 
BJ Cartridge Standard mode—up to 3.6 ppm 

Print Width
Maximum 8 inches (205 mm)

Line Feed Speed
Approximately 150 ms/line at 2/6-inch line feeds 

Resolution
Color 720 × 360 dpi
Black 720 × 360 dpi (with Smoothing)
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Printable Area—Papers
The shaded portion in the following figure shows the printing area for
paper. The table lists the minimum margins.

All Except Fabric Sheet Fabric Sheet

Margin Inches mm Margin Inches mm

L 0.25 6.4 L 0.25 6.4 
R 0.25 6.4 R 1.35 34.4
T 0.12 3.0 T 1.62 41.1
B 0.65 16.5 B 1.10 27.9

Printable Area—Envelopes
The shaded portion in the following figure shows the printing area for a
COM10 envelope. The table lists the minimum margins.

Margin Inches mm

L 0.25 6.4
R 1.25 31.7
T 0.12 3.0
B 0.65 16.5
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BJ Cartridges
BC-21e Color BJ Cartridge
Print head 64 nozzles for black

24 nozzles for each color (cyan, magenta,
yellow)

Print head life Approximately 2,000 color pages at 30% 
coverage

BJ tanks BCI-21 Color (cyan, yellow, magenta) 
BCI-21 Black

Ink color Black, cyan, yellow, magenta
BJ tank yield

BCI-21 Color Approx. 100 pages at 7.5% coverage
BCI-21 Black Approx. 225 pages at 5% coverage

BC-20 Black BJ Cartridge 
Print head 128 nozzles
Ink color Black
Cartridge yield Approx. 900 text pages at 5% coverage

BC-22e Photo BJ Cartridge 
Print head 64 nozzles for black

24 nozzles for color
Ink color Black, cyan, magenta, yellow
Cartridge yield Approximately 50 pages at

7.5% coverage for each color
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Facsimile
Applicable line
Public switched telephone network

Compatibility
G3

Data compression system
MH, MR, MMR (ECM-MMR)

Modem type
Fax modem

Modem speed
14400/9600/7200/4800/2400 bps

Automatic fallback

Transmission speed
Approx. 6 seconds/page* at 14.4 Kbps, ECM-MMR

transmitting from memory

Transmission/reception memory
672 KB DRAM, MR storage
Up to 42 pages*
Up to 20 documents*
LCD displays memory used 
Uses direct transmission when memory full

Automatic Document Feeder (ADF)
30 pages, letter size (based on 20 lb paper)
10 pages, legal size

Fax resolution
Fine mode—203 pels/in × 196 lines/in

(8 pels/mm × 7.7 lines/mm)

Standard mode—203 pels/in × 98 lines/in
(8 pels/mm × 3.85 lines/mm)

Fax printing speed
Approx. 4 pages/minute*

*Based on the CCITT #1 Chart, Standard mode

Appendix A Specifications A-5



Dialing
Automatic dialing

One-touch speed dialing (6 locations)
Coded speed dialing (50 locations)
Group dialing (55 locations)

Manual dialing (with numeric buttons)
Automatic redialing (including error redialing)

Redial times: 1-10
Redial interval: 2-99 min

Manual redialing
Pause button (variable length: 1-15 sec)

Networking
Sequential broadcast (up to 57 locations)
Automatic receiving
Non-ring reception
Deactivate ECM
DRPD (Distinctive Ring Pattern Detection)

Report/reference
Activity report (up to 20 transactions)
Non-delivery report
TTI (Transmitter Terminal Identification)

Ink saver
Economy mode for printing received faxes extends 
cartridge life
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Copier
Scanning resolution
B&W Text: 203 pels/in × 196 lines/in
B&W Photo: 360 × 360 dpi with halftone 
Color Fine: 360 × 360 dpi, full color
Color Standard: 360 × 180 dpi, full color
Color Snapshot: 360 × 360 dpi, full color

Printing resolution
360 × 360 dpi

Default size
100%

Reduction sizes
70%, 80%, 90%

Copy speed
Black and white copy

Initial copy—45 seconds
Subsequent copies—20 seconds

Color copy
COLOR FINE mode, Letter size—11 minutes

Multiple copies
Up to 99 copies of a document
1 copy of a color document

Scanner
Scanning method
Solid-state electronic scanning by contact image sensor

Scanning image processing
UHQ™ (Ultra High Quality image enhancement)
Halftones—256 levels of gray
Color—16.7 million colors
Photo/text auto-recognition
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Automatic document feeder
Paper size—Up to 30 letter-size or A4-size sheets

10 legal size sheets
(Based on 20 lb paper)

Paper thickness
Auto feed—0.003-0.005 in (0.08-0.13 mm)
Manual feed—Up to 0.017 in (0.43 mm)

Paper Weight
Auto feed—20-24 lb (75-90 g/m2)
Manual feed—24-90.7 lb (90-340 g/m2)

Resolution
Optical 300 dpi
Enhanced 30-600 dpi (set from within application)

Effective scanning width
8.42 in (214 mm)

Compatibility
TWAIN

Scanning speed
B&W Text (40-150 dpi)—9 sec/page 5 ms/line
B&W Text (160-300 dpi)—18 sec/page 5 ms/line
B&W Text (310-600 dpi)—35 sec/page 5 ms/line
Grayscale (40-150 dpi)—13 sec/page 7 ms/line
Grayscale (160-300 dpi)—25 sec/page 7 ms/line
Grayscale (310-600 dpi)—78 sec/page 11 ms/line
Color (40-150 dpi)—39 sec/page 21 ms/line
Color (160-300 dpi)—75 sec/page 21 ms/line
Color (310-600 dpi)—234 sec/page 33 ms/line

Document sizes
Maximum 8.5 in W × 39.3 in L (216 mm W × 1000 mm L)
Minimum 3.5 in W × 2.5 in L (88.9 mm W × 63.5 mm L)
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Scanned image
The actual scanned image size for the MultiPASS C5500 is shown below.
This information applies to documents that will be scanned for faxing
or copying.

There is a 0.12 in (3.0 mm) margin on either side of the sheet and a 
0.16 in (4.0 mm) margin on the top and bottom that are not picked 
up by the scanner.

MultiPASS Desktop Manager for Windows
System Requirements
IBM® PC or compatible computer with a 486DX2 66 MHz or 

higher processor (Pentium® recommended)
16 MB of memory (32 MB recommended)
50 MB of free hard disk space 
Microsoft Windows 98 or Windows 95
Bi-directional Centronics-compatible parallel cable (IEEE 1284-compliant)
CD ROM drive (2× or better)

PC Fax
Canon proprietary MultiPASS Desktop Manager for Windows
Fax/Telephone address book
Fax Viewer
Fax Log
Fax distribution lists
Real-time MultiPASS C5500 hardware status available through computer
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General Specifications
Power Source
120V/60Hz

Power Consumption
Approx. 48W (Maximum)
Approx. 8.4W (Standby)

Dimension (W x D x H)
15.75 in × 14.4 in × 7.75 in
(400 mm × 365 mm × 205 mm)
Main unit – no trays

Weight
12.3 lb (5.6 kg)

Environmental Conditions
Temperature: 50° F - 90.5° F (10° C - 32.5° C)
Humidity: 20% to 85% RH

Liquid Crystal Display (LCD)
16 × 1

Display Languages
English, French, Spanish

Telephone
Automatic Fax/Tel switchover
Answering machine hook-up

(CNG detecting signal, no sound)
Telephone hook-up
Remote reception by telephone
Remote receiving ID (Default): 25
Tone button
Pause button (variable length: 1-15 sec)
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Space Requirements
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Receiving Faxes and Phone Calls
Automatically—Fax/Tel Mode

In Fax/Tel mode, the MultiPASS monitors all incoming calls to see
whether the call is from another fax machine or from a telephone:
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If you plan to use the MultiPASS C5500 as a stand-alone fax, and you do
not install the MultiPASS Desktop Manager, you must enter your name
and fax number from the operator panel. If you choose to use the
MultiPASS C5500 this way, you will not be able to use its many features,
such as speed dialing, PC faxing, or scanning.

Also, you will not be able to change the Transmit Confirmation Report
to print after every transaction. (The default for the TX REPORT is to
print only when there is an error in transmission.) Canon recommends
that you install the MultiPASS software as described in the Quick Start
Guide. See Chapter 3 for details on using the MultiPASS Desktop Manager.

N In the United States, you are required by FCC regulations to include your
name and fax number every time you send a fax. Be sure to enter this
information.

LCD Menu System
To enter the LCD Menu System, press the FUNCTION button on the
operator panel. Then press < or > to move between selections and press
START/COPY to make a selection. Press STOP to exit the LCD Menu
System.

Option Description/Settings

USER SETTINGS

DATE & TIME Set the date and time (24-hour clock) using the
numeric buttons.

UNIT TELEPHONE # Enter your fax number using the numeric
buttons (up to 20 characters).

UNIT NAME Enter the name you want to appear at the top of
each fax page you send (up to 24 characters).

TEL LINE TYPE Sets the dialing method the MultiPASS uses to
match the type of phone line you have—
TOUCH TONE or ROTARY/PULSE.

BUsing the MultiPASS C5500 
as a Stand-alone Fax



Option Description/Settings

COLOR COPY MEDIA Select PLAIN PAPER when printing or copying
on plain paper, or HIGH RES. PAPER for
special print media, such as Canon’s High
Resolution Paper HR-101.

RX MODE Sets the Receive Mode.

FILE PRINT Prints documents stored in the MultiPASS’s
memory (when the MultiPASS Desktop
Manager is installed).

ROLLER CLEANING Cleans the rollers inside the MultiPASS.

HEAD CLEANING Cleans the print head on the  BJ cartridge.

NOZZLE CHECK Prints a test pattern to check whether the 
BJ cartridge is functioning normally.

N You can change the TX REPORT settings only through the MultiPASS
Desktop Manager.

Entering Information in the MultiPASS
When using the MultiPASS as a stand-alone fax machine, you must enter
your user information into the unit through the operator panel.

When entering information through the operator panel of the
MultiPASS, follow these guidelines.

❍ If you pause and do not make an entry for more than 60 seconds,
the MultiPASS returns to Standby mode. You must start the
procedure over from the beginning.

❍ If you make a mistake while entering registration information, you
can correct it in one of two ways:

• Press < or > to move the cursor under the wrong character, and
then enter the correct character.

• Press STOP and reenter the information.
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Entering Your User Information
Follow the steps below to set the date and time for your MultiPASS and
to enter your fax number and your name. The date and time appear in
the LCD display as well as on the documents you send. Your fax number
and name appear on each document you send.

❍ Use the month-day-year format (mm/dd/yy).

❍ Precede single digits with a zero.

11/15/98 00:00

Enter today’s
date and the 

time using the 
numeric buttons.

06/08/98     15:36

DATE & TIMEPress
START/COPY

twice.

USER SETTINGS
Then press  

the > button.

FUNCTION 
Press FUNCTION

on the one-touch
speed dialing

keypad.
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❍ Set the time using the 24-hour clock system.

❍ Example:

07:30 = 7:30 A.M.
17:05 = 5:05 P.M.

❍ You can enter a space with the > button to make your
number easier to read.

TEL =   6665552222

Enter your fax
number (up to 20

digits) using the
numeric buttons.

TEL = 

DATA ENTRY OKPress START/COPY
twice when the

date and time 
are entered.

11/15/98     08:15
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❍ After a few seconds, the LCD display changes to:

❍ Press the button with the letter you want to enter; for
example, press 2 three times to enter a capital C.

Button Characters
1 1
2 ABCabc2
3 DEFdef3
4 GHIghi4
5 JKLjk15
6 MNOmno6
7 PQRSpqrs7
8 TUVtuv8
9 WXYZwxyz9
0 0
# -.*#!”,;:^’_=/|’?$@%&+()[]{}<>

❍ Correct errors by moving the cursor to the error using 
< or > (on the one-touch speed dialing keypad) and
entering the correct character.

CANON FAX BACK

Enter your name
(up to 24

characters) using
the numeric

buttons.

Then press
START/COPY

again.

UNIT NAME

DATA ENTRY OKPress START/COPY
when the fax

number is entered.
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The MultiPASS returns to standby
mode.

Press STOP to
complete the
registration.

DATA ENTRY OKPress START/COPY
when you finish

entering your
name.

B-6 Using the MultiPASS C5500 as a Stand-alone Fax Appendix B
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Activity report
Journal of fax transactions, both sent and received.

Address Book
The electronic Address Book provided by the MultiPASS Desktop
Manager that allows you to create a list of people with their phone and
fax numbers.

Automatic dialing
Dialing fax or telephone numbers by using a shortcut of pressing one to
three buttons. To use automatic dialing, you must register the numbers
in the MultiPASS Desktop Manager. See also one-touch speed dialing
keypad, coded speed dialing, and group dialing.

Automatic document feeder (ADF)
Refers to the document tray in which you stack the document you want
to fax, copy, or scan.

Automatic redialing
When the receiving fax machine is busy or does not answer, or when an
error occurs while sending, the MultiPASS waits a specified amount of
time and then automatically redials the number. You define the number
of times the unit redials and the length of time between redialing.

Bi-directional parallel interface port 
An interface connection that is capable of both sending or receiving. For
example, when you print and when you send a fax from your computer,
data goes from your computer to the MultiPASS; when you scan and
when you receive a fax into your computer, data goes from the
MultiPASS to your computer.

BJ cartridge
The printing mechanism that contains the print head unit and BJ tanks.

BJ tank
The special type of ink container housed by the BJ cartridge. The 
BC-21e Color BJ Cartridge contains two BJ tanks: one color—BCI-21
Color (which includes cyan, yellow, magenta) and one black—BCI-21
Black.

GGlossary
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bps
Bits per second. Refers to the speed with which a fax machine sends and
receives data.

Broadcasting
Transmitting documents to more than one location.

Bubble Jet printing
An ink-jet type printer that heats the ink to a boiling point in a nozzle to
form a bubble. When the bubble expands, there is no room left in the
nozzle for the ink and the ink is projected onto paper.

CCITT #1 Chart
A test chart, defined by CCITT/ITU-TS, used to measure the
transmission speed as well as the transmitting and receiving memory
capacity of a fax machine.

CCITT/ITU-TS
Formerly known as CCITT, Consultative Committee for International
Telegraph and Telephone. CCITT has been replaced by the International
Telecommunications Union-Telecommunications Sector (ITU-TS), a
committee created to set international standards for
telecommunications.

Centronics
The popular name for the parallel printer port used by most printers
and personal computers.

CNG
Calling Tone. This is a signal sent by fax machines to identify the call as
an incoming document. When the receiving fax detects this signal, it
automatically starts to receive the fax transmission. The majority of fax
machines in use today can send and detect CNG signals.

Coded speed dialing
An automatic dialing method that allows you to dial a fax or telephone
number by pressing the CODED DIAL button and a two-digit code using
the numeric buttons.

cps
Characters per second. A unit of measurement that indicates the printer’s
speed.
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dB(A)
Stands for decibel level (a decibel being a unit of measurement for the
intensity of the sound coming from the unit), adjusted for background
noise.

Dialing methods
Ways of pressing one or more buttons to access a number to connect to
an outside party or fax machine. Dialing methods include one-touch
speed dialing, coded speed dialing, group dialing, and manual (regular)
dialing.

Dithering
A method by which color dots are combined on a page to produce a
wide spectrum of colors.

Document
The sheet of paper containing the data that you send to or receive from
a fax.

dpi
Dots per inch. A unit of measurement for indicating a printer’s
resolution.

DRPD
Distinctive Ring Pattern Detection. Allows you to assign up to five
different ring patterns to distinguish voice and fax calls using your
telephone company’s special services.

ECM
Error Correction Mode. The ability of your MultiPASS to reduce system
and line errors when sending or receiving from another fax with ECM
capability. ECM is most effective in areas where the telephone lines are
in poor condition or there is frequent interference on the line.

Fax/Tel switching
The ability of the MultiPASS to automatically detect whether a call is
from a fax or telephone. With this feature, one telephone line can be
shared by both the telephone and the fax.

FINE
The fax setting for documents with very small characters and lines.
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Fine mode
One of the printer’s print modes. Use this mode when printing on
transparencies or printing a halftone image that produces grayscale or
intermediate colors.

Font
A complete set of characters of the same size and style; a particular
implementation of a typeface. For example, 12-point, Courier bold.

G3, Group 3 fax machine
Defined by CCITT. Uses encoding schemes to transmit image data while
reducing the amount of data that needs to be transmitted, thus reducing
transmission time. Encoding schemes for G3 fax machines are Modified
Huffman (MH), Modified Read (MR), and Modified Modified Read
(MMR).

Grayscale
Representing color in black and white as a result of different intensities
of color. Different colors and intensities of colors appear as different
shades of gray.

Group dialing
A dialing method that enables you to dial up to 55 registered one-touch
speed dialing or coded speed dialing numbers together as a group. This
means that you can press just one to three buttons to enter numbers
when sending the same document to many destinations.

Halftone
Using this method, the MultiPASS (in printer mode) produces shades of
gray or of colors by mapping dots to be printed. For color printing,
different colored dots of ink are placed closely together to create
illusions of other colors.

IEEE 1284
IEEE 1284 is the new specification standard for computer-to-peripheral
bi-directional parallel interface communications. The new standard was
adopted by IEEE, Institute of Electrical and Electronic Engineers, Inc., in
1993. Some of the benefits it provides are: bi-directional communication
between computers and peripheral devices, a higher speed data transfer
rate, and protection against data loss due to noise interference.
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Ink Saver
You can enable or disable economy printing (ink saving feature) when
receiving faxes. By enabling the Ink Saver Mode, ink consumption can be
decreased by as much as fifty percent, resulting in a longer effective
cartridge life. You set Ink Saver Mode in the Advanced: Receive Fax
dialog box.

Intensity
The amount of color. More intense or more saturated colors are more
pure. Less intense or less saturated colors are less vivid.

Interface port
The MultiPASS comes with one IEEE 1284, bi-directional parallel
interface port, located on the back of the unit. You attach the cable that
connects your computer and MultiPASS to this port.

Jack
The telephone receptacles (RJ11 type) on your wall or in your
MultiPASS used to connect the MultiPASS to the telephone line,
telephone, answering machine, or data modem.

Landscape orientation
Refers to printing across the length of the page (as opposed to portrait
orientation printing across the width of the page).

Manual feed
A method of feeding paper into the printer one sheet at a time.

Manual receiving
A method of receiving faxes in which you answer all incoming calls
using a telephone.

Manual redialing
When you use regular dialing, you can redial a number “manually”
simply by pressing REDIAL on the operator panel. The last number
called is the number redialed.

Memory broadcast
Allows you to send a scanned fax to as many as 57 locations at once,
using a combination of one-touch speed dialing, coded speed dialing,
and regular dialing.

Modem
A device that converts (Modulates) digital data for transmission over
telephone lines. At the receiving end, this device converts the modulated
data (DEModulates) to digital format that the computer understands.
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MultiPASS Desktop Manager for Windows
Canon’s exclusive software package that allows you to use the MultiPASS
with your Windows software applications. You must install the Desktop
Manager to use your MultiPASS as a printer, scanner, or PC fax.

Noise
A term applied to a variety of problems that impair the operation of
telephone lines used for faxing.

Noise level
See dB(A).

Nonbleed
A special mode in color print quality selection whereby the printer
changes from true black to composite black when directly adjacent to an
area of color.

Numeric buttons
The round numbered buttons on the operation panel marked the same
as a standard telephone keypad. Press them to perform manual dialing,
to enter numbers and letters when you register numbers and names, and
to enter coded speed dialing codes with two or more digits.

One-touch speed dialing keypad
The round buttons numbered 1 to 6 on the operator panel, each of
which may be registered as a fax or telephone number. Once a number is
registered, you press one button to dial the entire number.

Page orientation
Refers to the direction of print on the page. Printing across the width of
a page is called portrait orientation. Printing across the length of a page
is called landscape orientation.

Pause
A timing entry required for registering certain long distance numbers
and for dialing out through some telephone systems or switchboards.
Pressing the REDIAL/PAUSE button enters a pause between digits of a
telephone number.

PC fax
An electronic way to send and receive faxes. A PC fax is sent from or
received directly into a computer. Using the MultiPASS Desktop Manager
you can send and receive PC faxes, and save, sort, and/or print the PC
faxes.



Glossary G-7

Portrait orientation
Refers to printing across the width of the page (letter style). This is the
opposite of landscape orientation, which is printing across the length of
the page.

Print head
The printing mechanism that contains print nozzles and ejects the ink for
printing.

Print head capping
An automatic protection function that prevents the print head unit and
BJ cartridges from drying out or becoming clogged with dust.

Printable area
The area of a sheet of paper or envelope on which a printer can
reproduce text or graphics (the printable area is smaller than the paper).

Printer driver
Software that sends printing instructions to a printer (in this case, the
MultiPASS C5500). The printer driver keeps track of the attributes of a
printer and the codes the program must send to access those attributes.

Pulse
See Rotary pulse.

RAM
Random Access Memory. Memory that is used for temporary storage of
information such as documents you want to print, scanned and received
documents, and downloaded fonts.

Receiving
Receiving faxes is also defined as RX or reception. This refers to how the
MultiPASS receives fax documents.

Redialing, automatic
See Automatic redialing.

Redialing, manual
See Manual redialing.

Reduction mode
The MultiPASS’s automatic feature that reduces the received image to
ensure it fits on the page. You can turn this feature on/off with the
Reduce to Fit Paper option in the Receive Fax dialog box of the
MultiPASS Desktop Manager.
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Registering
A process by which you place fax or telephone numbers and names in
the MultiPASS’s memory for automatic dialing so that you can save time
dialing frequently called destinations. You register numbers using the
Address Book in the MultiPASS Desktop Manager.

Regular dialing
Pressing the individual numeric buttons to dial a fax or telephone
number.

Remote receiving ID
A two-digit code that enables you to manually activate a fax using a
telephone that is connected to the MultiPASS. (The default code is 25.)

Remote reception
Activating a fax by answering a telephone that is connected to the
MultiPASS, but that is not located near the unit (such as a cordless
phone). You need to dial a remote receiving ID number to start remote
reception.

Resolution
The measurement of a printer’s quality expressed in dots per inch (dpi).
Low resolution causes font characters and graphics to have a jagged
appearance. Higher resolution means smoother curves and angles as 
well as a better match to traditional typeface designs. Resolution values
are represented by horizontal data and vertical data, for example,
360 × 360 dpi.

Rotary pulse
A telephone dialing system where a dial is rotated to send pulses to 
the telephone switching system. When you pulse dial, you hear clicks.
When you touch-tone dial, the most common dialing system, you 
hear tones.

RX
See Receiving.

Sender ID
Information printed at the top of a fax (also called TTI or Transmit
Terminal ID). This data appears only if the sending fax has been
programmed with the information.

Sending
Sending transmission is also defined as TX or transmit. A fax document
that has been scanned by a fax machine and sent over telephone lines, in
the form of electrical pulses, to another fax machine is a sending
transmission. The MultiPASS also allows you to send a document
directly from your computer (PC faxing).
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Sending speed
The rate at which faxes are transmitted through the phone line. See also
bps (bits per seconds).

STANDARD
A document setting for sending normal typewritten or printed
documents containing only text and no drawings, photographs, or
illustrations.

Standby
The mode in which the MultiPASS is on and ready to use. All operations
start from Standby mode when the LCD displays the date and Receive
mode.

Tone/pulse setting
The ability to set the MultiPASS to match the telephone dialing system
your telephone line uses: touch-tone or rotary pulse.

Transaction number
A unique number assigned to each fax document sent (TX NO.) or
received (RX NO.) by the MultiPASS and used to identify that particular
fax document.

Transmit
See Sending.

TrueType font
The scalable font technology built into Microsoft Windows. It offers you
the same font images both on computer displays and printer outputs.

TTI
Transmit Terminal ID. See Sender ID.

TWAIN
An industry standard that allows you to input image data directly 
from a scanner or other input device. Because your MultiPASS supports
TWAIN, you can use the scanning features of the MultiPASS with any
Windows application that also supports TWAIN.

TX
See Sending.

Typeface
The printed design of characters. For instance, Courier, Script, and
Roman typefaces all print characters of different designs.
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Answering machine: 5-4–5
jack: 1-8

Answering machine mode: 5-4–5, 8-8
options: 8-9–10

Applicable line: A-5
Applications, launching from MultiPASS 

Desktop Manager: 8-16–17
Arrow buttons: 1-11, B-1
Assorted Paper Starter Kit: 2-4
Attention needed status: 8-22
Auto feed guidelines: 2-21–22
Auto start send: 8-5–6
Auto tone, scanned images: 6-14
Automatic 

dialing: 4-4–5
settings: 2-14

Automatic Document Feeder: See ADF
Automatically feeding paper: 2-19–22

B
B&W FAX/COPY button: 1-9–10,

4-14–15
B&W PHOTO mode: 1-19, A-7
B&W TEXT mode: 1-19, A-7–8
Back Print Film BF-102: 1-3, 2-3,

2-18–19, 2-28–30, A-1–2
uncurling: 2-29–30

Banner Paper: 1-3, 2-2, 2-18, 2-36–41,
A-1–2
printing: 2-36–41
printing area: 2-36

BC-20 Black BJ Cartridge: 1-2, 1-18,
9-9, A-4

BC-21e Color BJ Cartridge: 1-2, 1-18,
9-9, A-4

BC-22e Photo BJ Cartridge: 1-2, 1-18,
2-30, 9-9, A-4

BC-22e Photo Kit: 1-4

180 × 180 dpi: 2-11
360 × 360 dpi: 2-11, A-7
486DX processor: A-9
720 × 360 dpi: 2-11

A
Accessories: 1-2–4
Action Toolbar, Desktop Manager 

window: 3-2–4
Adding 

entries, Address book: 3-14–17
pages, to document: 1-16

Address Book 
adding entries: 3-14–17
entries: 3-13
exporting: 3-19–20
importing: 3-17–19
opening: 3-12–13
printing: 3-17
setting up: 3-12–20
sorting: 3-13
using: 4-17

ADF: 1-7, 1-14, 4-2, A-5, A-8
paper jams: 10-3–4

Adjusting preview image, scanning:
6-9–12

Advanced 
Receive Fax options: 8-9–11
Send Fax options: 8-5–7

ALARM light: 1-9–10, 10-11
Annotation tools: 4-33
Annotations,

adding to cover page: 4-49–50
adding to document: 7-30–36
including: 4-20
revising: 7-36
selecting: 7-37–38

Answer options: 8-7

Index I-1
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BC-29F Neon BJ Cartridge: 1-2, 2-30, 9-9
BCI-21 Black BJ Tank: 1-2, 9-11, A-4
BCI-21 Color BJ Tank: 1-2, 9-11, A-4
Bi-directional cable: 10-25, A-9
BJ cartridge(s): 1-2–3, 9-9–21, A-4

guidelines: 9-9–11
print head: 9-8
replacing: 9-11–15
specifications: A-4
storing: 9-19–20

BJ tank(s): 1-2–3, 9-9–12, 9-16–21, A-4
replacing: 9-16–18
yield: A-4

Black and white scan mode: 6-5, 6-9,
6-21–22

Brilliant White Paper: 1-3, 2-2, 2-18,
A-1–2

Bubble Jet Paper LC-301: 1-3, 2-3, 2-18,
A-1–2

Bulletin Board Service (BBS): 1-4

C
Calls, responding: 5-9–10
Cancel 

fax: 4-21
sending: 4-10

Canon 
Authorized Service Facility (ASF):

1-5, 10-1
Canada: 1-4
Customer Care Center: 1-4–5, 10-1
help: 1-4
Specialty Papers: 1-3, 2-2–4, 2-28–41
Web site: 1-4

CARTRDIGE button: 1-11, 2-17, 9-12,
9-15–16, 9-18

Cartridge holder: 1-8, 9-14
CCITT #1 chart: A-5
CD ROM: A-9
Centronics interface: A-9  
CHANGE CARTRIDGE message: 9-11
Cleaning

MultiPASS: 9-3–6
scanner components: 9-4–6

Cleaning sheet, high resolution paper:
2-31–33

CODED DIAL button: 1-9–10, 4-5
Color: A-8

copying: 1-19
mode: 2-11
model: 2-9, 2-11
scan mode: 6-5
snapshot: A-7
standard: A-7
versus printing speed: 2-13–15

COLOR COPY button: 1-9, 4-14
COLOR COPY MEDIA setting: 1-19, B-2
COLOR DRAFT mode: 1-19
COLOR FINE mode: 1-19, A-7
Color printing

high quality: 2-13
quick: 2-13
problems: 10-16–17

COLOR SNAPSHOT mode: 1-19
COM10 envelopes: 2-25
Command bar, Desktop Manager 

window: 3-3, 3-5
Command buttons: 3-13
Compatibility: A-5

scanning: A-8
TWAIN: A-8

Contrast, setting: 4-15
Contrast/brightness, adjusting scans:

6-15
Copier, specifications: A-7
Copy 

resolution: A-7
speed: A-6

Copying 
documents: 1-13, 1-18–20
in color: 1-19
problems: 10-23–24
receiving: 5-6
resolution: 1-19

Cover page: See Fax cover page
Cover Page Designer: 4-31–52

window: 4-32–33
Creating, new folder: 3-8, 7-4
Customer Care Center: 1-4–5, 10-1



D
Data compression system: A-5
DATE & TIME option: B-1
Date format: 8-3–4
Default settings: 8-5, 8-8
Delete fax, after sending: 4-20
Desktop Manager: See MultiPASS 

Desktop Manager
Destinations: 4-11
Details tab, Windows: 2-8
Dialing

automatic: 4-4–5
fax: A-6
regular: 4-2–4

Diffusion halftones: 2-14
Dimensions, unit: A-10
Disconnecting, MultiPASS: 8-24
Display language: 8-3–4, A-10
DL envelopes: 2-25
Docking stations: 10-26
Document(s)

adding annotations: 7-30–36
adding pages: 1-16
adding sticky-notes: 7-32
adding text: 7-31
adjusting size and view: 7-25–28
arranging: 7-10
attaching to e-mail: 7-9
copying: 1-18–20, 7-5
cropping: 7-29
deleting: 7-6–7
display, straightening: 7-26–27
exporting: 7-9
flipping area: 7-29
highlighting: 7-35–36
identifying: 1-17
importing: 7-8
indexing: 7-12–21
inserting stamp: 7-33–35
merging: 7-12
modifying: 7-22–38
moving: 7-4
MultiPASS Desktop Manager: 7-1–41
orientation, changing: 7-26
preparing: 1-13–16

printing: 2-5–6, 7-3, 7-38–39
receiving: 5-1–5
renaming: 7-5–6
restoring: 7-7
scrolling: 7-10
searching: 7-12–21
sending: 4-2–10
sizes, scanning: A-8
sorting, List View: 3-11
splitting: 7-11
toolbar: 3-3
transmitting: 4-11–13
viewing: 3-9–11

Document feed lever: 1-9
setting: 1-16

DOCUMENT READY message: 4-2
Document support: 1-7
Document View: 3-9–10, 7-2

manipulating documents: 7-10–11
dpi: 2-11, A-7
Draft mode: 2-11, 2-15
Drawing graphic, creating: 4-41, 7-36
Driver settings: 2-11
DRP service: 5-4, 5-9–10
DRPD 

feature: 5-9–10
mode: 8-8
switch options: 8-9, 8-11

E
Effective scanning width: A-8
E-mail: 7-9

attachments: 8-15
support: 1-4

Entering information: B-2–6
Envelopes: 2-18, A-1–3

printable area: A-3
printing: 2-25–27

Environmental conditions: A-10
Error correction (ECM): 8-5–6, 8-9
Error warning status: 8-22
European DL envelopes: 2-25
Exporting, Address Book: 3-19–20
Extension phone: 5-2

Index I-3
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F
Fabric Sheet FS-101: 1-3, 2-3, 2-18,

2-28, 2-33–35, A-1–2
drying: 2-35
printing: 2-33–35

Facsimile, specifications: A-5–6
Fax(es) 

cancelling: 4-10
fine resolution: 4-14–15
header: 1-17
heading position: 8-5–6
heading/unit name: 8-4–5
information: 8-4–5
photo resolution: 4-14–15
preferences, setting up: 8-3–4
printing speed: A-5
processing: 4-20–21
quality: 4-13–15
receiving: 5-1–10
recipient, specifying: 4-17–18
resending: 4-8
resolution: A-5
sender, identifying: 4-19
sending: 4-1–52
setup: 8-2–14
standard resolution: 4-14–15
status: 4-26–27

Fax cover page
adding annotations: 4-49–50
adding graphics: 4-38–40
adding labels and text: 4-37–38
adjusting fields: 4-43
attaching: 4-18
background, preparing: 4-35–36
creating: 4-34–42
deleting: 4-52
designing: 4-31–52
modifying: 4-41–49
previewing: 4-19
printing: 4-52
renaming: 4-51–52
scrolling: 7-28

Fax driver, removing: 8-25

Fax Log 
comment: 4-19
using: 4-29–30

Fax memo: 4-20
creating: 4-22–23

Fax only mode: 5-2, 8-8
Fax Retrieval System: 1-4
Fax/Tel mode: 5-2, A-12

switching: 8-7
options: 8-9–10

Faxing 
documents: 1-13
problems: 10-19–22

Feeding paper
automatically: 2-19–22
manually: 2-23–24

FILE PRINT 
message: 5-8
option: B-2

Fine mode: 2-9, 2-11
fax: A-5

Fine resolution: 4-14–15
Folder(s)

creating: 3-8, 7-4
deleting: 7-6–7
list: 3-3–4
MultiPASS Desktop Manager: 3-6
renaming: 7-5–6

Font defaults: 7-30
FUNCTION button: 1-11, 9-8, B-3
Function buttons: 1-9, 1-11

G
Gamma curve values: 6-16
General tab, Windows: 2-8
Glossy Photo Paper GP-201: 1-3, 2-2,

2-18, 2-28, A-1–2
Graphics settings, recommended: 2-11
Graphics tab, Windows: 2-9, 2-11
Grayscale: A-8

scan mode: 6-5
Greeting Cards GC-101: 1-3, 2-3, 2-18,

A-1–2



Group 
addresses: 3-16–17
dialing: 4-6–7
entries, Address Book: 3-13
speed dialing, defining: 8-13–14

Guidelines
auto feed: 2-21–22
MultiPASS: 9-2

H
Halftones, diffusion: 2-14
Hard disk space: A-9
Hardware, cannot initialize: 10-25
HEAD CLEANING function: 9-8, B-2
High Gloss Film HG-101: 1-3, 2-4, 2-18,

2-28, A-1–2
High mode: 2-11
High quality color printing: 2-13
High Resolution Paper HR-101: 1-3–4,

1-19, 2-3, 2-18, 2-30–33, A-1–2
Highlighting, document: 4-50, 7-35–36
Histogram tone levels: 6-17–18
Hold fax: 4-21
Home position: 9-18

I
IBM PC computer: A-9
Identifying, documents: 1-17
Idle message: 8-21
IEEE 1284-compliant: 10-25, A-9
Image 

area, scanned: A-9
color matching: 2-9
contrast: 8-5–6
editing base: 7-29
mirroring: 6-12
moving: 6-11
optimizer: 2-9
rotating: 6-12
size, scaling: 6-12
tone, adjusting: 6-13–22
tone, reversing: 6-12

Importing, Address Book: 3-17–19
In Box folder: 3-6–7, 5-7
Include annotations: 8-15
Indexing

creators: 7-13, 7-17
documents: 7-12–21
keywords: 7-15, 7-18
owners: 7-14, 7-17

Individual entries, Address Book: 3-13
Ink: 9-10–11

color: A-4
saver, fax: A-6

Ink Cartridge Storage Box: 9-13, 9-19–20
Ink/toner saver mode: 8-9
Installing, printer driver: 2-5
Interface: 10-25, A-9

J
Jams, paper: 10-3–5

L
Launch applications: 3-5
Launcher 

setup: 8-16–17
using: 8-17

LCD: A-10
display: 1-9
menu system: B-1
messages: 10-6–10

Limit mark: 2-22
Limited warranty: 1-3, 9-11
Line feed speed: A-2
Line jack: 1-8
Liquid crystal display: See LCD
List View: 3-9–11, 7-2
Listen time: 8-9–10
LOAD PAPER message: 1-12
Loading 

documents: 1-14–16
paper: 1-12–13, 2-19–24

Lock lever: 9-13

Index I-5
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M
Magnetic fields: 9-2
Managing documents, MultiPASS 

Desktop Manager: 7-1–21
Manual feed 

mode: 2-23
slot: 1-8, 2-24

Manual mode, fax receiving: 5-3, 8-8
Manual sending, faxes: 4-9
Manually feeding paper: 2-23–24
Media type: 2-9, 2-15

recommended: A-2
Memory: 2-14–15, A-9

faxes stored: 1-20
printing document: 5-5
sending: 4-2

Memory Clear Report: 10-26
MEMORY FULL message: 1-19
Menu bar: 3-3
Messages, LCD: 10-6–10
Modem 

jack: 1-8
speed: A-5
type: A-5

Monochrome 
mode: 2-11, 2-15
printing: 2-14

MultiPASS Desktop Manager
documents: 7-1–41
folders, using: 3-6–8
making phone call: 8-18–19
receiving faxes: 5-7–8
reinstalling: 8-26
scanning: 6-3–4
selecting documents: 7-1–2
setup: 8-1–26
setup options: 8-2–14
specifications: A-9
starting: 3-2
system requirements: A-9
system setup: 8-14–15
uninstalling: 8-25–26
using: 3-1–20
window: 3-3–5

MultiPASS hardware, cannot initialize:
10-25

MultiPASS Printer Driver: 2-5, 2-7,
2-23, 2-35, 8-25

MultiPASS Server: 3-2
adding to StartUp: 8-24
closing: 8-22–24
minimized: 8-20 
removing from StartUp: 8-23
restarting: 8-23
status messages: 8-21–22
using: 8-19–22
window: 8-20–21

MultiPASS software, uninstalling:
8-25–26

MultiPASS Viewer: 7-22–25
options: 7-39

Multiple copies: 1-20, A-6
Multitasking: 4-1, 5-6

N
Networking, fax: A-6
No answer, telephone: 8-9–10
Nozzle check pattern: 9-7
NOZZLE CHECK function: B-2
Number buttons: 1-9–10, 4-2, B-5

O
Off hook alarm: 8-5–6
On error option: 8-5–6
One-touch speed dialing: 4-5

buttons: 1-9–11
Online help, Windows 98/95: 2-7
Opening, Address Book: 3-12–13
Operator panel: 1-7, 2-17

copying documents: 1-18–20
using: 1-9–11

Outgoing message: 5-5
Output tray: 1-7

extension: 1-7



P
Packing materials: 9-21
Page orientation: 2-9
Paper 

feeding problems: 10-17–19
guidelines: 2-4
handling: 2-2–4, A-1
jams: 10-3–5
loading: 1-12–13, 2-19–24
printable area: A-3
weight: A-2

Paper feed 
limit: 2-18
method: 2-9, 2-18

Paper guide: 1-13, 2-21
Paper output guides: 1-7, 2-30–31
Paper output tray: 2-38

capacity: 2-21
Paper rest: 1-7, 1-12
Paper size: 2-9, A-1

option: 8-7
scanning: 6-8

Paper support: 2-20
Paper tab, Windows: 2-9
Paper thickness lever: 1-8, 2-18-19,

2-23, 2-25, 2-34
setting: 2-16–18

Paper type: 2-9
selecting: 2-2–4

Parallel 
cable connector: 1-8
interface: A-9

Pass-through devices: 10-26
Pause duration: 8-5–6
PC faxes

sending: 4-16–24
specifications: A-9
See also Fax(es)

Phone call, MultiPASS Desktop Manager:
8-18–19

Phone line option: 8-4–5
Photo Kit: 1-4
Photo resolution: 4-14–15

Photo-realistic color printing: 2-11
Plain paper: 2-2, 2-15, 2-18, A-1
Platen: 2-22, 9-4
Power 

consumption: A-10
failure: 10-26
goes out: 1-21
source: A-10

Power cord connector: 1-8
Preferences

Cover Page Designer: 4-36
fax setup: 8-3–4
scanning: 6-7

Preparing documents: 1-13–16
Preview 

image, adjusting: 6-9–12
scan options, setting: 6-5–9

Primary colors: 2-15
Print 

media, printer settings: 2-18
model: 2-9,
test page: 2-8
width: A-2

Print head: 1-3, 9-3, 9-10, A-4
cleaning: 9-8
life: A-4

Print quality: 2-9, 2-11, 2-13–14
problems: 10-14–15

Print speed: A-2
improving: 2-14–15

Printable area: A-3
Printer 

settings, print media: 2-18
setup, Windows: 2-7–12

Printer cover: 1-8, 2-16
Printer driver: 2-35

installing: 2-5
removing: 8-25
Windows 98/95: 2-7

PRINTER MODE message: 1-11
Printer port, defining: 2-8
Printer Properties dialog box: 2-7
PRINTER RESET button: 1-11
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Printing: 2-1–41
Address Book: 3-17
Banner Paper: 2-36–41
document: 2-5–6, 7-38–39
document, memory: 5-5
documents, MultiPASS Desktop 

Manager: 7-3
envelopes: 2-25–27
methods: A-1
nozzle check: 9-7
problems: 10-11–14
receiving: 5-6
resolution: 2-11, A-2, A-7
specifications: A-1–3
speed, fax: A-5
speed, versus color: 2-13–15
status: 8-21

Printing options: 2-10
Processor: 2-15
Properties dialog box: 2-7

Q
Quality, faxes: 4-13–15
Quick color printing: 2-13

R
RAM: 2-14–15, A-9 

See also Memory
REC’D IN FILE message: 5-6, 5-8
REC’D IN MEMORY message: 5-5
Receive conditions: 8-8–8
Receive fax

no signal: 8-9–10
telephone: 5-3–4

Receive fax options: 8-7–11
Receive mode: 5-1–5, 5-10, 8-7, B-2
Receiving 

documents: 5-1–5
fax status: 8-21
telephone calls: 5-2–3

Receiving faxes: 5-1–10
computer off: 5-7–8
computer on: 5-7
Fax/Tel mode: A-12
MultiPASS Desktop Manager: 5-7–8

Recommended graphics settings: 2-11
REDIAL/PAUSE button: 1-9–10
Redialing: 4-7–8

cancelling: 4-8
Reduction 

option: 8-7
sizes: A-6

Registering, receiving: 5-6
Registration card: 1-5
Regular dialing: 4-2–4
Remote options: 8-9, 8-11
Replacing

BJ cartridge: 9-11–15
BJ tank: 9-16–18

Report
automatic: 8-5
fax: 8-4–5
receive: 8-7–8

Report/reference, fax: A-6
Resend option: 8-5–7
Resending, fax: 4-8
Resolution

copying: 1-19
printing: 2-11, A-2
scanning: 6-6, A-7
setting: 4-13–15

RESOLUTION buttons: 1-9, 4-14–15
Responding to calls: 5-9–10
RESUME button: 1-11
Retries option: 8-4–5
Ribbon cable: 2-16, 9-3, 9-12, 9-16
Ring 

patterns: 5-9
time: 8-9–10
tone: 8-9–10

ROLLER CLEANING
function: B-2
message: 2-33

Routine maintenance: 9-3
RX MODE option: B-2

S
Safety instructions: 1-5–6
SB-21 Ink Cartridge Storage Box: 1-2,

1-4, 9-19–20



Scan 
driver: 6-3
folder: 3-7
mode: 6-5
options tabs: 6-3
resolution: 6-6

ScanGear 
uninstalling: 8-26
window: 6-1–3

Scanned image size: A-9
Scanner 

components, cleaning: 9-4–6
specifications: A-7–9

Scanners: 10-26
Scanning: 6-1–22

black and white options: 6-9
documents: 1-13
glass: 9-5
image processing: A-7
message: 8-21
method: A-7
MultiPASS Desktop Manager: 6-3–4
paper size: 6-8
preferences: 6-7
resolution: A-7–8
speed: A-8
width: A-8
Windows application: 6-4–5

Screen matched color: 2-14
Searching documents: 7-19–21
Selection size, adjusting: 6-10
Send Fax 

dialog box: 4-16
information, specifying: 4-16–21
options: 8-4–7

Send Fax Manager: 3–2
advanced: 8-5–6
using: 4-25–29

Sending
document: 4-2–10
multiple locations: 4-11–13
PC faxes: 4-16–24

Sending document support: 1-7
Sending faxes: 4-1–52

status: 8-21

Sent Fax folder: 3-7
Separation 

guide: 9-5
roller: 9-5

Sequential broadcasting: 4-11–13
Serial number: 10-2
Servicing, unit: 1-5
Setting tab, Windows: 2-10
Setting up

Address Book: 3-12–20
speed dial assignments: 8-12–14

Setup
MultiPASS Desktop Manager: 8-1–26
options: 8-2–14

Setup analyzer: 2-10, 2-12
using: 2-12

Sheet feeder: 1-7, 1-12–13, 2-19, 2-21
capacity: A-1
paper jams: 10-5

Silent period: 8-9–10
Silent receive: 5-10

option: 8-7–8
Space requirements: A-11
Specialty papers: 1-3, 2-2–4, 2-28–41

guidelines: 2-28–30
Specifications: A-1–12
Speed, scanning: A-8
Speed dial 

assignments, setting up: 8-12–14
group, defining: 8-13–14
tab: 8-12

Speed option
receiving: 8-9
sending: 8-5–6

Spilled ink: 9-10
Spool settings: 2-8
Stamp, inserting: 7-33–35
Stand-alone fax: B-1–6
Standard mode: 2-11

fax: A-5
Standard resolution: 4-14–15
START/COPY button: 1-9–10, 4-3, 5-3
Starter Kit (SK-101): 2-4
Status bar, MultiPASS Desktop Manager 

window: 3-3, 3-5, 3-13

Index I-9
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Status messages, MultiPASS Server:
8-21–22

Sticky-note 
adding: 7-32
annotation: 4-49–50

STOP button: 1-9–10
Storing, BJ cartridges: 9-19–20
Supplies: 1-2–4
Support, customer: 1-4, 10-1
Switch boxes: 10-26

using: 1-21
System 

requirements: A-9
setup: 8-14–15

System-defined folders: 3-6

T
Tape backups: 10-26
Technical 

notes: 10-25
support: 1-4, 10-1

TEL LINE TYPE option: B-1
Telephone: A-10

calls: 5-2–3
jack: 1-8
option: 8-3–4
problems: 10-23
receiving fax: 5-3–4

Text enhanced scan mode: 6-5
Text stamp, creating: 4-39-40, 7-34-35
Thumbnails: 3-10
Tone 

adjustments, scanning: 6-13–22
curves, using: 6-19–21
tab, scanning: 6-13–14

Transmission speed: A-5
Transmission/reception memory: A-5
Transmit report: B-1
Transmit Terminal Identification: 1-17
Transmitting, document: 4-11–13
Transparencies CF-102: 1-3, 2-4,

2-18–19, 2-28–29, A-1–2
Transporting, MultiPASS: 9-20–21
Trash folder: 3-7

emptying: 7-8

Troubleshooting: 10-1–26
T-Shirt Transfers TR-101: 1-3, 2-3,

2-18, A-1–2
TTI: 1-17
TWAIN compliant: 6-1, A-8
TX REPORT option: B-1

U
U.S. Commercial #10 envelopes: 2-25
Ultra High Quality (UHQ) image 

enhancement: A-7
Uncurling, back print film: 2-29-30
Uninstalling, MultiPASS software:

8-25–26
UNIT NAME option: B-1
UNIT TELEPHONE # option: B-1
User information, entering: B-2–6
USER SETTINGS options: B-1
User-defined folders: 3-7–8

V
Variable fields, inserting: 4-41–42
Viewing documents: 3-9–11
Volume option: 8-3–4

W
Warranty: 1-5, 9-11, 10-1
Water resistant paper: 1-3, 2-3
Web site: 1-4
Weight, unit: A-10
Windows 98/95: 2-7, A-9

online help: 2-7
printer setup: 2-7–12
tabs, using: 2-8–10
Twain-compliant: 6-1

Windows application
scanning: 6-4–5
sending faxes: 4-23–24

Windows Printing System users: 10-25
Work area: 3-3–4

Z
Zip drives: 10-26
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